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The Concept Behind CUE
Once upon a time, in the land of Faraway, there lived a young writer who more 
than anything wanted to fit his music to moving pictures.  He wrestled with this 
problem until one day the news came of a great sorcerer-composer who freely 
shared these secrets.  Immediately, he set out for the town of Holy-Wood where 
this master lived, taking only his lute, a ream of writing paper, and his massive 
desire to learn. 

Our novice finally met the old Composer-Sorcerer, but unfortunately matters still 
did not improve.  Upon first seeing The Click Book, a volume so large it was 
sold with a team of yaks, our hero was overwhelmed.  Inside this massive tome 
was page after page of indecipherable numbers which the Composer-Sorcerer 
referred to as Clicks, and these he told the apprentice were the secret of making 
music conform to picture.

The Sorcerer hated dealing with the cumbersome Click Book.  It was time-
consuming, boring work that he longed to be freed from.  This apprentice's 
arrival seemed a gift from the musical gods.  Although not an evil man, the 
Sorcerer saw the young apprentice as a means to free himself forever from the 
eternal Click Search.  

Under the guise of necessary training, the Sorcerer was preparing to consign his 
new apprentice to a lengthy stint in the Click Dungeon  when a sorcerer colleague 
from the Valley of Silicon took pity on our hero and conjured a device that made 
searching for correct tempos a much more civilized pursuit.

This program is the result.  It is meant for old sorcerers, young heroes and 
anyone in-between. 

The intention of CUE is to be a powerful tool for both the composer and the 
music editor.  There seemed to be a need for something that would enhance the 
collaboration between these two related fields.  By creating a shared working 
medium, we build a bridge over which much information may easily cross in 
both directions.  In fact, with all the MIDI implementations, the synthesist is also 
linked into the same process.

CUE's aim is to automate every task that takes time away from the creative 
process.
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It provides Spotting Notes                                                                          
It creates Cue Sheets                                                                              
It permit's entry of timing points directly from video with a single 
keystroke    
It lays out a Title Page with your logo
It converts a tempo tapped out on the mouse into proper click information
It searches Click Tempos
It allows you to program accelerandos and ritards
It displays a musical graphic useful for laying out meter changes
It lays out and prints custom Score Paper
It is a stop watch for grabbing cue points on the fly
It contains a click book that can appear in different time and tempo formats
It rescales your Cue Sheet to compensate for an off-speed picture or late 
edit's
It lets you follow existing material and hand-tap a complete click track
It creates a film's Master Cue List or "Bible"
It generates the Performing Rights Cue Sheet
It contains a time and tempo Conversion Table

CUE also performs some important performance related tasks:

It locks to Midi Time Code
It generates MIDI Event Triggers
It plays the selected click (including all meter and tempo changes)
It lets you output this click with either accented or unaccented downbeats
It instantly dumps it's click track into various sync boxes
It displays Streamers and Punches for conducting without a click track
It outputs a MIDI clock and can receive a MIDI start signal
It commands the generation of SMPTE
It creates MIDI Files that can be read by other programs

Lest this appears to be overwhelming assortment of information requiring a 
private secretary to handle the typing load, keep this idea central in your mind:  
Although certain aspects of the program require their own keystrokes (operating 
the Stop Watch for example), for the most part, this program derives all it's 
knowledge from the data you enter on the Cue Sheet.  This means that you will 
only have to enter the essential material once.

With this pleasing thought in mind, let's move into CUE  and see what's 
involved.
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Organizational Notes
We know how people often attack a new piece of software when they get it home.  
Rather than page-by-paging it through the manual, the tendency is to jump in and 
see what blows up.  Often the proviso is: "In Case of Fire Use Manual."   Keeping 
this in mind, we have tried to provide several options.  There are several places 
in this manual, where CUE's functions are listed in different ways. Page numbers 
for finding a needed subject are included in each of these overlapping lists.

CUE's aim. . . on the preceding page, lists the broad functions that the Cue 
program addresses.  Starting page numbers are included after each topic. The 
Table of Contents reflects what we hope is a relatively orderly progress 
through the various layers of CUE, describing each operation and it's interaction 
with related functions.  The Index will be useful when you are using this as a 
general reference manual and need to find specific points.  The Menu Map 
which follows our Organizational Notes presents a graphic display of the 
various menus and their pop-up sub-menus with page locations listed next to each 
item. We hope this will direct you to the right spot in the manual to describe what 
you are seeing as you poke about in the program, or wish to break in new 
techniques.

As an addditional aid to the hop-skip-and-jump manual reader, we have tried to 
make the manual somewhat modular.  This means that certain pieces of 
information are repeated in different sections.  While we haven't gone for 
complete redundancy, we have tried to seek a pleasing balance between stupifying 
repetition and gross understatement.  

It should also be noted here that this manual assumes familiarity with the 
Macintosh family of computers.  If this program is to be your first experience 
with the Macintosh, then we suggest you spend some time with the Macintosh 
manual and some basic applications such as MacWrite or MacPaint to get 
comfortable with the Mouse and basic procedures before you hop into CUE.

One last item before we start is that the CUE manual does not provide an 
overview of film music composition.  We will go into explanations of why 
certain CUE features exist and how they relate to the film community, but for 
information regarding techniques and philosophies underlying the craft of 
making film music, we suggest you check out Earle Hagen's comprehensive 
books, Film Scoring, and  Advanced Techniques for Scoring Film, 
published by Alfred Publishing.  You might also check out Dan Wyman's 
Scoring for Time text used at San Jose State University.
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1 A Quick Look At CUE
For the purpose of taking a brief look at CUE, let us divide the program's many 
features into three central areas of function : 

 1.  Construction of complete Cue Sheets with descriptions and 
timings.

2.  Matching cue points with their proper Click tempos and meters.
3.  Output of collected information and timed events through print,

                MIDI, and SMPTE generation.

We'll take a quick look at three major CUE windows which represent each of the 
three areas.  Each of these areas are uniquely interwoven.  Remember when you 
take this brief tour, that CUE will perform many more features than these three. 
After this introduction, we'll come back and get you started on entering your 
own material.  If you can't wait, see page 15.

Start with the Cue Sheet
After loading the CUE disk and clicking twice on the icon for CUE which looks 
like this:

you will be presented with the Cue Sheet Window, the overlay Input 
Window and the Custom Menu list.
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The Cue Sheet and the Input windows are your central tools for entering 
information about the visual material you are working with.  There are areas for 
entering production information, starting and stopping times, camera moves, 
descriptions of scenes, musical timing information, and more (as you shall 
discover).  The Custom Menu is provided to help streamline selecting some of 
CUE's many options.  We will go into greater detail about the Custom Menu 
on page 92.

Here are some quick ways to retrieve your windows:

-Click on any visible part of a window, and it will move to the front. 
          -Bring windows to the front through the following 'power keys':

Command-I Input window
Command Opt-M Custom Menu

To see more of the Cue Sheet, or make it the active window (if it is not) 
       click once on any exposed part of it.

To retrieve the Input window you can select it from the Windows Menu, type 
Command-I (Command is the key that looks like a cloverleaf) either in upper 
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or lower case, or click on the small part of the Input window that is visible 
below the Cue Sheet. Clicking on a piece of the Custom Menu will bring it to 
the top as well. Try these operations before we continue.

If you wish to enter some information into the Input window, by all means do 
so.  Clicking on OK in this window will place whatever material you have 
entered there into the Cue Sheet window, if it has been properly configured.  So 
don't be surprised if CUE beeps at you and takes you back to the Time entry 
area instead.   We will discuss proper time entry in the upcoming chapter.

Lets continue our get-acquainted tour of CUE.  Click back on the Cue Sheet 
window, and note any information which may have been added to it.  Move the 
mouse up to the Windows title in the Menu bar.  Click on Windows, and, 
while holding the mouse button down, move it down to Click Book.  If you 
want to prevent the dreaded Mac-user disease, Forefinger Fatigue, you can type 
Command-opt K.  The following window should appear:

    

The Click Book window provides you with the central time-saving device 
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composers need to determine the placement of their cues.  With this chart, and 
the information placed into a Cue Sheet window, you can test virtually any 
practical tempo to find the one which catches your cue points best.  The large 
numerical chart shows time as a function of beats and tempo.  The far left hand 
column shows beats in increments of 10, while increments of 1 beat run along the 
top of the chart.  The time displayed for each beat in the central chart has been 
calculated for a Tempo of 12 - 0, as stated next to the Tempo button on bottom 
left.  You can change the display of this flexible tool by changing a number next 
to one of those three bottom buttons (Tempo, Find Click #, and Find Time), 
and clicking on the associated button.  With each change of tempo, the times 
displayed in the chart will change.  You will find find information about this 
window and it's functions in the chapter entitled, The Click Book (page 112).

Close this window for now by clicking on the small upper left hand box in the 
Click Book banner.  You should see the original CUE banner now at the top of 
your screen.  Move over to the Reel World heading in the menu, click on it and 
select Playback from it's column.  The following window should appear:
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The Playback window is just one of several "output" features CUE provides to 
help construct a unified environment for your work.  This screen will take the 
tempo(s), cue points, and necessary performance information in your cue, and 
construct a visual clock which outputs MIDI and click information simultaneously 
when you start it.  The rectangles at right and left of the screen (sprocket holes, 
pretty clever) allow you to start and stop the "information playback" of your cue.  
Running time, beats, cue points (punches), streamers and more are all displayed 
in the window when you start the playback of a cue.  Try clicking on the Start 
button, and watch what happens.  Information on this window and other playback 
functions will be found in the chapter entitled, Communicating With the 
Outside World.

Skip around to some of the other menu items and get a feeling for how they 
interconnect.  The function of many of these windows is dependent upon material 
entered into the Cue Sheet.  So, let's begin our first complete exploration of 
CUE right there.
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2 The CUE SHEET Exposed
When you "click" on various areas of the Cue Sheet window, you will find the 
following dialogs and/or pop-up menus:
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The Cue Sheet Exposed  [2] 
 

Pop-up Menus provide you with
hidden dialogue boxes

of their own. 
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The Cue Sheet Exposed [3]
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Entering Information from Home Base
Having checked the many dialog boxes of the Cue Sheet window, Lets begin to 

discuss them in some detail.  Time, description, and production information 
entered through the Cue Sheet will affect almost every function of CUE. 

Setting Your Cue Information
We will start by titling our cue.  This is done by going up to the Operations 
Menu and selecting Set Info.  A sub menu will appear to right.  Move the mouse 
cursor over and select Set Cue Info.  This will open a dialog box  for entering 
information about the cue you are working on.  It looks like this:

If for some reason you do not wish to title your cue then you need not access this 
dialog box and can proceed to the next step.  However, since Set Cue Info does 
provide ease of identification for your print-outs and also is a source of some of 
the raw material for The Master Cue List and The Performing Rights 
Cue Sheet, this dialog box is extremely useful.
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Like all the dialog boxes in CUE, there are two ways to move from one entry 
area to another.  One is by using the Tab key, which will move you sequentially 
from box to box.  The other is by using the mouse to locate the cursor at the 
point you wish to enter information.

The Production Title and the Cue # will appear on the Cue Sheet when we 
return to it.  All the rest of the information you can enter in this dialog box 
refers to the Master Cue List and the Performing Rights Cue Sheet.  If 
you are working on a single cue such as music for a commercial, then you can 
leave the rest of the boxes blank, but for purposes of getting you into using CUE, 
let's suppose we are working on a feature called "Zarkov Unchained".  Enter this 
title in the Production Title Box and then Tab to the Cue # Box.

The number you enter here keeps track of where in the film this cue occurs.

A word of explanation for the uninitiated:  These numerical titles 
take the form rrMss where rr is the reel number and ss   is the start 
number from the beginning of the reel.  For example, the fourth cue 
on reel 6 would be titled 6m4.

In the case of our example, since it is the first cue in the film, we will call it 
"1m1".  Enter 1m1 in the Cue # box, and tab to the Cue Title where we will 
enter an actual name for the cue.  Our sample cue is called the "Opening Shot".  
Enter this and tab to Session #.   The number you assign here will allow you to 
group your cues so that you can organize them by the session you will be 
recording  them at.  It may be too early in the process for you to know this now, 
but you can always return and add this information later.

Continue to tab along,  entering your own name under Composer(s), 100 under 
%, (since you are the sole composer on this cue), the name of your publishing 
company under Publisher(s) and BMI, ASCAP or other affiliation under Affil .

Written, Orchestrated Copied and Recorded  have check-boxes to be 
clicked on when each of these tasks has been accomplished.  This will keep your 
Master Cue List up to date whenever you choose to assemble one.  To find out 
more about compiling the Master Cue List see page 166.
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Customized Usage Menu
At the very bottom of the page between the Ok and Cancel buttons are a pop-up 
menu box labeled Background Instrumental, and right center button labeled Edit 
Usage Menu. 

If you click on the box to the left you will see that it is really a pop up menu.  
Scrolling downward by clicking on the mouse cursor and moving it down toward 
the bottom of the box will reveal three other default choices besides 
Background Instrumental.  They are Background Vocal, On Camera 
Instrumental and On Camera Vocal.  Selecting any one of these will cause 
the selection of your choice to appear in this box.  Clicking on OK will mean that 
this is how the cue will be listed on the Performing Rights Cue Sheet when 
the time comes to print it out.

But what if none of these four choices fit's your particular needs?  That's where 
the Edit Usage Menu button comes in.  When you click on it the following 
entry box will appear:

The first four boxes are filled in with the default settings.  It is suggested that you 
leave these in place because if you are ever doing a Performing Rights Cue 
Sheet whose cues were done on an earlier version of CUE, these default settings 
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will allow your print-out to accurately reflect the usage choices you made with 
your previous CUE version.
This leaves you twelve more spaces to enter any customized usage categories you 
desire.  To avoid confusion, you must enter these usages in left column-right 
column order instead of first down one column and then down the other.  The 
reason for this is that since CUE reads from left to right, it will decide it has 
reached the end of the list whenever it comes to an empty box and thus all your 
customized usages will not be displayed if you list them only in the left column.

After you click on OK, and then click and scroll on the pop up menu, you will 
see your customized usages appear in addition to the four default categories.  
Selecting one of the new usages will cause it to appear in the display box and will 
make this the usage that will be listed on the Performing Rights Cue Sheet.

We are now ready to return to the Cue Sheet, but first it is necessary to accept 
the information just entered.  This is done by moving the mouse cursor over the 
button labeled OK and clicking once (or hitting the Enter key).  Go ahead and 
do this now.  

Remember: just because you clicked on OK when you created a customized usage 
does not mean this is the one that will appear in your print-out.  Selecting that 
particular usage from the pop up menu so that it will appear in the display box 
and then clicking on the OK just to the left of this display box is what will 
accomplish that.

To find out how to compile the  Performing Rights Cue Sheet, see page 171.

If there was another item that you wanted to add to our Set Cue Info dialog 
box, once more, click on the Operations Menu and then select Set Cue Info.  
When the dialog box appears on the screen, you will see that it holds all the data 
that you previously entered and saved by clicking OK.

Should you have entered this dialog box by mistake or if you wish to leave it 
without updating any of the information, click once on the button marked 
Cancel.  If you have updated any entries but now do not wish to save these 
updates, then clicking Cancel will restore the settings you last clicked as OK.

Cancel will always return you to the Cue Sheet.  It does not remove any of the 
information which you have saved by clicking on OK.
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Set Production Info
While Set Cue Info lets you log in some of the basic information about your 
production, it does leave off a number of other specifics you may want to include 
on your Performing Rights Cue Sheet.  CUE has anticipated this need with 
the Set Production Info dialog box. If you click on the Operations menu 
again you will see Set Production Info  appear when you select Set Info right 
up at the top.  When you slide the cursor over to Set Production Info and then 
release the mouse button, this is what you will get

This dialog box will let you either tab through the various categories or select a 
particular one of them just like Set Cue Info did.  All of the information you 
enter here will appear in the Performing Rights Cue Sheet.  

If you are wondering why the Production Title appears in the Set Cue Info 
dialog box as well as this one, it is there as a convenience.  Should you be 
working on a commercial or something other than a feature, you may never have 
a need to go to Set Production Info but you may want to list a production title.  
This way you can do it all in the Set Cue Info dialog box.  Whichever one of 
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the two dialog boxes you enter the Production Title into will cause it to 
automatically appear in the other one, so you don't have to duplicate keystrokes.

The Production #, and Episode will also show up when you print out the Cue 
Sheet and the Master Cue List.  At the bottom are a number of buttons which 
will allow you to indicate whether the production is for TV or Theatrical and 
whether it is a Feature or a Short.

After you have entered whatever you want to log in this dialog box, click on OK 
to save it or Cancel if you want your entries to disappear.  This will return you 
once more to the Cue Sheet.
 

Quitting the Program ("but I  just got here") 
The only reason we mention this now, is in case you have to stop working and are 
frustrated by how to Quit the program.  The Quit command is located at the 
very bottom of the File menu.  Selecting it will enable you to leave gracefully.  
You can also hold down the clover leaf Command key and type Q.  

Saving your work before you leave is another matter.  This is dealt with on page 
52.

Setting the Running Time

The next operation which CUE permit's you to do is the logging of your 
Running Time (the place in the film where the cue begins).  It is important to 
enter your Running Time before you enter any actual cue points if you want 
CUE to show your timings correctly. This entry is not only a helpful guide when 
it comes time for the music to be cut in but is also used by CUE to 'zero' the 
Relative Time column for composition purposes.  

There are three ways you can call up the Running Time dialog box:
1-  by selecting  Set Running Time from the Operations menu. 
2-  by holding down the Command key while you type the letter R 
3-  by clicking anywhere on the Begins at line at the top of the Cue 

Sheet.   
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After doing any of these three procedures, this is what you will see:

There are three pieces of information asked for in this dialog box.  

The first entry box marked: SMPTE hour will accept any number up to and 
including 23 hours.  Placing the hour in this box will make it easier to enter 
SMPTE times in the actual Cue Sheet because you will only have to type 
minutes, seconds, and frames into the Input window.  CUE will automatically 
fill in the hour for you.  By the way, when you convert from SMPTE to other 
formats such as feet and frames, CUE will ignore the SMPTE hour since reels 
just don't come that big.

The second box is labeled: Start of Cue.  This is where you enter the rest of 
the SMPTE number and all of the information concerning the hrs:min:sec and 
hundredths of seconds, or feet/frames from the beginning of the reel.  You can 
tab between these entry boxes or use the mouse.  CUE abides by the standard 
Macintosh word processing conventions so if you want to type in a number 
completely different from that which is currently entered, remember to select the 
entire box so it is highlighted in black before you key in a new entry. 
 

The third box is provided so you can store an Alternate Running Time for 
your cue.  This will prove handy if the composer is working with a video copy in 
which the first frame of picture starts at 0:00:00:00, and the editor is working at 
a movieola with a reel that has an academy leader which which would make the 
first frame of his picture show up at 12 feet instead of 0 feet.  Before we explain 
how to  create an Alternate Running Time, let's first key in an initial 
Running Time.
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For purposes of example, we and the director of our mythical film have decided 
this cue is to begin at 10 seconds into the first reel and that the mythical video 
tape of our mythical film has been delivered to us mythically encoded with 30 
frame non-drop SMPTE.  

Since it has become fairly universally accepted that the SMPTE hour is made to 
correspond with the reel number, our first step is to enter the number 1 in the 
box labeled SMPTE hour.  When you first call up the Running Time dialog, 
the SMPTE hour entry box will be selected and waiting for your keystroke.  If 
you have parked the cursor in the other entry box, hitting the Tab key is the 
fastest way to select the SMPTE hour box in order to enter the hour.  Once you 
have done this, you can hit the Tab key and proceed to enter the Start of Cue 
time.

BIG FAT NOTE:  If you have entered a SMPTE hour in the SMPTE hour 
box do not enter it again in the Start of Cue box.  If you do, CUE will add the 
two SMPTE hours together which is very logical but not really the result we 
had in mind.

Our sample entry should be entered in this way:  s0:00:10:00.  The prefix "s" is 
the way CUE recognizes that we are entering 30 frame non-drop Black and 
White SMPTE code. When you first enter the Start of Cue box, there will be a 
zero number already entered.  If this number appears in same time format you 
are using, you can hold down the Command key and hit the Tab key to move 
from time field to time field, thus saving the entry steps of typing slashes, colons 
or periods.  In the case of our example, you could tab from the hour to the 
minute to the second entry, and type in the number 10 without having to enter 
the whole number.  Try this to make sure you understand how this feature works.
 
Since our particular example is a round number of seconds, you you could also 
save keystrokes by hitting the Tab key to select the entire box, and typing 10 
(entering time requires no letter prefix before the number and since there is no 
fraction of a second involved, you need not enter a decimal point for CUE to 
understand). (The section about time entry starts on page 30).

When you are satisfied with your entry, click on the button marked OK (or hit 
the Enter key), and you will return to the Cue Sheet.  If you decide not to 
make an entry, then clicking the mouse on the button marked Cancel will also 
return you to the Cue Sheet.  (Note that in CUE, unlike some Macintosh 
programs, the Return key does not  exit a dialog window.  You should always 
use the Enter key as a substitute for the OK button).
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Notice that the information you just typed is now displayed on the second line at 
the top of the Cue Sheet.  If you want to see the Running Time displayed in 
another time format other than the one you are currently viewing on the screen, 
then you will have to change the setting of the Time Formats.
 
We Warned You But You Did It Anyway Note: As we alluded to at the 
beginning of this section, if you forget to enter the Running Time before 
merrily starting to bang out your Cue Sheet, you will create a small problem 
for yourself.  What happens should you try entering your Running Time 
belatedly, is that it will be added on to the time of your first cue point instead of 
reflecting that they are both one and the same.  (If your first timing point is 20 
seconds, and you enter a Running Time of 20 seconds after you typed the Cue 
Sheet, that first timing point will now show up as 40 seconds.)  Don't worry, 
there is a way to extricate yourself from this dilema:

First replace any numbers you may have keyed into Set Running Time with 
zeros, and click on OK.  Then select Set Offset from the Operations menu and 
enter your Running Time as a positive (+)  Permanent Offset.  (see page 144  
for more details, but even better, try training yourself to enter your Running 
Time first.)
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Setting the Time Format
CUE  is a very flexible beast.  As we learned in the Running Time dialog box, 
we can enter and get back hrs:min:sec, SMPTE numbers and feet/frames.  In 
addition, since CUE will tell you what measure and beat is occurring at a specific 
timing point, it will also allow you to express timing information in the form of 
measures and beats.  (We will go into greater detail on this when we discuss the 
Input Window starting on page 29.) 

Now that you are about to enter some actual cue point information, our 
suggestion is that you set CUE so that it will show your timing information in 
the same format as that which you are entering.  The reason for this is that at 
some point in your process, you are going to want to proofread your "typing" to 
make sure that your timings are entered correctly.  Seeing them displayed in the 
same format you are working in greatly facilitates this.

To select a time format, move the mouse cursor up to the Operations Menu and 
choose Set Formats.  When you do so, you will notice that a a whole new 
smaller menu has opened up just to the right of the words Set Formats.  

This is your first official encounter with hierarchical menus in CUE.  To use 
these little sub-menus, slide the mouse to the right and you will find that the 
different lines of text in this hierarchical menu will highlight just like the main 
menu's.  The purpose for this feature is that without these little sub-menus, all 
these categories would have to be listed in the main menu, making it an endless 
list you would need to scroll every time you wanted something which wasn't 
showing on-screen when you first accessed the menu.  

This particular hierarchical menu will gain you access to a dialog box made up of 
three separate "pages": Time Formats, Tempo Formats, and, Cue Sheet 
Formats.  You will also find a separate selection entitled, Screen Setup.  These 
pages allow you to tailor your Cue Sheet to meet a great variety of different 
applications.   Each is discussed under it's own topic section in the manual.   For 
more details on this, see pages 65 and 116.

Since we are interested in setting the Time Formats, move the mouse over to 
the hierarchical menu and select Time Formats. When you lift your finger 
from the mouse button, the dialog box  which appears on the screen it will look 
like this:
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If for some reason the dialog box does not say Set Time Formats at the top, 
click on the button at the bottom of the page that says Cancel and turn page. 
This will move you to the next page in this dialog box.  You can repeat this until 
the correct one of the three pages that make up this dialog box will appear, or 
you can click on the button that says Cancel, which will return you to the Cue 
Sheet, allowing you to start the whole menu selection process over again.

The other two  pages allow you to make selections of different Cue Sheet 
Formats and Tempo Formats.  We will take these up a little later but you are 
certainly free to click on the Cancel and turn page button and check them out.  
When your curiosity has been satisfied, click back to Time Formats and we will 
proceed.

Note: There are two other ways that you can call up the Set Time Formats 
dialog box. You can hold down the Command key and type the letter F, or once 
you have actually entered your first cue point, so that the timing columns with 
their headings have become visible on the Cue Sheet, you can click on the 
headings of either one of these columns to call up this dialog box.

Set Time Formats
As you examine this page it appears too simple.  You can see the two columns of 
timing information displayed and you can see the little box to the left of them 
which allows you to turn either of them off in case you only want to look at one 
column of information, but where do you select between all of the different 
formats we have been writing about?
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This mystery will become clear as soon as you click anywhere on one of the two 
boxes that describe what the Time Format of that particular column is.   What 
you will see is:

This is a pop-up menu and it works just like the main menus and the hierarchical 
menus.  Pull down and select any of the available choices for timing display and 
when you release the mouse button, your new choice will show in the box.  This 
menu allows you to choose between a wide array of different time formats, and it 
lets you select either Absolute and Relative time.

Absolute and Relative Time  
This is an important concept to understand.  Absolute Time refers to the actual 
timing points of the cue as taken down from the movieola or video tape.  
Relative Time is the time from the start of the cue.  This feature makes it 
unnecessary for the editor to zero the counter at the beginning of each cue in 
order to determine it's length.  After you have used the pop up menu to select 
either Absolute or Relative, you can return to the menu a second time in order 
to select the timing format you desire that particular column to appear in.
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Format Choices
The three basic choices you have are hrs:min:sec.100ths, SMPTE or Feet 
and Frames.

In the SMPTE portion of the dialog box you can choose between 24, 25 or 30 
frame SMPTE.  When selecting 30 frame SMPTE, you can further pick black 
and white, color, or drop frame.  Black and White means that the SMPTE 
is running at exactly 30 frames/second.  Drop frame means that the SMPTE is 
displayed as 30 frames/second but is running at 29.97 frames/second. To 
compensate, the first two frames of each minute between the second and ninth 
minute of every ten minute cycle are dropped.  Color means that the SMPTE is 
displayed as 30 frames/second but is running at 29.97 frames/second with no 
compensation as in drop frame.

IMPORTANT NOTE:  Do not assume that you should enter your timings as 
color SMPTE if you get a color video tape.  If there is no label on your working 
tape, check with your music editor, or with the video engineer who made your 
dub.

If all this seems confusing, don't worry.  A small child could understand it.  
Unfortunately since there are no small children operating any of the major video 
facilities, we are in deep trouble.  The main fact which you will want to be very 
clear on is exactly what type of SMPTE is being striped on the tape you are going 
to work with.  Once you know, it will be possible to set CUE to conform to 
whatever you end up with.

There are two basic choices and a wildcard under feet/frames.  CUE will deal 
with both 35 and 16 millimeter film, but it will also handle film at 23.976 frames 
per second.  If you have a video with both a footage and a drop frame window 
burned in, and you want to take down the footages, use this format.

Information about how to correctly enter all these different formats is covered in 
the section starting on page 30.

There are a number of advantages to having two timing columns. The composer 
can be looking at the Relative Times which are pertinent to writing the music, 
while also being able to refer to the Absolute timing points that the editor and 
director are dealing with.  For that matter the composer can be showing his times 
in minutes/seconds and simultaneously refer to feet/frames or SMPTE 
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numbers. As you think about the possibilities, you will probably come up with 
variations on this theme that suit your own needs. For Instance, if you have to 
have three columns of timings, you might want to make print-outs of two 
columns, and  refer to a third on screen.  

Since the Set Formats feature has three pages, OK and turn page will enter 
the choices you have made and send you to the next page of the dialog while 
Cancel and turn page will throw away any changes you just made but still 
keep you paging through the Formats dialog box.  As with the dialog boxes we 
have already dealt with, clicking on the button marked OK (or hitting the Enter 
key) enters the choices you have made and sends you back to the Cue Sheet, 
while Cancel sends you back to the Cue Sheet without updating whatever was 
previously in the Formats dialog box.  

Quick Note: If you have been playing around with some of the other pages in 
this dialog box you might not achieve similar results to what we will describe in 
the next section of the manual.  To correctly undo any changes you may have 
inadvertently made, be sure that all the buttons on the  Set Cue Sheet Formats 
page are set identically to the illustration which follows:
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To find out about more about the Set Cue Sheet Formats  page, turn to page 
65 of this manual.

The Input Window
Now that we are back at our Cue Sheet display, you may need to retrieve the 
Input window.  So once again you can either click on the Window menu and 
select Input, type Command-I, or click on any part of the Input window that is 
exposed.  What you will see is this:

It is here that specific information about each cue point is entered. The two text 
areas in this window are Time and Description. In order to enter a cue point, 
both of these must be filled in.  They are both editable text areas that follow all of 
the Macintosh conventions for editing text.  You can move from one to the other 
by using the Tab key or by clicking in the field you want to activate.(The mouse 
cursor will change from an arrow to an "I-Beam" whenever it is over one of 
these fields.)  Actually entering a cue point in to the Cue Sheet is done by 
clicking on OK or hitting the Enter key.

 Absolute and Relative Time  
Before we enter any timing information, it is important to be sure whether you 
are entering Absolute or Relative time.When you enter an Absolute Time, 
CUE will calculate the corresponding Relative Time and enter it in the 
Relative Time column and vice-versa. Although we previously explained the 
difference between the two, this distinction is important enough to bear repeating:  

Absolute Time refers to the actual timing information taken from the movieola 
or video tape.  Relative Time is the time from the start of the cue.
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The title bar of the Input window indicates whether CUE is set to receive 
Absolute or Relative time entries.  If it is set for Absolute and you wish to 
change it to Relative time you can do so by clicking on the Operations menu 
and selecting Enter Relative Time.  After you have done so, the title bar on 
the Input window will reflect the change you have made.  If you want to go back 
to Absolute time, click on the Operations menu again and you will see that it 
now reads: Enter Absolute Time.  Clicking on this will return the Input 
window and it's title bar to the Absolute time  setting.

A faster way to accomplish this is to hit the Command key along with the letter 
"a".  Command "a" will toggle you back and forth between the two time 
modes.

Time Entry Formats

If you are entering either hundredths of seconds,  seconds, film frames or beats it 
is not necessary to enter "0" minutes, feet or measures in order for CUE to 
understand the number you are feeding it.Your entry will be logged correctly 
provided you use a decimal point if you are keying in a fraction of a second,  the 
slash (/) before the frame number, or a letter "b' before the number of beats. No 
punctuation at all is necessary for entry of whole seconds without increments.

Once you enter the SMPTE hour in the Running Time dialog box, you need not 
enter the SMPTE hour when you enter times in that format.

The letters entered before a timing number distinguish between feet/frames, 
measures/beats, 16 millimeter, or the many SMPTE formats.  They may be 
entered in either upper or lower case. The letters you should use to distinguish 
between the different forms of film and SMPTE are: "x" for 16 millimeter, "f" 
for 24 frame, "e" for 25 frame, "s" for 30 frame black & white, "c" for 30 
frame color, "d" for drop frame, "m" for measures, and "b" for beats.

To enter film frames at 23.98 frames  per second, precede the entry with an 
asterisk (*).  
 
CUE will translate any kind of time entry you can feed it into the specific format 
you have selected for your Cue Sheet.  Certain times such as Running Time 
and the start of the Warning Clicks are always displayed in the Absolute time 
format, while others such as Offset are always shown in the Relative time 
format.
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If you have one time column set for Absolute and the other for  Relative, 
CUE  has no problem homing in on what format is to be used for Absolute 
Time.  But what if you have both columns set for either Absolute or Relative?  
In these cases, CUE will arbitrarily decide that the first timing column is the one 
it will use for Absolute Time Format, and the second column for Relative 
time.
     
You can enter a number of seconds greater than "60" in the Hr:Min:Sec:100th 
format, and CUE will calculate the proper conversion and display your entry in 
minutes and seconds. Unlike many other programs, you do not need leading 
zeroes such as "09" in order to mark a decimal place. This cuts down on the 
number of key strokes you need to make.

Time Entry Types and Examples
Time entries can be expressed in several forms:

seconds and/or hundredths of seconds 87.64
.53

minutes:seconds and/or hundredths 3:4.9
66:01

hours:minutes:seconds and/or hundredths 4:0:06.15
1:1:11

SMPTE Formats
30 frame (black & white) seconds and frames s23:29

s14
30 frame (b & w) hours:minutes:seconds:frames s12:5:22

S3:01:44:1
alternate entry method using semi-colons s12;5;22

S3;01;44;1
24 frame minutes:seconds:SMPTE frames f6;48;1

F4;9;21;7
25 frame minutes:seconds:SMPTE frames e0:5:22

E2:01:31:2
30 frame (color) hours:minutes:seconds: frames c8;5;22

C3:01:44:1
Drop frame hours:minutes:seconds: frames d3:2:17

D9:5:7:2
(for explanations of different SMPTE formats see Format Choices on page 27)
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Film Formats
35 millimeter feet / and/or film frames 486/11

/3
16 millimeter feet / and/or film frames x67/5

x/14
23.98 frames  per second *32/7

*x256/
measures and/or beats b48

M6B3
     M8

As you can note from the above examples, you are provided as much forgiveness 
as possible when it comes to entering numbers to the Input window.

Film Frames at 23.98 FPS
This is a format especially designed for situations where the editor is taking 
timings from a moviola and the composer is working from a video encoded with 
drop frame SMPTE.

Since American video (NTSC) runs slow (29.97 frames per second instead of the 
advertised 30 fps), there will be a degree of slippage between timings taken from 
film when compared to drop frame SMPTE. The extent of the slippage is that ten 
minutes of film will take ten minutes and 18 frames of displayed drop frame 
SMPTE to unreel. This 18 frame difference over a ten minute span may not seem 
like a lot, but if an editor and composer are trying to get in sync over a particular 
subtlety in the picture, it could get confusing.

CUE's solution to this situation is to provide the editor with a way to notate 
feet/frame timings that will slightly slow them down automatically to match the 
video speed.This format is film frames at 23.98 fps (it is really 23.976 fps, 
but who's counting). If the editor takes the film timings down in this format (by 
placing an asterisk in front of each timing) then the composer will receiving 
timing sheets whose cue points will match the movieola perfectly even after they 
have been converted to drop frame SMPTE.
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Saving Keystrokes when Entering Numbers
Several time and effort saving substitutions have been included in CUE to make 
entering numbers easier:

When is a ; Not a ; ?
To save the keystroke of having to hit the shift key, you can enter ";" instead of 
":" when typing hours-minutes or SMPTE (s6;48;23).  When the number is 
actually displayed in the Cue Sheet, it will appear with colons instead of semi-
colons.

Space Bar Punctuation
You can set the Space Bar up to be either a colon ":", a slash "/", or a 
period.This is done by clicking on the Operations menu, selecting the Set 
Formats sub-menu and releasing on Cue Sheet Formats. There, under Space 
Bar Character, you will be given the three choices. Clicking on whichever one 
you are using the most for between-number punctuation in your entry process, 
and then clicking on OK (or hitting the Enter key) should make your number 
entry typing routine easier.

The ESC Key
On extended keyboards the ESC key will work just like the CANCEL, DONE, 
or EXIT buttons.  It is a logical counterpart to the ENTER key which replaces 
the OK button on your screen.

Command/Tab
If you are editing an existing timing, holding down the Command key while you 
hit Tab will move you from one time field to another so you won't have to 
retype slashes or colons.

No Extra Zeros Around Here
When you are entering an even number of feet, you need not place a "0" after the 
slash mark  (/) to indicate zero frames. (You must use the slash, or  CUE will 
read your entry as seconds).
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If the time is entered as a measure or beat, CUE will take into account any tempo 
and meter changes and the current offset when it calculates the time.

Note: When entering numbers, make sure you use the zero character ("0") from 
the top line of your keyboard or your numeric keypad.  Entering the letter "O" 
may look the same to you but it will confuse the computer.

Adding & Subtracting Time
It is possible to add or subtract time in the Input window (or in any other 
feature that receives an input time) by placing a plus (or "=") or a minus sign 
after the initial number you enter and then typing in the amount you want to add 
or subtract.  All the conventions for entering a particular type of timing (specific 
letters for each type of SMPTE, the slash /  for feet/frames, etc.)  pertain to this 
entry as well 
(e.g. +/8 or -s10).

You can create a new cue point by adding and/or subtracting time from an 
existing cue point with this feature as well.  With a selected cue point entered in 
the Input window as a starting point, Tab or click immediately to the right of 
the number. Add or subtract the time to the cue point you wish to create, by 
beginning with a plus (+ or =) sign or a minus (-) sign, and typing your number 
using the protocol of the timing system you are in ( /, : ).  Hit the Tab key, when 
you are finished entering the number, and the cursor will move to the description 
area for cue information.  Now click on OK or Enter, and your cue list will 
have a newly entered cue point.

The only wild card piece of information in this area concerns adding and 
subtracting measures and beats.  If you are working with a single Tempo from 
beginning to end of the cue then you can proceed as described above, but if you 
have been making a lot of Tempo  changes, simply adding measures or beats to 
an existing timing point may not give you an accurate result.

CUE converts measures and beats to the time specified at that measure and beat 
input point.  If, for example, you added or subtracted the input expression 
M3B4, CUE will take the TIME at Measure 3, Beat 4, and add or subtract it to 
your previous number. By entering an existing timing point into the Input 
window, you will always be adding measures and beats to some other type of time 
format (feet/frames, SMPTE, etc.).  In this case, CUE assumes that you are 
describing measures and beats from the beginning of the cue.
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Should you have varied the Tempo sufficiently, the result will be that a slightly 
incorrect time will be added in.  

The way around this is to always add or subtract measures and beats to measures 
and beats (m34b2+m3b4). When you do this, CUE will calculate the combined 
number of measures and beats and convert that into a time, taking into account all 
fluctuations in Tempo and Meter.
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The Cue Point Description
Anything may be entered in the Description field.  At times you may find it 
necessary to include a lot of detail concerning a particular timing point. CUE lets 
you enter up to 24 lines of text.  If you need more space than this, then take 
heart, if you ever finish your cue sheet, you could probably publish the document 
as a novel and advertise it as having more pages than Gone With the Wind.

Varying The Look of Your Text
Whenever the cursor is in the Description field, the Font, Size, and Style, 
buttons will become enabled, allowing you to select and change the type of font, 
it's size and/or the style that the selected material is displayed in.  

These three buttons work in a similar fashion to other Macintosh writing 
applications.  Pop-up menus appear when you click on each one of these buttons 
providing you with those fonts, font sizes and font styles which are installed in 
your computer.You can change these items at any time when entering your cue 
point descriptions:

Click and hold on the Font button.You will find that one additional item has been 
added to the top of the menu which is unique to CUE:

 Set Default to . . . allows you to select the basic font which will be used for 
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all printable documents in your current production set, with the exception of 
font, style, and size changes made to your cue point descriptions.  Set Default 
to. . . will always display the most recent font chosen.  If you select a font on 
your first click of this button, and you release your mouse button over this title 
on a second pass, your entire Cue Sheet will adopt the currently displayed font.  
Take care that you do not accidentally click twice in this manner when a font is 
displayed which was not meant to be the default setting. 

The Set Default to. . . feature is primarily intended to give those of you with 
laser or other high-resolution printers a choice of type styles which will be 
consistent with the built-in fonts of your printer.  

Some Text Editing Conventions
Although you have total freedom of entry, there are a few helpful tips for what 
you write:

There are several places in CUE such as the Score Page, the Clicks window 
and one part of the Tempo Search where because of limited space, your 
Description is abbreviated.If you can pack some recognizable key  phrase into 
the opening words of your Description, you will help yourself in the long run. 
For the time being though, don't worry about it.  This comes under the 
classification of "fine tuning".

If you are new to the world of Music Editorhood it will be useful for you to 
learn a few of the conventions used in putting Cue Sheets together.  Using a 
relatively agreed-upon description format for each cue point will create less 
confusion when several people have to use the prepared cue sheets:

Dialog is capitalized.

Capitalize the word in your description that occurs right at the timing point you 
have noted: 
          (The window SHATTERS.  Joe ran across the room and SLIPPED.)

Abbreviations:

BG Background FS Full Shot
CU Close Up INT Interior
DIAL: Dialog LS Long Shot
ECU Extreme Close Up MS Medium Shot
EL End of Line (of dialog) NARR: Narrator
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EOR End of Reel O.C. Off Camera
EXT Exterior O.S. Off Stage
FG Foreground POV Point of View
FI Fade In SFX Sound Effects
FO Fade Out ZIR Zirconium

To reverse the case of a portion of your text, select the text you wish to modify, 
hold down the Command key and hit the reverse apostrophe key (`).  Should 
your text be all upper case it will become all lower case and vice-versa.  Mixed 
upper and lower case text will still be mixed, but all the letters will be the 
opposite case of what they were.

If you want to take a block of lower case text and capitalize the first letter of 
every word, select the text, hold down the Command key and hit the semi-colon  
(;).
In case you can't remember these two commands, you will be able to find both of 
them in the Edit menu.

One more editing convention can be found in  a pop-up menu labeled "TEXT 
BETWEEN QUOTES" in the Set Cue Sheet Formats dialog box .  This lets 
you choose between the standard text styles (bold, italics, etc.) when you are 
typing a description in the Input window.  Whenever you type a quotation mark, 
the text style will automatically switch to the choice you made with the "TEXT 
BEWEEN QUOTES" pop-up menu.  When  you type another quote, the text style 
will return to the current font Style selection.

This feature does not change dialog already set in your Cue Sheet, or what you 
have just  typed or selected for the current Input description window.
 

Other Input Window Editing Tools
In the Edit menu you can also select Cut, Copy and Paste.These function in 
CUE just as they do in any other Macintosh program. Since this comes under the 
category of basic familiarity with your Mac, we will not go into detail on this. 
Suffice to say that by selecting a block of text from the Input window and 
choosing Cut or Copy, you can Paste it into another cue point.

A HELPFUL TIP: When you are entering a series of SMPTE cue points that 
are close together, you can Copy the prefix, minute, and colon from the first cue 
point into the Clipboard (for example: s7:).  By Pasting this into the Time 
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field, you only have to type in the second and frame on succeeding cue points, 
thus saving yourself a good number of key strokes.

The Key Hit Box
When you search for tempos, most probably, you will not want CUE to search 
for a tempo that catches every single entry on your Cue Sheet.  As music editors 
do, you will probably find yourself noting cue points that help you to see the 
continuity in the scene you are working on even though you there is no intention 
of catching each of these with any kind of specific musical touch.

By clicking on the check-box marked Key Hit (or typing  Command-h), you 
are telling CUE that this particular timing point is one of the cue points that you 
are interested in catching with your music.  An "X" will appear in the check-box 
which means that a check mark will be placed in the Cue Sheet margin to the 
right of the Time entry as a reminder that this cue point is a Key Hit.  A 
second click (or typing Command-h) will turn the "X" off.
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The CAM Box (***,CUT, & DISS)
Film editors often note whenever there is a cut or a dissolve from one scene to 
another.  To save you the trouble of writing this out each time one occurs, all you 
have to do is click on the pop-up menu button under the word CAM. When you 
do so, a little pop-up menu will appear giving you a choice of either CUT or 
DISS (dissolve) in addition to the three ***.  The word that you select will now 
appear in the box taking the place of the three asterisks.When you click on OK or 
hit the Enter key the chosen word will be placed on the Cue Sheet to the left of 
your description 

Another way to select CUT or DISS is to type Command / once or twice.This 
will allow you to toggle between the two words without having to use your 
mouse.Typing Command / a third time will re-display the three asterisks and 
turn this feature off.

The Stop Watch
Another very handy feature available to you in the Input window is the Stop 
Watch. It works very simply by clicking on the check box labeled Stop Watch. 
  
The first click gets the Stop Watch ready. You will know that you have clicked 
successfully because the button will be highlighted and a Stop Watch icon will 
appear to the right.

40



Either clicking on the mouse or hitting any key will start and stop the Stop 
Watch. You will know the Stop Watch has started because the face of the watch 
will become black with white hands.

The next click or keystroke stops the Stop Watch.  At this point, the watch face 
will disappear.  Most important of all, the elapsed time you have just clocked will 
appear under Time in the Input window.
 
In case you have no access to a movieola or a video tape with visible SMPTE 
numbers, you could take a timing by starting the Stop Watch at the point you 
want your music to begin and stopping it at the event whose timing you wish to 
catch.  Since the Stop Watch places the time in the correct place in the Input 
window, all you have to do is describe the event you have just timed, click on OK 
and go on to the next event.

If the time you want to catch is a long way from the beginning of your cue, you 
can time from any point in your cue by typing that point into the Time field of 
the Input window.  Now when the stopwatch starts it will be from that timing 
point instead of zero.  

The MOVE Checkbox
 
CUE does not assume that by editing a previously created cue point, you 
necessarily want to delete that entry from it's original place in the Cue Sheet.  
Often, a cue point contains a description which you want to retain, changing only 
the time for your next cue point.  If you change your mind about a cue point 
however, or wish to simply move it to another spot in your Cue Sheet, put a 
check in the MOVE box.  This will move the entire cue point entry to the new 
time you have entered in the Input window, and delete the original.  

41



Logging Multiple Cue Points on the Fly
Our Stop Watch is also a lap timer capable of storing up to 30 lap times.  What 
this means is that you can grab either 30 different cue points or dialog ins and 
outs on the fly and then go back at your leisure, and generate Descriptions for 
them later.  Here is how to log these multiple lap times:  

First go up to the menu labeled Reel World and select Log Cue Points. Notice 
that in the Input Window, the words Stop Watch have been replaced by the 
phrase: Log Cues.

The first time you click on the words Log Cues, you will see the white watch 
face appear just as you did when you were operating the basic Stop Watch.

Your next click will start the Watch, and from here on, anytime you click the 
mouse you will Log another cue point provided you don't exceed 30 different 
events. You will know that the Watch has started because it's face will be 
highlighted in black, and you will be able to tell that you have exceeded 30 timing 
points because after 30, the Watch face will disappear and the time of the 
thirtieth timing point you logged will appear in the text area where Time is 
displayed.

If you are entering less than 30 timing points, log the last one in the series by 
hitting any key on the keyboard in order to turn off the clock. Give this a try 
with a number of random timings so you can get a feel for how this works.

Now you are ready to enter these cue points into the Cue Sheet.
 

If the Time entry area is not highlighted, hit the Tab key until it is.  Then type 
L1 (you can also use the lower case L if you wish). This stands for logged timing 
point #1. Hit the tab again to highlight the description area and now you are 
ready to enter some text. For purpose of this example you may want to type the 
same event number in the text area as well so you see which events your random 
timing points correspond to.  When you hit OK or the Enter key, you will see 
the running time that you captured as cue point L1  appears on the Cue 
Sheet.
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Proceed to type L2, L3, and so on, describing each one until you are satisfied or 
until the series you entered is complete. When the last cue point you logged in 
this manner has been described, you will not be able to enter any more timing 
points. CUE will beep at you and the Timing entry area will highlight letting 
you know you have come to the end of your string.

A suggestion: If you are going to be grabbing a number of cue points on the 
fly, it helps to be organized in terms of knowing what you are going after. It may 
be possible for you to remember all twenty six timing points you hit, but it is 
more likely that you may confuse the end of a particular piece of dialog with a 
cut or a gunshot. One way to proceed might be to go for all dialog on one pass, 
all efx on another, etc.  

Note: If you enter less than 30 timing points and don't hit the Clear button, you 
will resume timing from the last point you entered should you start the Watch 
again without creating Descriptions for those points you already logged. 
Clicking on the Clear button will remove this information so you can enter times 
starting at zero.  On the other hand if you want to enter timing points from some 
place other that zero, simply enter that time in the Timing entry area and the 
Stop Watch will start logging  from the time you entered.

Automatic Timing Points Entry 
This is an aspect of CUE that can save you a major chunk of time.  It permit's 
you to pause the video copy of your film at a point you wish to log into the Cue 
Sheet and automatically enter the SMPTE number into the Time entry area of 
the Input window with a single keystroke.

Before you begin grabbing these numbers without having to type them out, there 
are several preliminary steps. The first of which involves having your video tape 
prepared correctly.

VITC & LTC - The SMPTE Twins Revealed
There are two generic types of Time Code:  

One is Longitudinal Time Code (LTC).  This is the one that most of us are used 
to dealing with.  It comes in different flavors (24, 25, 30 frame, etc.) and is an 
audio signal generated onto or read from your video or audio tape.

The second main type is Vertical Interval Time Code (VITC) which is embedded 
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into the video signal (if you request it) and is read by hooking up the video signal 
to a box that will convert the VITC to LTC.

There is a very important reason for bringing up VITC at this time:

While CUE is capable of grabbing a Longitudinal Time Code (LTC) number on 
the fly, and can also pick off a number with the tape running at slightly slowed 
down speed, CUE along with everything else which reads LTC, is incapable of 
reading a number from a freeze frame, or for that matter from a tape that is 
rolling too slowly. In addition, should you be working with a 1/2" format video, 
in almost every case the sound will disappear as soon as you start to slow the tape 
down. 

What this means is that if you want to rock your video back and forth, find the 
exact frame, freeze the tape and then click that number into the Cue Sheet, you 
will have to do something else. This is where VITC comes in.

When we freeze a video image, that single frame gets sent out 30 times/second 
(like regular full speed video) so that we can view it on our monitor. Since VITC 
is embedded in the video signal, it is also getting sent out at 30 frames/second.  As 
a result, just as the monitor thinks it is getting continuous video even though it is 
only getting the single frame sent to it again and again, a device reading the 
SMPTE number will also be perfectly happy to accurately read that single 
SMPTE frame number because it is receiving the SMPTE number at what seems 
to be regular speed (30 frames/second).

Although many video editors get very adept at grabbing frames with the tape 
slightly slowed down, it does lack a certain degree of ease and accuracy.  If you 
want the extra precision of VITC, make sure that you request your video tape 
with VITC as well as Longitudinal Time Code.  Then, hook your VITC to LTC 
converter up to a SMPTE/MTC converter that is in turn connected to the MIDI 
input going to whichever port you have set as the sync port in the MIDI Setup 
dialog box of the Reel World menu.

VITC to LTC Converters
The basic process of splitting your video signal is made easy by the 
manufacturers of the hardware necessary to convert VITC to LTC.Standard 
operating procedure seems to be placing a video-out on the back of these boxes 
thus making it easy for you to route your video signal over to the monitor after 
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you have sent it to through the converter. 

Telcom and Evertz Microsystems are two Canadian companies that make 
converters (Evertz VITC Reader/Translator Module 622, Telcom VITC) which 
work perfectly with CUE.    

When your hook up is complete, you are now ready to roll.

Grabbing SMPTE Without Getting  Dirty 
Hands:  Back to Automation

First click on the Operations menu and select Set Formats.  Organize the 
Time Formats page so that your Cue Sheet will be displaying the same 
SMPTE format that you are about to read from the video.  As with standard 
typing of cue points, your Cue Sheet will make much more visual sense this 
way.

The next item on our check list is to lock CUE to SMPTE.This can be done by 
clicking on the Reel World menu to access the Options dialog box where you 
can click on: Lock to Time Code.  An easier way to do this is to hold down the 
Command key and type the letter E. When you lock to time code, the Stop 
Watch area of the Input window will be changed to read  SMPTE Clock.

Clicking on the SMPTE Clock check box will activate this feature.To have it 
capture a number, all you have to do is roll your video tape to the frame you 
want to capture.The clock will turn black to indicate that it is getting SMPTE.  
When you click on the mouse, that SMPTE number will appear in the Time 
entry area of the Input window.  

Remember: if you are using LTC then you will have to grab your timing points 
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on the fly.  When you are using a VITC converter, you have the luxury of 
pausing the video tape before you hit the key which automatically enters the video 
frame number. In either case once the number has appeared, you can type your 
description into the highlighted Description area and click on OK (or hit the 
Enter key).
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Fine Tuning the VITC to CUE Coordination
All of us at one time or another have probably seen a line of visual "static" 
running from left to right across a freeze-framed video image. This is called the 
noise bar. In order to give us nice, clean freeze-frames, some video players shove 
the noise bar out of our sight completely above the picture. These players will not 
read VITC well because this area above the frame is exactly where the VITC 
information is stored, and the noise bar acts as a distorting mask which gets in the 
way of the VITC reader. To insure successful VITC reading, make certain you 
are using a video player that parks the noise bar where it is visible.

Since this noise bar is the dividing point between video frames, the VITC number 
that you capture might be one frame off from the SMPTE window depending on 
whether your video player parks the noise bar at the top or bottom of the 
screen.To avoid this annoyance, click on the Reel World menu and select 
Options.

Down  at the bottom of this dialog box is a feature labeled SMPTE Clock 
Adjust.  You can place any number up to 9 in the little text entry box and 
indicate whether this is to be a plus or minus compensation by clicking on the 
appropriate button.

In the case of the number in CUE's Input window always being one more than 
that which is displayed on your screen, click on the minus button, enter "1" and 
then click on OK or hit the Enter key. Once you have adjusted CUE to deal 
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with the idiosyncrasies of a particular set-up, you should be fine for the rest of 
the entries you are making during that work period. The SMPTE Clock 
Adjust is saved as a default.  

You may find this feature useful when you are grabbing LTC cue points on the 
fly.  It is possible to adjust for the rather predictable human delay times caused 
by our less-than-perfect response time. 

When you select Log Cue Points from the Reel World menu while reading 
SMPTE from an external source, your Log Cues check box will be labeled 
SMPTE Log.
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3 Working With Cue Sheet 
Information

OK, you have now been saturated with a big blast of information about the Input 
Window and a lot of you have probably been trying out some entries as you've 
been reading. This however is the official "let's go do it" place in the manual.

What follows is a series of sample cue points for you to copy into CUE. Before 
you start working on our sample cue, make sure that the Input window is set to 
receive Absolute timing information. (see page  26).

When you have entered the mandatory Time and Description, and clicked on 
the Key Hit and Cut information where needed, you are ready to log your cue 
point into the Cue Sheet. This is done by clicking on the button that is labeled 
OK (or hitting the Enter key).  After you click, you will see that the 
information you typed now appears in the middle of the page on the Cue Sheet, 
and that the Input window is clear and waiting for your next entry.

If you wish to clear the entire contents of the Input window while you are 
working in it, then click on the button marked Clear.This removes text while 
still allowing you to remain in the window. If you want to remove text from a 
specific field such as Description, you can select it by dragging the cursor 
across it and hitting the backspace key just like in MacWrite.

Should there be an error in the Time field or if the Time field is empty and 
there is information in the Description field, when you hit OK, CUE will beep 
and select the Time field so that the time can be re-entered. 

Viewing Both Timing Columns
Since we have set up our Cue Sheet to show two columns of timing information, 
it would be good to view them simultaneously as we make our entries.  This can 
be done by using the scroll bar at the bottom of the Cue Sheet window. For 
your convenience, clicking on the shaded portion of the scroll bar will move the 
Cue Sheet back and forth, either revealing both columns of timing information 
or showing the Tempo information along with the second timing column.  

There are other ways to move the Cue Sheet page horizontally.The easiest is  
hitting the Tab key which will bounce you back and forth.  You can also move 
the scroll bar by clicking on and dragging the little box (or thumb as it is called) 
or for more delicate adjustments, click on the arrows at either end of the scroll 
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bar and hold down the mouse button until you get where you want to go.

A large screen can render this process unnecessary because the Cue Sheet 
window may be expanded to the width of the whole Cue Sheet and the height of 
whichever screen you are using.

Splitting the Cue Sheet
If you don't have a big screen, but want to see the measure and beat information 
on the right of the page as well as both timing columns to the far left, then click 
on the menu labeled: Misc and select Split Cue Sheet or hold down the 
Command and the Option keys and type the letter S. This will cause both sides 
of the Cue Sheet to be displayed on the small screen.  What you lose sight of in 
this mode is the complete width of text.  You will see a double line moving 
vertically down the middle of the page showing you where the text has been 
lopped off.  Generally, enough of your initial text should be visible for you to 
know where you are in the cue.  If you want to undo this center truncation, just 
repeat this process (Command/Option S) and the Cue Sheet split will vanish, 
restoring your complete description area.

What, you don't like where we placed the split?  Well you can move the position 
of the split line as well.Just for that particular Cue Sheet which just can't be 
truncated any other way;  select Split Cue Sheet in one of the ways described 
above. When the Split line appears, you will notice a small darkened area at the 
top of the double line.  Clicking on this area and holding the mouse button down 
will allow you to drag the Split line to wherever you would like to have it on the 
Cue Sheet window.
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Sample Cue Information

    Time Key Hit's Description
s1:0:10:00*** The night sky fades in

s1:0:12:15 yes A shooting star arcs across the heavens

s1:0:15:11 Camera pans down to follow the star as it 
descends

behind some hills

s1:0:19:19 yes     CUT FS view of a glowing crater left by the impact of 
the star.

s1:0:21:14 Start to pan in toward the center of crater

s1:0:25:17           CUT MS of a large shining egg that is sitting in the 
center of the low crater.  It's 
sheer surface reflects the glowing embers 
on the ground around it.

 
***Remember that since you entered the SMPTE hour in the Running Time 
dialog box, you should not type the SMPTE hour as you enter times in this 
format.

When you enter your first cue point you will notice that several other items have 
popped into existence. Your Cue Sheet now shows how many Warning Clicks 
will precede your cue, what your starting Meter is, and also displays the Total 
Time of the cue. You can adjust both the Warning Clicks and the Meter but 
we will deal with them later in the manual. The Total Time will change as you 
add more cue points.

Also notice that to the right of the descriptions (you may have to use the Split 
Screen feature, scroll or Tab over to see this), the Cue Sheet is telling you 
what beat and hundredth of a beat each one of your cue points falls on.The 
default tempo setting of CUE is 12-0 (a 1/2 second click) and so it is displaying 
click information at that tempo. Don't worry about this for the moment. You will 
be searching for the ideal tempo very soon.

Should you wish to remove a cue point you have just entered, click on the Edit 
menu and select Undo or type Command Z.  If you have made no other 
entries, selecting Undo or typing  Command Z a second time will undo the 
Undo.
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Saving the Cue Sheet
Before we go on to do any further work with our sample cue this might be a 
good time to save it. Your Cue Sheet can be saved by clicking on the File menu 
and selecting Save Cue.  A dialog box will appear asking you to "Save current 
cue as:"  
  

After you have given it a name, click on the button marked Save (or hit the 
Enter key).  As with almost all Macintosh dialog boxes if you wish to resume 
work without saving anything, simply click on the Cancel button. If you are 
working on a file that you have already given a name and Saved, then the next 
time you Save it,  CUE will automatically update your file under the name you 
have given it.  Try selecting Save again.The disk drive will whir for a few 
moments and then you will be able to proceed.

Should you want to save your updated cue without modifying the version you 
have already saved, then select Save As from the File menu. You will be 
presented with a hierarchical menu that will let you either save your work as as 
Cue, a Score, or as a Title Page.  Slide the cursor over until Save Cue as is 
highlighted, and release the mouse button.  We will deal with the last two items in 
this menu when we come to the sections of the manual about the  Score Page 
(page 159) and the Title Page  (page 108).

After you release the mouse button, you will see a dialog box open up that has the 
original file name under "Save current cue as:".  By renaming it, you will save it 
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as a different file thus preserving the previous version intact under the old name.  
Beware: if you do not rename your file, the old version will be replaced and lost. 

Save your files frequently while you are working on them.You will probably 
find this admonition in every computer manual you read. The bottom line is, you 
never can tell when Godzilla may bite through your local power lines and send 
your unsaved work into the ozone.  Another good tip is to back your files up onto 
another disk at the end of any work period.

All About CUE
As an added assist to saving your file,  you can see how big the file is and how 
much available disk space you have on your drives by clicking on the Apple 
menu and selecting About CUE.  Clicking on the OK fine button removes this 
window.

Auto Backup
This is an option that has been provided for you so that you can save your 
previous file along with the newest version to be saved, or save a duplicate of 
your newest file update.  Although backing up your entire disk should prevent 
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you from losing data, having an extra copy of each cue on your actual work disk 
provides you with an extra level of security.

Auto Backup works in the Save (not save As) mode only. It is optional 
because there may be some people who do not wish to take up the extra disk space 
necessary to store these backups.  

To engage this feature, click on the File menu and select Auto Backup.If you 
want to make sure you have done this correctly, click on the File menu again and 
you should see a check mark to the left of the words: Auto Backup.  

When you Save a cue, CUE will check the disk to see if that file already exists. 
If it does, CUE will rename it "bak.filename" before saving the new version of 
the cue. What this means is that you now will have saved the next to the last 
version of your file as your backup. If you want to save two identical copies of 
your most recent version of the cue, then select  Save twice in a row.

Naming Your Files
A word of important advice on naming your CUE files: Save As lets you choose 
the title under which the cue is saved to disk. This is different from the cue title 
you gave it in the Set Cue Info dialog box. Set Cue Info provides an internal 
name for the cue that is useful within CUE. The name you give your file is the 
one which will appear under the Cue Icon in the Finder.

If you are working on a project with multiple cues in it, then the suggested 
naming procedure is to create a production code to use as the beginning of 
each file name.  After creating your consistent production code title, place a 
slash ("/") and and something to make that filename unique.  In most cases this 
unique part will be the cue number.  

The film title of the example used throughout this manual is called Zarkov 
Unchained. If you use "Zarkov" as your production code then the name used to 
save the first cue in reel one which has been entered on the Cue Sheet can be 
called "1m1"- the whole title then is:  Zarkov/1m1.  Any other cues you save 
from the same film would all be preceded by the same code, (Zarkov/6m2,  
Zarkov/3m5, etc.).
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The usefulness of taking the trouble to do this will become clear when we deal 
with the Master Cue List, Spotting Notes, and the Performing Rights 
Cue List. In both these applications, CUE uses file names to locate all the cues 
from a particular production: ("Zarkov"). 

Do not be concerned about all your backup files ("bak.filename") creating a lot 
of unnecessary duplication by appearing on the Spotting Notes, Master Cue 
List and the Performing Rights Cue Sheet.The reason CUE puts "bak." at 
the beginning of the name is so CUE will ignore these files when it goes 
searching disks for a particular production code name.

If you are using 800K disks, or a hard disk initialized with the Hierarchical File 
System (HFS), you will have to use the production code when naming your file 
folders: (Zarkov/Reel 1, Zarkov/Reel2). On MFS disks, folder names are 
ignored.While this means MFS users don't have to be as meticulous when labeling 
folders, careful naming does help to keep your files organized.

Big Fat Note:  This is the first of several places in the manual where we want 
to caution you not to place your cues in a folder with any name on it other than 
that of the specific production you are working on followed by a slash (/).  If for 
example, you place all your files in a folder marked "CUE Folder", when you go 
to compile your Spotting Notes, Master Cue List or Performing Rights 
Cue Sheet, CUE will not be able to locate the files you are trying to work with, 
resulting in consternation, frustration and a phone call to find out why your CUE 
won't do this advertised task. 
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Restoring Your Cues
If for any reason, while you are working on a cue, you wish to return this cue to 
the last version you Saved  click on the File menu and select Revert.  You will 
be presented with this dialog box:

Clicking on Yes will reopen the previously Saved version of the cue.If you 
made a mistake by calling up this dialog box then click on Cancel and it will go 
away without affecting your current cue.

Clearing Your Cue Sheet
To clear your Cue Sheet, click on the File menu, select New, and you will be 
given an option to save any changes in the current cue.After you make your 
choice, the Cue Sheet will be cleared of all cue point entries. Any of the 
information you previously placed in the Set Cue Info, Set Production Info 
and Set Formats dialog boxes (see pages 15, 19, 24, 65, and 116) will be 
retained except for Written, Orchestrated, Copied and Recorded. The 
assumption is that if you are entering multiple cues on a given project, most of 
this information will remain the same. All  you will have to update in most cases 
is the Cue # and the Cue Title.
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Modifying the Cue Sheet
Editing Cue Points

Making changes to a cue point which is already part of the Cue Sheet is an easy 
matter. If the Cue Sheet is the front window, clicking once on any part of the 
cue point line, and holding the mouse button down, will cause a pop up menu to 
appear that looks like this:

This menu is a great little time-saver. When it first pops up, the word Edit will 
be highlighted.  This means that when you release the mouse button the Input 
window will appear with that particular cue point entered into it ready to be 
edited. If you want to change whether or not this cue point is a Key Hit, simply 
selecting the words Key Hit in this menu you will switch the status of this cue 
point without you having to call up the Input Window so you can click on the 
Key Hit box.

The other items in this menu will be dealt with in other sections of the manual. 
Nudge up and Down on page 58, Accel\Ritard on page 132, and Move Cue 
Points on page 81.

Lets find a cue point for editing purposes. Open the sample file,"Zarkov/1m2, or 
the completed sample cue you have hopefully stored. As we have described 
before, clicking on any visible part of your Cue Sheet window will bring it 
forward, if other windows have been placed in front of it.  You can now use the 
scrollbar at right to find a cue point you wish to edit, should the length of your 
cue place the point you are looking for off the screen.  In the case of 
"Zarkov/1m2" the single cue point of the cue will be front and center. Your 
sample cues may take some scrolling. Click anywhere on the cue point line.  The 
pop up menu will briefly appear with the Edit line flashing, and then 
immediately open the Input window for you.
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Remember that once you have made changes to the cue point you are editing, you 
will have to click on the OK button (or hit the Enter key) to update this cue 
point on the Cue Sheet.  If you decide against these changes before you have hit 
OK, you can either highlight the Time and Description and replace what is 
currently showing, or click on the Clear button to clear the whole Input 
Window.

You can get rid of an edit you just entered either from the input window or the 
Cue Sheet by clicking on the Edit menu at the top of your screen, and selecting 
Undo (or type Command Z).   

As we have mentioned elsewhere in the manual, don't forget the "power keys" 
which you can use to type in various commands without having to select a 
window and click on a selection using the mouse. Mice are notoriously slow. Note 
the "clover leaf" Command symbol, opt symbol, and then a letter next to many 
of the selections in various menus.  Holding the Command key, or 
Command/opt combination (if both are present) down while you press the 
indicated letter will create the same result as clicking on the menu and selecting 
an item.  Memorizing the "power keys" for your most frequently used commands 
can take a great deal of operating time off your paperwork, and leave more time 
for composing (or a night on the town).  

Back to the sample "Zarkov" cue which was entered before. Let's decide that we 
want to make the medium shot of the egg at s1:0:25:17 into a Key Hit. Go to 
the Cue Sheet and edit this cue point to get a feel for the process.  Also proof 
read what you have typed to see if your typing has provided you with any other 
opportunities to edit our little cue. 

Nudge Up/Nudge Down
This litlle feature increments or decrements the time of your selected cue point 
by the smallest division of your current Time Format (Command-A). If you 
are entering Absolute SMPTE NDF (B&W), the nudge divisions will be one 
frame.   
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Deleting a Cue Point
There are three main ways that you can delete a single cue point.

The first method is achieved by clicking the offending cue point into the Input 
window just as you did when editing. You can now delete it by going up to the 
Edit menu and selecting Delete Cue Point. A variation on this is to type 
"Command d".  

A second cue point deletion technique is to type the time of the cue point you 
wish to delete into an empty Input window. Typing this time into an Input 
window which has no description information, and then clicking on the OK 
button (or hitting the Enter key) will remove the cue point from your Cue 
Sheet.  

You can undo your most recent deletion by clicking on the Edit menu and 
selecting Undo (or type Command Z).   

A third method of deleting a cue, or number of cues, can be achieved with fewer 
keystrokes than the methods above. Hold down the Shift key and click the mouse 
button over the line or lines you wish to delete. Then hit backspace, delete (on 
newer keyboards), or the clear key.  A dialog box will appear:  

Click on the appropriate answer, and the cue sheet window will return with the 
selected cue or cues deleted.

Type a bogus cue point or two into the sample cue you are working on and try all 
of these methods of deletion to see which ones you like better.
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Deleting a Range of Cue Points
There is also a more precise way of deleting a range of cue points.The following 
dialog box can be brought up in the Edit menu under Delete Range:

Deleting a Range will work in either Absolute or Relative Time so make 
sure that the footages you are typing into the dialog box are taken from the time 
column that corresponds to the way the Input window's title bar reads.

You can use the Tab key to move between the two boxes, or use the mouse to 
move the cursor into place.  Timing information can be entered in feet/frames, 
minutes:seconds, SMPTE timings or measures and beats.
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Place the time of the first cue you wish to remove in the box marked: Delete 
from, and the time of the last cue in the series you wish to delete in the box 
marked: to.You can now begin to vanish all the designated cue points by clicking 
on OK, (Cancel returns you to the Cue Sheet).There is a fail-safe step to 
prevent you from incorrect deletions, so before you can complete the process, 
this extra dialog box will appear: 

  

If you want to proceed, click on Yes and your deletion will be complete.

IMPORTANT NOTE: Deleting these cue points will NOT affect the length of 
your cue.  By removing them, you will now be able to use the Change Cue 
Length feature in the Operations menu to make the necessary time deletion.

Converging Cue Points
 CUE is so precise that it distinguishes between very small variations in time. 
When you switch time formats (from SMPTE to feet/frames for example), the 
different resolution factor between the two formats may exaggerate the on-screen 
rounding off just enough so the program won't recognize the cue point you wish 
to delete or edit.  

As a result, when you ask CUE to remove a point that is different from any 
stored in it's memory, it may balk. When you are editing such a contrary cue 
point, you may end up with a duplicate cue point that is just a hundredth of a 
second different. 

There are several ways you can deal with this:
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The Mystery Feature
Perhaps the best way to deal with this problem is to go to the Cue Sheet 
Formats sub menu of the Set Formats menu located in the Operations menu 
and make  sure that the Mystery Feature is clicked on.

This means that if you are trying to delete or edit a cue point which varies from 
the time stored in CUE's memory because you are now working in different 
format from the one you originally chose, CUE will recognize this minute 
difference and let you delete or edit without having to make any further 
adjustments to the time. 

One of the few conditions where you might want to disable this feature will be 
for Cue Sheet entries less than ONE FRAME apart. Under this circumstance 
CUE might become confused, and you may  want to employ Justify Timings 
to solve the problem. 

Justify Timings
The second way to continue working in a time format where you are having 
difficulty deleting a cue point is to actually make the internal timings conform to 
the ones you want to edit in.  Internal times are not rounded off every time you 
change formats, as this could have a cumulative effect which might cause your 
timings to "wander" from their original points.

If  you do not need to make great numbers of small shifts, then conforming the 
internal timings to the display will not cause any problems. Click on the 
Operations menu and select Justify Time. Notice that in parenthesis next to 
the words Justify Time, you are told whether CUE is currently set for 
Relative or Absolute time. Cue will Justify Time in either format, 
according to the one you have set for your current Cue Sheet.  

When you select Justify Time, the following dialog box will appear as a 
precaution to give you the opportunity to chicken out.
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If you wish to continue, click on OK or hit the Enter key and the cue will be 
justified.  To abort this process click on Cancel.

Cue Sheet Wrestling
Another method for dealing with problem cue points is to go back to minutes, 
seconds and hundredths of a second, or move to Relative Time, if it is in 
seconds and hundredths.  

One final suggestion is to revert to the time format that you entered the cue in 
and make your deletions or edits.

Printing Your Cue Sheet
In  order to print your Cue Sheet, select Print  from the  File  menu.  When 
you do so, a hierarchical menu will appear giving you the choice of printing a 
wide array of documents that CUE is able to generate. Each one of them is 
discussed in their own part of the manual.  For the time being we are only 
concerned with Print Cue Sheet, so select this (or type Command P), and you 
will be presented with the standard Macintosh printing options.  Make the 
appropriate choices and click on OK (or hit the Enter key).  

CUE will put the date and time on every Cue Sheet you print so you can always 
tell which is the most recent copy.  

Note: If the document that gets printed out looks strange, you may not have all 
the appropriate font sizes installed as part of your system file.  (See Apple's 
documentation on the Font D/A Mover.) In order to print Best on your 
Imagewriter, you will need font sizes installed that are twice the size of the one 
you wish to print. (For example: to print 12 point in the Best mode, you will 
also need 24 point installed.)
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Selection of Best or Faster for your printout will best duplicate the quality of 
your on-screen material.  Selecting Draft as a print option will give 
unpredictable results.

Printing From the Finder
If you want to print a numberof cues, it is best to go to the Finder, hold down 
the Shift key, select the icons of all the cues you want to print and then choose 
Print from the File menu.  When you do this, a special dialog box will be 
displayed on the screen before the standard Macintosh print options are made 
available to you:

If you are printing Cue Sheets and Score Paper, (see page 159) make sure 
both boxes are clicked "on". To continue, click OK, or hit the Enter key and 
you will be presented with two Macintosh page setup dialogs followed by two 
print option dialog boxes one after the other.  Beneath each of them will be a title 
indicating whether you are setting the print options for Cue Sheets or Score 
Paper. This will allow you to have different printing specifications for each 
form in the same print run, such as printing your Cue Sheets vertically and 
your Score Pages horizontally.

Once you have set up both sets of printing options and clicked on OK or hit the 
Enter key for each of them, the printing will commence.

Should you be printing out a large amount of material, our advice is to click on 
OK and go eat lunch.  The Imagewriter is not known for setting speed records.
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Set Cue Sheet Formats
The appearance of the Cue Sheet both on screen and in it's printed form can be 
varied in a number of ways other than what sort of Time Formats we want to 
display.  Click on the Operations menu and choose Set Formats again so we 
can examine some of our other options.

Once the hierarchical menu appears, select Cue Sheet Formats and the 
following dialog will appear:

Another way to call this dialog box  up without using the menu bar is to hold 
down the Command and  Option keys while typing the letter F.  A third way to 
call up this dialog is to click on the Cue Sheet heading labeled Click #:.If you 
want to move to the other pages of this dialog, click on the OK andTurn Page 
or Cancel and Turn Page buttons at the bottom of the page depending on 
whether or not you want to save any changes you have made to this dialog.

Remember, if you want to see any changes you make in this dialog box actually 
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become part of the way the  Cue Sheet is displayed, you have to click on OK or 
OK and Turn Page.

Screen Setup

Under Set Formats an option has been created to allow large screen owners a 
measure of choice for dialog box observation. Select Screen Format from the 
sub-menu, and the following graphic dialog box will appear:

The two checkboxes at the top, will allow you to configure CUE dialog boxes on 
you screen in various ways. The first checkbox (above) comes up immediately 
upon selecting Screen Setup:  Dialog Centering on Big Screens:  Five 
rectangles are presented to you. These rectangles represent relative positions on 
your screen that dialog boxes will appear when you click select them from a 
menu or from a window. Click on an area of the screen with one of these boxes. 
It will highlight. Now click on OK and return to the Cue Sheet.  

Test your selected screen position by bringing up a box.  For instance, type 
Command-R.  Your Running Time dialog box should appear in the general 
area of your screen, selected in the Dialog Centering box. The larger your 
screen, the more you can avoid covering your cue descriptionor crucial numbers 
with a dialog box.
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Checking the second box, Area to Activate Custom Menu, presents a 
modified screen graphic with several small rectangles along the bottom and lower 
sides of the white center-screen image.

A special area for bringing up your Custom Menu  is created you highlight one 
of these side or bottom areas.  Click OK and return to your Cue Sheet. Now 
when your mouse cursor moves over the area of your screen selected in the Area 
to Activate Custom Menu box, your Custom Menu will appear.

When you highlight the separate rectange at the bottom of the shaded area in your 
picture.  The "pop-up" Custom Menu feature will be turned off.  If in fact, you 
decide to made no changes to your default Screen Setup, just click on Cancel.

Selections made in the Screen Setup dialog boxes will be included when you 
Save Defaults.

Music Info in Cue Sheet

Music Info in Cue Sheet is here as an aid to music editor/composer relations. 
By clicking the Don't Display button, you can turn off the visual display of 
Warning Clicks, Tempo, Meter and most important,  Bars/Beats. This lets 
a cue sheet reach a composer without giving the impression that the editor is 
making musical suggestions.  (The musical data is not lost.  Clicking on the button 
next to Display will restore all this information to the screen).
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 Cue Point Display
A Cue Sheet as prepared by a music editor usually has many more cue points 
listed on it than the composer wishes to catch with his music. By going to Cue 
Point Display and clicking on Key Hit's Only, the Cue Sheet  will now 
show or print out only the cue points which you have designated as Key Hit's. 
By removing all the non-essential cue points, a much more focused examination 
of the cue can be achieved. (Once again, this information is not lost.  It can be 
retrieved by clicking on the button labeled: All Cue Points.)

Click Display
Click Display switches the Cue Sheet between displaying Clicks either as a 
total number of Clicks or as Measures and Beats.  If you do not want to use 
the Formats dialog box you can toggle between Click # and Measure/Beat by 
typing Command-Y.  Measures and Beats will become more useful later on, 
so let's stay with Clicks for the moment.

Beat Divisions
The wide array of choices for how you display the actual Beat Divisions  
in the Cue Sheet  can be accessed in four different ways. In addition to 
clicking on the button next to the Beat Division of your choice in the Set 
Cue Sheet dialog box, you can choose Change Beat Div. Display  in the 
Misc. menu, or for the greatest ease and speed, hold down the Command 
and Option keys and type the letter D.  Each time you type D, you will 
toggle between one of the four Beat Division options without ever having 
to leave the Cue Sheet .

Hundredths and Other Fractions
CUE displays it's fractional beats in decimal hundredths of seconds as a default 
setting, but another options is to display the fraction of your choice. By typing a 
number into the highlighted text entry box under Beat Divisions, you can 
display your beat information in any fraction up to a 999th.

One way this could be useful to you is if your sequencer supports step entry. If 
your sequencer divides a beat into 480ths for example, you can see your timing 
points displayed as exact beats and sequencer ticks that exactly correlate to the 
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sequencer, making it possible to enter notes at exact timings even if they don't fall 
on musical subdivisions. 

Another use of this feature is to break the beat into musical divisions. For 
example, by entering a 2 into the text box, the beats will now be rounded off to 
the nearest eighth note (an eighth is half of a beat). 

Notice that when you enter a number in this text box, the button next to it is 
automatically toggled on. If you want to go back to decimal hundredths, click on 
the button marked 100ths.

The Great Beat Round-Off
Another way to deal with hitting certain cue points is to round them off to the 
closest beat and then conduct the hell out of the orchestra so they speed up and 
slow down to compensate for the inherent "errors" in the music you have written.

To activate this feature go to the Set Cue Sheet Formats page (Command 
Option-F).  By clicking on Round Off Mode under the title  Beat Divisions, 
and then on OK, you will convert the beat display to a mode where it not only 
rounds off the beats but also displays in parenthesis to the right of each beat how 
far off you are in plus or minus fractions of a second.
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Beat Display With Notation

There is a fourth choice for ways to display the beat division that each 
timing point occurs at.  Again under Beat Divisions  in this Set Cue 
Sheet Formats  page, you will see an entry entitled Notation. Clicking on 
Notation will cause a note value to be displayed after the click number in 
your Cue Sheet.This is especially handy for the many instances where 
accuracy in hitting a cue is really a function of the nearest musical beat, or 
part of a beat that is practical to write in traditional notation.  Note:  In 
Notation mode, the cue point indicated will come at the end of the note 
indicated to the right of the beat number.
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Accelerando/Ritard, Click Tap Display
We will go into using the Accelerando/Ritard feature in much greater detail 
on page 132 and information on Click Tap can be found on page 215. Quite 
simply Accelerando/Ritard makes a number of Tempo decisions that will 
speed up or slow down the click track between points which you designate and 
Click Tap allows you to tap out an entire click track by hand. If you want to see 
every single Tempo decision that CUE has made in either of these two cases, 
then click on the button marked All Tempos.  

If you only want to see the opening and closing Tempos and whether an 
Accelerando or Ritard is taking place, click on the button next to Beginning 
and End Only. Since CUE will make a great many Tempo shifts to accomplish 
a given Accelerando or Ritard and will follow your every human nuance when 
you tap out a click, you may want to examine them only to satisfy your curiosity 
since they could take up a great deal of space on the screen or the printed page.

Space Bar Character

When entering times into the Input  window or at any other point in CUE 
where you are prompted to enter a time, you can use the space bar as a short cut 
to enter the proper Time Format  consistent with your current needs.  

Input Error Checking
Every once in  a while you will type a number into the Cue Sheet that is way 
off.  What will usually happen is that you will type an hour in when you meant to 
type a minute, or a minute when you meant to type a second. Often this won't be 
noticed until later, particularly when you are flying along typing lots of cue 
points as quickly as possible.

Entering a time in the text box that is between 0 and 99 seconds activates this 
feature without a click into the radio button.  From this point on until you click 
in the radio button to turn this feature off, CUE will compare each time 
entered into the Input  window to the previous time entered, and if it is 
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less than the previous time or if the difference between the two is more 
than the number of seconds you specified in Input Error Checking , the 
Mac will beep and a dialog asking Really?  will appear.  If you click on 
Yes, this cue point will be entered into the Cue Sheet .  If you click on No, 
then you are returned to the Input  window where the Time entry will be 
highlighted and you can correct your mistake.
The assumption here is that if you are entering timing points in 
chronological order, each timing point will be later than the one before and 
that most of them will be in fairly close proximity to each other.

TheMystery Feature 
This is the option that allows you to delete and edit cue points that would 
otherwise just sit there and snicker at you.  For more detail on this, see page 62.

Text Between Quotes
The text between quotes is a pop-up menu. It enables you to choose 
between the text styles(bold, italics, etc.) of test inserted between quotes 
in the cue description of the Input window.  When in the input window, 
whenever you type a quotation mark the text style will automatically 
switch to the choice you made with the Text Between Quotes pop-up menu.  
When you type another quote, the text will toggle back to the default style 
setting
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Saving Your Default Settings
As you use the program more, it is quite likely that you will develop certain 
tendencies concerning how you like CUE to be set up. By clicking on the File 
menu and selecting Save Defaults you can preserve the settings on the three 
"pages" of the Set Formats dialog box as well as those of the Options, 
Streamer Options,and MIDI Setup dialogs located in the Reel World menu.  
Other items included in the Save Defaults package are the amount of Pre-Roll 
specified in the Reel World menu's Generate SMPTE dialog box, the position 
of windows on the screen, Screen Setup, MIDI Channel Names, Custom 
Menu settings, and whether or not you have selected Auto Backup from the 
File menu.  

Using  Save Defaults will allow CUE to be set up on screen just the way you 
like it every time you open the program.  Save Defaults will cause CUE to 
save and duplicate any customized window placement you create, as well as the 
size of the Cue Sheet and Click windows.  This comes in handy for anyone 
working with a large screen or a Mac II, where you have the space to spread 
your windows out for greater visibility over the broad expanse of the bigger 
screen.

If you have made any changes to your default settings that you would like to 
preserve, you can do so by selecting Save Defaults again.  Should you have 
made any changes to your default settings and not saved them, CUE will remind 
you of this when you Quit the program and give you the option of saving them 
(or not saving them) at that time.

Should there be some point that you would like to return CUE to it's original 
settings without going through a lengthy process of going from dialog box to 
dialog box, you can Quit  the program and look in the Finder for a file marked 
CUE 3.0 Defaults. By throwing this in the Trash, you will permanently 
dispose of the customizing you have done.  
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Fine Tuning Your Cue Sheet
We have now reached a crossroads in this manual. For all intents and purposes, 
you are at a point where you now know enough about the Cue Sheet and the 
Input window so that you can go ahead with the vital task of determining the 
appropriate Tempo for your cue.

On the other hand, there are still a number of useful features that the CUE Cue 
Sheet has which we have not yet described. It's your choice. Our suggestion is 
that you skim over the remaining features very briefly, but let your main 
concentration flow into feeling comfortable with your own cues.

Your Cue Sheet is written. The bulk of your typing is behind you.  Now this 
information is ready to go to work for you. Tempo Search begins on page 123. 
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4 Additional Cue Sheet Features
The Preface

There will be times where you will find it useful to have some general 
information in the Cue Sheet which will appear before the first cue point. This 
could be anything from a description of the previous cue, to information on 
synthesizer sync tones or a list of undergarments worn in the average Victorian 
household.  

By going up to the Operations menu and selecting Set Info, a hierarchic menu 
will appear allowing you to select Set Preface.  After you do so, a dialog box 
will appear that permit's you to enter up to 6 lines of text.

 
If you are satisfied with what you have written then click on the button marked 
OK (or hit the Enter key).  The dialog box will disappear and you will see that 
the Preface you wrote now appears before the first cue point.
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If you have no cue points entered, the Preface will not appear even though you 
have typed it in and clicked on OK. This is correct CUE behavior. As soon as 
the first cue point is entered, your Preface will be there.  

Note:  Once a preface has been entered, you can edit it by clicking on it with the 
mouse.  This will bring up the Set Preface dialog box without you having to 
access the  Operations menu.

Entering the Preface Into Your Spotting Notes

There are times when an editor has to start taking timings even before the 
spotting sessions take place.  When this happens there are some editors who like 
to be able to transfer what they have written in their Cue Sheet Preface into 
their Spotting Notes. To accomplish this with CUE, go to the Edit menu and 
select Preface to Spotting Notes. If you then move to the Operations menu 
and select Set Spotting Notes, you will see the text of your Preface appearing 
in the text entry box. Provided you have Saved your file with this new 
information, it will appear in the Spotting Notes when you print them out.

To find out more detail about Spotting Notes, see page 100.
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The Reverse Slash 
Once thought of as the most feared fencing technique in Heidelburg, the reverse 
slash (\) has taken on a whole new meaning in CUE. There will be times when 
you may want to show some timing points that directly follow your cue without 
having CUE take them into account as part of the cue.  By making the reverse 
slash (\) the first character you type in the Input window under Description 
and clicking on OK (or hitting the Enter key), you will be telling CUE to make  
the Total Time of the cue equal to the time of that cue point. Try adding a 
reverse slash to one of the Descriptions of our sample cue and you will see the 
following:

A line now appears directly after that cue point with the word Reference: just 
below it.  Also note that the Total Time of the cue is listed as the time of the cue 
point with the reverse slash.

 Set Count Off
You have probably noticed by now that  below the title on the Cue Sheet is a 
line which has generally been reading: 8 WARNING CLICKS BEGIN  AT . 
. . followed by a time. Although this line is most pertinent to CUE's ability to 
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play the click track of a given cue, we will go over this feature now because we 
are unraveling all the mysteries of the Cue Sheet in this section of the manual.

Set Countoff allows you to program a variable amount of warning clicks before 
CUE begins to play the cue with all it's Tempo and Meter changes. The amount 
of clicks is adjusted by clicking on the Operations menu and selecting Set 
Count Off.   

If you wish to change the number of Warning Clicks from the default setting 
of 8, type in another number and click on the button marked OK (or hit the 
Enter key). You can program up to 29 Warning Clicks. When you enter "0" 
Warning Clicks, the display will not appear in the Cue Sheet. As with our 
other dialog boxes, clicking on Cancel removes the dialog box and leaves 
everything the way it was.

The number of Warning Clicks is displayed on the Cue Sheet with it's own 
start time for a very important reason:  Often, because a piece of music starts 
softly or begins on an off-beat, it becomes a judgement call for the editor as to 
exactly where the composer intended the cue to begin.  A deviation of even a few 
frames may cause the music to feel early or late, particularly if it is catching a 
number of events.  If you place the Warning Clicks on to the mix or transfer 
of your music, an editor can cut the cue into the film precisely because he knows 
exactly where the warning clicks begin. 

Since the Absolute Time Format will determine how the start time of your 
Warning Clicks is displayed, CUE can provide an editor with either 
feet/frame or SMPTE information depending on which medium the editing is 
being done in. This, coupled with the fact that your first Warning Click's time 
is calculated by computer, greatly eases the physical process of combining music 
with picture.
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Note: You can change the number of Warning Clicks without using the 
Operations menu.  The appropriate dialog box will appear if you click on the 
Warning Clicks line where it is  displayed on the Cue Sheet. 

Change Cue Length
As long as we're dealing with making the editor's task easier, here is another 
feature that removes a minor nightmare from the job. Imagine this reel-life 
drama:  All the timings for a scene have been taken down and translated from 
feet/frames into minutes:seconds.  The phone rings.  It's the director.  He has just 
decided to add three frames into the middle of this scene. "That's not a problem, 
is it?" he asks solicitously.  Now you get to recalculate every single timing point 
that happens after the three frame addition.  You smile through gritted teeth and 
begin. But wait, in the distance, the sound of a bugle echoing through the hills: 
it's CUE to the rescue.

Before anything else happens, make sure that one of your timing columns is set 
for Absolute Time in the same time format that the director is working with 
and that the Input window is also set for Absolute Time so you will be ready 
to make modifications to the proper time format.   Once this is done, click on the 
Operations menu and select Change Cue Length (or type Command-L), 
and you will be presented with the following dialog box:  

This is a warning that you won't be able to Un-do this procedure by typing 
Command Z or by selecting Undo  from the Edit  menu.  If you wish to 
proceed, click on OK, or hit the Enter key.
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The first choice to make is whether you are inserting or deleting time and this is 
done by clicking on the appropriate button. To the right of these buttons is the 
box for entering the amount of time by which the cue is being changed. Any valid 
time format including measures and beats is acceptable.  

Next, tab or position the cursor into the other entry box, which will then enable 
you to enter where the time change is to take place. If you insert this time change 
at the same time as an existing cue point, it will move that cue point (and 
everything after it) by whatever the amount you have entered into the first box. 
To keep that timing point intact, just add the time change at a point which falls 
before the cue points you want to move but after the ones that you wish to to 
remain the same.

Adding time is a straightforward proposition. Lets say that we have to add 10 
seconds and 6 frames to the sample cue which was entered back under Lets 
Enter Some Stuff on page 49 at 19 seconds  and 19 frames in. Type s10:06 
into the first box and s19:19 into the second box. Click on the OK button and 
you will see that 12 seconds and 15 frames have been added to all the cue points 
after 1 minute, 32 seconds and 2 frames.

Deleting time has an extra rule connected with it:  In order to prevent you from 
removing a cue point by mistake, CUE will not allow you to enter a time 
deletion which would eradicate one of your entries. Try deleting 16 seconds at 18 
seconds and 4 frames frames into the cue. The Macintosh will beep at you and 
send you back to the time entry box to try again.

If the previous cue point is so close that there is no way you can enter your 
deletion without overlapping the next cue point, you will actually be removing 
that cue point from the film. To do this, go to your Cue Sheet and remove that 
unwanted cue point thus permitting the deletion to be entered.(See Deleting a 
Cue Point and Deleting a Range of Cue Points  starting on page 59)
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In the case of our example, there is more than a foot between the two cue points 
that bracket our deletion, so enter a foot count in the "at" box that is more than 
one foot before the cue point which is giving us a problem. If you do this, the cue 
point will be preserved and CUE will accept your deletion.

Although we have not yet taken up Tempo Search, this note is for later when 
you are using CUE on a project:  Should you have already calculated your 
tempo, be sure to check and see where the newly recalculated cue points are 
falling.  Unless our director changed the length of the film by an even beat,  you 
will probably have to do a new tempo search.

Move Cue Points-An Insanity 
Prevention Tool

Using Move Cue Points in the Operations menu provides an alternate way to 
change the length of the cue you are working on. It was developed to cope with 
the following unpleasant scenario that befell a music editor friend of ours:  

Imagine this: You have taken down all the timings from a film and created Cue 
Sheets.  All of a sudden, wholesale changes to the picture begin to stream 
through.To make matters worse, absolutely no information is provided that lets 
you know where the additions and subtractions to the footage occur. Your only 
way of realigning your timing notes is to go through each reel examining cue 
point after cue point to see where changes have taken place.  

When you find a discrepancy,  you have to calculate the difference between the 
new timing and the one on your Cue Sheet  and then modify each subsequent 
cue point until you get to the place where the timing differential changes again.  
Calculating, recalculating, adding and subtracting the differential within each 
reel, reel after reel . . . the worst kind of work.  But then, you are being paid by 
the hour aren't you?

CUE provides the following help:

When you come to a cue point whose timing has moved, click on the Operations 
menu and select Move Cue Points. You will be presented with the following:
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If this reminder strikes fear in your heart, click on OK and when the dialog box 
appears, click on Cancel. If not, then you can proceed. (Remember that selecting 
Revert from the File menu will return your Cue Sheet to the last version that 
you saved.) 

Using Move Cue Points is very straightforward.The first text entry box 
marked: Move Cue Point  at, is where you enter  the time of a cue point which 
no longer conforms to the recut picture. The other box labeled, to is where you 
key in the new timing that this cue point appears at. Once again we want to 
remind you (not that you have forgotten) to make sure that at least one of your 
timing columns, as well as your Input window is set for Absolute Time, and 
that you are entering your changes in the same format as the director's. Don't 
forget as well, that your hour (if in SMPTE) has already been set in the Running 
Time box, and so should not be added again

When you click on OK, two actions take place . First, your cue point now 
appears in the Cue Sheet with the updated time, and second, CUE calculates the 
difference between the old and new timing point and either adds or subtracts that 
time from all subsequent cue points in your cue.
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A short Cut
From the Cue Sheet, clicking and holding the mouse button down on the cue 
point whose time you wish to change will bring up a pop-up menu. Release your 
button over the Move Cue Points entry and CUE will automatically put the 
time of this cue point into the first entry area of the Move Cue Points box.

It's still a laborious task, but at least you won't need a straight jacket with built in 
solar calculator.

Multiple Versions of Your Cue
There may be times when more than one way to score a particular part of a film 
may seem attractive. CUE gives you three versions of any given Cue Sheet so 
you can work on several musical approaches at the same time and compare them 
easily by clicking from version to version.

The Version Number is displayed in the Title Bar of the Cue Sheet 
Window.

You access the Version Number by clicking on the Version menu and 
selecting Version 1, 2 or 3. The number of whichever version you choose will 
be displayed in the title bar of your Cue Sheet along with your file name.

An alternate way to change Versions is to hold down the Command key and 
type either "+" (or "=") to move forward through the Versions, or Command 
"-" to move in the other direction. If you are not sure what Version you have 
moved to, you can click on the menu to check your progress.

All the cue point information will be exactly the same on all three versions. Any 
data you type into the Input window of any of the versions will appear 
identically on the other two.

What can be different from version to version are the Tempos, Meter 
Changes, Offsets and Warning Clicks.
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Copying one Version into Another
If you want to try another approach to the cue that has only one or two minor 
changes from the one you are working on, select Copy Version from the 
Version menu and you will be presented with this dialog box:

The dialog box assumes that the version of the Cue Sheet you are currently on is 
the one which you wish to copy from. Changing to a different version of the Cue 
Sheet will allow you alter it's wording. Clicking  on the version number you 
wish to copy into will cause an exact duplicate of the original to be created when 
you click on OK.  Now you can make your modifications without having to re-
enter all the information that is identical in both versions. 

Selecting the Final Version  

Since the Tempos and Meter Changes you set in your Cue Sheet affect the 
Click Track which CUE outputs, there is a safety feature to prevent you from 
playing the wrong Version at a session. When you select a Version from the 
menu, you will see that one of the Versions appears in out l ine . This is the 
final Version.

To set your final Version, select the one you want and then click on the 
Version menu again and select: Set Final. If you click on the menu one more 
time, you will see that the Version you just chose now appears in out l ine .To 
show you which is the final Version without your having to click on the menu, a 
dot (•) will appear next to the Version number shown in the title bar of the Cue 
Sheet window. 
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Locate and Get Next
Locate, which is found at the bottom of the Edit menu, provides an easy way to 
zero in on specific aspects of your Cue Sheet. When you select it you will be 
presented with this dialog box:

You can use this Locate feature to find specific words or phrases much as you 
do in most word processors. Enter the word(s) you wish to find and click on OK 
(or hit the Enter key).  The dialog box will disappear and the first cue point 
containing the word(s) will appear in the Input Window. To make locating and 
changing the word(s) easy, they will be selected.

Get Next or Command-G will locate each successive occurrence. When there 
are no further occurrences of the word(s) then the following will appear:

What makes this particular Locate dialog box unusual is that it can also be used 
to find Key Hit's, Cuts, or All Cue Points. Clicking on the button next to 
whichever one of these you would like to locate will cause CUE to place Key 
Hit's, Cuts, or All Cue Points in the Input Window instead of a specific 
word or phrase. You use Command-G to locate the next occurrence just as you 
would with a work or phrase.
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Typing Command-G after selection of All Cue Points is a far quicker way to 
bring each cue point into the Input Window in succession than having to go 
back to the Cue Sheet for each desired Edit.

Scale Time-The Incredible Shrinking Cue Sheet

This is one of those features that you may not have to use too often, but if you do, 
you will be very glad of it's existence. It is designed to deal with situations where 
you find that the original timings are proportionately different from the ones you 
are now working with. There are two basic scenarios within which this may 
happen: 

One scenario is when you are trying to match up your drop frame SMPTE video 
tape with a Cue Sheet whose timings have been taken from a movieola without 
use of the film frames at 23.98 fps format (see page 32).This is a frustrating 
and not uncommon occurrence because when a video copy has been made of a 
film master ten minutes long, the video copy will last 10 minutes and 18/30th 
seconds (18 video frames) to cover the same distance that a movieola or kem does 
in 10 minutes even.  

If you are converting to non-drop frame (B&W) SMPTE , Cue Sheet timing 
points will match the video perfectly. But if you convert the standard feet/frame 
timings to drop frame SMPTE, you will encounter a small problem. CUE is very 
precise. Ask it to convert 10 minutes of feet/frames to 10 minutes of 30 fps 
SMPTE (whether drop or non drop) and it will do so. Thus your Cue Sheet will 
match the movieola, but not the slower moving video.  Since drop frame is "stop 
watch accurate", your video tape will be exactly 18/30th seconds (18 video 
frames) longer when you compare your video's SMPTE window to your Cue 
Sheet's ten minute span.  How do you deal with such a small but maddening 
discrepancy?

One suggestion is to try and bite off the numeric keypad on your Macintosh key 
board. If however you find this action to be counter-productive, you can use 
Scale Time to save the day.
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Click on the Operations menu, select Scale and then Scale Time from the 
hierarchic menu that appears.  You will first be presented with this dialog:

This means that you cannot type Command-Z, and have the Scale Time return 
to the original cue points. If you have been saving your work right along 
however, you CAN revert to your previously saved version.  

Now click on OK  and you will get the actual dialog box:

For the moment we will ignore the text entry boxes and focus on the bottom of 
the dialog box where you can click on a button that says B&W to Color and 
Color to B&W.  Here B&W is shorthand for non-drop SMPTE (30 FPS) and 
Color stands for drop frame SMPTE (29.97 fps).  By clicking on B&W to 
Color and then clicking on OK (or hitting the Enter key), you will 
automatically scale your Cue Sheet to reflect the slightly slower speed at which 
your video tape is running.  After you return to the Cue Sheet, the percentage 
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your cue has been scaled will be shown in the third line from the top of the Cue 
Sheet and both your Cue Sheet  and your video timing will agree.

If you want to see how this works, set the Cue Sheet up so that your Absolute 
column shows drop frame SMPTE, enter a cue point of exactly ten minutes and 
then follow the steps outlined above.  When you have done so, you will see that 
this timing point is now ten minutes and 18 frames and that your Cue Sheet has 
been scaled by 100.1 percent.

If you have gone ahead and worked out your Tempos before you noticed the 
Scaling discrepancy, you can also click on Scale Tempos and High Res (High 
Resolution) so that CUE will accurately scale your Tempos along with your 
timings. Now you won't have to work out a whole new set of Tempos.

The other basic scenario where Scale Time saves you time,  is through an 
occasional slip up in the transfer process, where SMPTE numbers on your video 
may not match the clock on the wall, yet the SMPTE is proportionally correct. It 
is under circumstances like this where the two entry boxes in the center of Scale 
Time become important.

Lets use a radical example: You have a piece of film that should take 30 seconds 
but because it has been transferred too slowly, the SMPTE numbers show that it 
takes 37.5 seconds.  You have blithely gone ahead and created a Cue Sheet based 
on the SMPTE numbers before the mistake was spotted. With the aid of CUE, 
you don't have to recalculate and re-enter all your cue points. You can instead re-
scale the whole Cue Sheet to compensate for the proportional difference 
between reality and the video you used when you took your original timings.

As you did in the previous example, click on the Operations menu and select 
Scale Time.  CUE can calculate the ratio between a specific cue point in your 
Cue Sheet and the new (correct) time your cue point should appear at. Armed 
with this information CUE then proportionally scales all the rest of the cue 
points to fit this new relationship.  All you have to do is enter two numbers. Into 
the box marked Move Time at, enter the time of your current (incorrect) cue 
point.  
Placed the  new time for this cue point into the box marked to. Remember NOT 
to add the SMPTE hour originally entered in the Running Time box. CUE has 
already done this for you.
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Click on the box marked OK or hit the Enter key if you want the Scale Time 
process to take place A dialog box will appear indicating the percentage of scaling 
needed to change your selected cue point to the new time:

                              
 
Click OK if you wish to proceed, or anywhere else inside the box if you wish to 
bail out of the process and return to the cue sheet. If you clicked OK, your cue 
sheet will be modified to reflect the changes.  Remember that Scale Time is not 
undo-able, but you can Revert your cue to it's prior form if that previous 
version was the last one that you Saved.

The percentage that your cue has been shifted now appears on the Cue Sheet in 
the area just above the Warning Clicks.

                       
Note that if you use Scale Time in the Absolute Time mode, the Running 
Time you have set will be subtracted from both the at and to entry boxes before 
calculating the scaling percentage.

Scaling a Portion of the Cue Sheet
If you ever need to proportionately scale just a part of your Cue Sheet, here's 
how you do it:
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Scroll the Cue Sheet to the first cue point that is to be included in the Scaling.  
Hold down the Shift key and click on this cue point. After you click you will see 
that this cue point is now highlighted.

Next, scroll to the cue point that is to be the last point in the section to be scaled. 
Hold down the Shift  key and click on this cue point. As you do so, that cue point 
and all the others between it and the first cue point you clicked on will become 
highlighted. Now when you do the Scale Time procedures outlined above, only 
this highlighted portion of your Cue Sheet will be affected by the scaling 
process.

Since the amount of the Scale Time refers to only a portion of the Cue Sheet, 
the percentage will not appear at the top of the Cue Sheet but after you have 
clicked on OK, or hit the Enter key to begin the scaling, it will instead be 
displayed in a dialog box that looks like this:

Should it be important for you to know what percentage of  scaling has just taken 
place, this is the point to note it down somewhere.

Scaling Tempos
If you have been reading about Scale Time thinking how nice it would be to 
Scale Tempos without Scaling Time, you can.
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By selecting Scale Tempos from the hierarchic menu that appears when you 
select Scale in the Operations menu, you will call up the following dialog box:

                               

In order to Scale Tempos you enter the Starting Click, the Ending Click, 
and what Ending Time you want that Ending Click to fall on.  For most 
precise results, also click on High Res (high resolution) before you click on OK 
(or hit the Enter key).  After completing this process you should see your 
changes entered into the Cue Sheet:

     
Since you can enter both a starting and an ending beat, you could choose to scale 
only one part of your cue, or several different sections of your cue, each one 
scaled to it's own particular proportion.  As with Scale Time, cue points can be 
selected by holding down the shift key and clicking on the beginning and ending 
cue points you wish to include in a range.  With this range highlighted, selecting 
the Scale Tempos box will send that range to their respective Starting and 
Ending click boxes.
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In case you need a bit of visual help finding the right bar-beat or click numbers 
to enter into the Scale Tempos box while that box is on the screen, we have 
added the following text-key aids:

Y (the letter): toggles Cue Sheet between click or bar-beat display.
up/down arrows: will the scroll the Cue Sheet behind the dialog box so                    

that you can see various points in a cue which extends                           
beyond  the window.

Creating a Custom Menu
If you start to feel a bit overwhelmed with all of the menu bar searching and 
mouse clicking needed to repeat certain necessary tasks, it's time to use the 
Custom Menu which pops up the first time you open your Cue Sheet. You can 
also retrieve the Custom Menu by clicking on any exposed part of it on your 
screen; moving up to Windows in the menu bar; clicking and sliding down to the 
Custom Menu; or simply typing Command Opt-M.

When your Custom Menu  is open, you can click on any of the titles in it's 
window to open or perform that function. If you click on the Save Cue 
title for instance, the Save Cue  dialog box will immediately come up and 
prompt you for it's normal Save  information. When the Save Cue 
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operation has been completed, the title will appear in outline until another 
title is selected from the Custom Menu .

Of course, every production has it's own special needs. You may well find 
that a particular item (or series of them), not found on the default Custom 
Menu list is constantly needed for your work. That's just why we have 
constructed the Custom Menu .You can add any CUE function found in the 
Menu bar of CUE to the Custom Menu , by replacing one or more of the 
default entries with the needed function.

To replace a Custom Menu  entry, click on the Add Item  check box above 
the current list. Select a title you wish to replace from the list below, and 
click on it.  The selected item should be highlighted, and will flash to show 
that it is active.  Now move up to your Menu bar, and select the function 
you wish to place into your Custom Menu  list.  When you click on the 
desired item, it will automatically appear in the highlighted, flashing box, 
chosen for it.

Follow this example.  Click on a visible edge of the Custom Menu , Select it 
from the Windows  column above, or type Command Opt-M . When it has 
come to the top of your screen, click on the Add Item Check box.  If you 
have not previously selected other items in the Custom Menu, the top 
entry of the list will be highlighted:

Lets keep this entry, and move to another for the sake of example. Click on 
Conversions toward the bottom of the list:
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With this box highlighted and flashing, move up to the Reel World menu, 
and select Generate SMPTE . This entry should now replace Conversions 
in the Custom Menu  box:

If you wish to replace another other entry, click on it and follow the same 
process.  Continue your replacements until the Custom Menu  reflects 
your best working format. When you are done, click on the Add Item 
check box to deactivate the entry procedure. Click on your newly added 
items to see that they function properly.

Cue Sheet Surgery
Breaking Cues
When you are receiving instructions coming from someone else, make sure to 
find out whether they are in Absolute or  Relative time, so that you will break 
the cue in the correct place.

There are two steps to Breaking a Cue.

The first step is to click in your Cue Sheet window on the cue point that will 
end the first part of your cue. When it appears in the Input window, type a 
reverse slash (\) as the first character in the Description and click on OK (or 
use the Enter key). This designates everything after the edited cue point as 
reference material. It is this part of the cue that will become the second cue.

The second step is to click on the File menu and select Break Cue.  
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If you have previously Saved the reverse slash and any other changes you may 
have made, then CUE will go ahead and break the cue.  Should you have any 
unsaved changes, the following dialog box will appear:

Should you wish to keep a copy of the Cue Sheet in it's original form, then click 
on Save As, which will allow you to give a different file name to the cue you are 
about to break.  When you click on Save, CUE will save the cue and proceed to 
break the cue into the two parts.  

The second part of the cue will be saved with an "A" appearing after the name. 
Thus, the second part of Zarkov/1m2 will appear as Zarkov/1m2A.

It is important to note that CUE has not saved the first part of the cue in it's 
shortened form.  Should you want the second half of the cue to appear as a 
reference, you can select Revert from the File menu and the entire cue would 
reappear with the reference point in it that you last Saved.  If you are sure you 
want to keep the cue in it's shortened version, you can save it without 
Reverting.

After saving the abbreviated cue, you would have to use the Merge function if 
you wished to put the two parts together again.

Merging Two Cues From the Same Reel
Merging two cues that are in the same reel can be a very easy process if you 
follow a few basic rules. It can also be like wrestling a greased gorilla in a phone 
booth if you don't. The key is this: When your Running Times are set, CUE 
will handle the Merge automatically if your cues are labeled correctly.

1.  Enter your Running Time on every cue.

2.  Label your cues correctly.  
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CUE recognizes production codes from the file name, so use the same 
production code followed by a slash (/) as in Zarkov/1m1, with every file that 
is part of a particular project.  Since CUE can tell that cues are from the same 
reel from the cue numbers you enter into the Set Cue Info dialog box, be 
certain that this information (1m1, 1m2, etc) is in place and correct. 

It is only when CUE sees two cues from the same production and the same reel 
that it will correctly merge them without you having to enter any additional 
information. 

CUE merges a prompt-selected cue to that cue which is already in the Cue 
Sheet. So whichever cue comes first needs to be in the Cue Sheet before you 
proceed.Open Zarkov/1m1 for a test of this procedure.  Click on the File menu 
and select Merge Cues.  You will be presented with a directory. Pick which cue 
will be appended to the one already in the Cue Sheet.

Double-click on Zarkov/1m2, and you will see the following:
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Under the first cue is a box where you can enter the time that the first cue ends, 
and under the second cue is a box for entering the time when the second cue 
starts.  

If these cues had more than one "page" to them, you could flip forward or back 
through the "pages" of either cue by clicking on the Next or Previous buttons 
under each cue.

Should you not want to follow through with this Merge Cue, then clicking on 
the Cancel button will return you to the Cue Sheet.

Examine the number displayed in the End at: box. Instead of listing the time of 
the last cue point in 1m1, it is showing where it plans to start 1m2. Since CUE 
has everything under control, we need do no calculations and can click on OK 
(or hit the Enter key).  This will complete the Merge and return us to the Cue 
Sheet, where  we can now examine our merged cue.

If you decide not to keep the results of your merge, click on the File menu and 
select Revert, which will permit you to restore the cue to it's original form.
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Merging Cues From Separate Reels
Probably one of the places you will most often encounter the need to Merge 
Cues is where there is a reel change right in the middle of a cue or where you 
end up dealing with a non-mechanical reel change.

Every step taken in the previous merge example applies here, right up until the 
point where you would click OK (or hit the Enter key). Since the two cues are 
from different reels, CUE does not know how to connect them. This means you 
will have to help out by placing an end time in the End at: box under the first 
cue.

When Merge is chosen under any circumstance other than two correctly labeled 
cues from the same reel, the time displayed in the End at: box represents the last 
cue point of the first cue.  Add to that number the amount of time which 
separates this cue from the beginning of the second cue, and the Merge Cue 
operation will take place successfully.

If you want to cut off the second cue's beginning, take the time of the second cue 
where the merge should begin, point and enter it into the Start at: box.  Again, 
clicking on OK (or hitting the Enter key) will complete the merge.Try this by 
combining Zarkov/1m2 with Zarkov 2m2. 

 As a result of a radical cut that the director made, Zarkov/2m2 now starts six 
seconds after the end of Zarkov/1m2. In fact, he has cut directly to the second 
cue point in Zarkov/2m2 as well. Enter your Merge Cues comparison page 
and type 1:15.17 into the End at: box, and 4.17 into the right hand Start At 
box. Merge the two cues. You will now see that CUE has not only placed the 
beginning of what had been Zarkov/2m2 six seconds after Zarkov/1m2, but 
has begun on the second cue point of the second cue as well.
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All the timings of what had been 2m2 have been recalculated. Whether the same 
Tempo will work for all of this new extended cue is another matter 
completely…

Set Change Over
After the director's radical cuts of Zarkov, executed with a dull hatchet, your 
cue 4m4 now spans two reels. While the Relative times need to stay the same, 
halfway through the cue the Absolute times need to reflect this reel change 
over. The Set Change Over command under the Operations menu enables 
you to do this:

Enter the end time of the current reel you are working in, and the start time of 
the next reel. All Absolute times will now reflect the change over, while the 
Relative times remain the same. If you would like to see a notice of the change 
over in your cue sheet, then click the Show Change Over box and CUE will 
print a Reel Change message in the Cue Sheet at the correct place. 

We are using SMPTE numbers here, since our "work print" was striped with 
SMPTE.  Remember however, you have only to change Time Formats in 
Multi-print, to get your feet/frames numbers in a print-out for the music 
editor.
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After a Change Over has been included in your cue,both you and CUE will 
need to keep the Absolute and the Change Over times straight. Here is how 
it's done:

Enter Change Over Times
Now you have a reel change over in the middle of a cue, and CUE will need to 
distinguish between not only Absolute and Relative times upon input, but also 
between the Absolute and the new Change Over time. After all, this is ONE 
cue, and we want to enter it as such.  Make sure you are in Absolute Time 
mode (Command-A), go to the Operations menu, and place a check next to 
Enter Chg. Over Time(select it).   The Input window will now let you enter 
times occuring after the change over.  The top of the Input window now shows:
 

Change Over time is only a form of Absolute time, where the SMPTE hour 
(reel number) has changed, and Relative time is unaffected by the reel change 
over. The Enter Chg. Over Time title will be greyed out in the Operations 
menu, unless you are in the Absolute Time mode.

If you wish to return to entries in your previous Absolute Time (cues before 
the change-over), or want to enter Relative time cue points, uncheck the Enter 
Chg. Over Time or use Command-A to return to Relative Time.
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5 Spotting Notes
While the Spotting process may be the first practical use for CUE as you begin 
work on a feature, we have placed the information at this point in the manual so 
that you will already be familiar with the basic workings of the Cue Sheet.

Spotting Notes allows you to enter information about the film, and also sets up 
all the files you will need later to generate Cue Sheets. With the exception of the 
actual Spotting Note description, all information typed in here will be entries 
you won't have to duplicate when actually producing the Cue Sheet.

You create Spotting Notes by clicking on the Operations menu and selecting 
Set Spotting Notes. The following dialog box will open:

If you have a Cue Sheet in memory when you select Set Spotting Notes,  
titles, times, and description notes (if entered into Set Spotting Notes at an 
earlier point) will show up in the boxes here.

The large box at the top of the window is provided for you to enter a brief 
description of the scene, or edit those notes which have appeared there from the 
Cue Sheet in memory. 
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The next items will seem familiar because we have already met them in the Set 
Cue Info and Set Running Time dialog boxes. Typing in the Production 
Title, Cue # and Cue Title will automatically place this information in the Set 
Cue Info dialog box.  For a correctly ordered print out, make sure you number 
your cues in the Cue # box using the form rrMss, where rr  is the reel number 
and ss  is the start number (6m4 is the fourth cue on reel six).

Entering the Start Time is just like entering the Running Time (page 20) and 
will place the data into that dialog box.  Remember that if you are entering a 
SMPTE number you should place the SMPTE hour in the box labeled for this 
purpose, and just type SMPTE minutes, seconds and frames into the box labeled: 
Start Time.

Typing the end point (without the SMPTE hour) of the cue into the box marked: 
End Time, will create a single cue point in the Cue Sheet  whose description 
will be: "End of Cue".  Although you won't be able to see it in the Cue Sheet, 
this End Time  has a Reference Point embeded in it's text.  You will only 
notice the Reference Point function if you try to type in timing points that fall 
later than the cue point marked End Time.  If in fact a Reference Point 
appears when entering data to the Cue Sheet, you have probably entered cue 
points past the original end the cue entered here.  If you wish to continue on past 
this point, delete the reverse slash (\) which begins the description of that cue 
point, or delete the whole "End of Cue" cue point and proceed.  

You can have only one Reference Point per Cue Sheet. If there several 
entered, CUE will display the first one it comes to in the Cue Sheet as a 
Reference Point  and ignore any later Reference entries.)

A space is provided to type in the name of the Music Editor. This information 
will get included in the Title Page assembly (page 108 ).

The last items in this dialog box are the four buttons at the bottom.

Save New Cue allows you create a new cue with the name you have entered.  
Clicking on this button will bring up a Warning box telling you that proceeding 
with this operation will completely erase any cue points currently in memory, 
and replace them with the information you have entered in the Set Spotting 
Notes dialog box.  After clicking on OK, enter a new cue name, or save your 
material under the one currently in memory. Be careful not to lose valuable cue 
points and cue descriptions by replacing a previously created cue through the 
Save New Cue procedure.  
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Save Edit will save the existing cue points in currently in memory, and add the 
Spotting Notes dialog information to this material. You should always use 
Save Edit if you want to add or change the spotting notes on an existing cue. 
Clicking on this box will bring up the Save Current cue as prompt. You can 
save you cue under the name currently in memory, or create a new one.  

Be sure that you follow all the naming conventions for files and folders described 
under Naming Your File and Saving Your File (page 54) for both the Save 
New Cue and Save Edit selections.

Two other buttons are included at the bottom of this box. Open lets you select 
other files for editing without having to leave this dialog box. Done returns you 
to the Cue Sheet in memory after you have finished Saveing, or allows you to 
exit without modifying the Spotting Notes box.

Displaying the Spotting Notes
Printing your Spotting Notes takes place in an identical manner to the Master 
Cue List and the Performing Rights Cue Sheet procedure. Make sure that  
your files are named correctly with the production code (name) followed by a 
slash (/) and your Cue or Reel designation. Make sure as well, that your files are 
not nested within any other folder(s) with a different name. 

Click on the Windows menu and select Spotting Notes. The following window 
should appear:
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Create your Spotting Notes compilation by typing the "production code" name 
into the box at the bottom left of the window. If you have named your files 
correctly with the production code followed by a slash (/) and the cue number, 
then CUE will be able to accurately search and compile the report. Do not add 
the slash or cue number to the Production Code box.  

Production # and Session # boxes are included at the bottom of this window as 
well.  They will reflect what has been entered in the Set Cue Info box for those 
cues which are being edited.  Only cues with matching session numbers will be 
displayed upon clicking OK.  CUE will look for Cue Sheets with matching 
Session #s when 1 through 9 is entered in that box.  Thus you can search for 
cues that are from a specific production and session.  Television series coded with 
the same production code, may well use these additional qualifications to display a 
particular episode. To begin a search which discriminates according to 
Production # or Session #, the words Prod. # and/or Session # must be 
highlighted, with the proper numbers entered into their associated boxes.

Session # Entries other than 1 through 9 will cause all cues with matching 
Production Code numbers to be included in the compilation.
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Before you click on OK, (or hit the Enter key) to initiate the search procedure, 
be sure that CUE knows about all the disks you want to include in the search.  
Any disks that have not been placed into a disk drive since you opened the 
program should be inserted at this time.  Clicking on the Eject button will 
remove disks currently in use so you can place other disks in your drive.  You 
can repeat this process as many times as is necessary, although if you are careful 
with your disk management you should be able to get an entire film onto a single 
800K disk.

Now click on OK and you will be asked if you want to Search or Skip each disk 
that has been inserted since you began your current use of CUE. If you have 
forgotten any disks, you will have to go through the Search  procedure all over 
again, so it is good to be organized before you start.

After all the disks have been searched the Spotting Notes will appear on the 
screen in the identical manner in which they will print out:
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Each Reel number will appear in Bold, along with the number of music starts 
found in that reel indicated in parenthesis after it. The top line of each Spotting 
Note lists the cue number, cue length and cue title. Beneath this are the start and 
stop times of the cue in the current Absolute Time Format as well as the 
musical usage. To the right is the description entered in the Spotting Notes 
dialog box.  

At the very bottom of the report you will find the total musical starts for the 
entire production listed in bold face type.  This is followed by cummulative time 
for each type of musical usage (entered in the Set Cue Info for each cue), and 
finally the total quantity of music for the entire production.

To actually print out the report, click on the File menu and select Print 
Spotting Notes from the Print sub-menu.

Organizing Your Files
Virtually all Macintosh users these days will be running with HFS (Hierarchical 
File System) initialized disks and will want to put cues in nested folders. Your 
folder names must start with the "production code" and a slash (/) in order for 
them to be included in a search. The folders can be nested as deep as you want as 
long as they follow the naming convention. For example, you might have a folder 
named Zarkov/Cues that contains other folders named: Zarkov/Reel 1, 
Zarkov/Reel 2, Zarkov/Reel 3, etc.Each of these folders would contain the 
actual cues.

Note:  Systems using the old MFS (Macintosh Filing System) are probably not 
capable of running CUE 3.0.

Big Fat Important Note: We are trying to call particular attention to 
this next point because in the years that this program has been available to the 
public, this is the single most asked question:

It goes something like:"All my files are named correctly. Why can't I compile my 
Spotting Notes (or Master Cue List or Performing Rights Cue 
Sheet)???"  
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The most common mistake made by CUE users is that after they have named 
their cues correctly and placed them in folders that also follow the labeling 
convention of the production code followed by a slash (/), they place all of their 
CUE material into a folder labeled CUE or Film Stuff or Top Secret or 
Winky the Dog With No Name.  Doing this makes it impossible for CUE to 
recognize and locate the files it is being asked to compile into a report such as 
Spotting Notes. Do not put your files into a folder labeled with anything other 
than the production code if you expect this feature to work.

Entering Your Spotting Notes Into the Preface
If you find that it would be useful to see the first 5 or 6 lines of a Spotting Note 
appear as the Preface in the actual Cue Sheet, you can easily accomplish this by 
clicking on the Edit menu and selecting Spotting Notes to Preface when you 
are back in the Cue Sheet window. Since the text entry box for Spotting Notes 
is larger than the one available for your Preface , you will not be able to 
transfer a longer Spotting Note  in it's entirety. A suggestion would be to 
make sure that all key information you want transferred is up near the beginning 
of the Spotting Note.
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6 Creating a Title Page
Once all your basic information has been entered into Set Spotting Notes 
and/or Set Cue Info, CUE can create a Title Page quickly and easily. Click 
on the Windows menu and select Title Page in order to proceed.

At the bottom of the window are a number of labeled rectangles that you can 
drag anywhere in the workspace located above the dividing line. When you 
release the button on the mouse, the box you have dragged will instantly display 
the corresponding information you have loaded into the Cue Sheet. Dragging 
the boxes below the dividing line removes them from the layout.  

Title, Other and Composer derive their information from items you have 
filled in on the Set Cue Info dialog box.  Editor pulls the editor's name from 
the Set Spotting Notes dialog box. The Date and Time come from the clock 
that is a basic part of the Macintosh.
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The only boxes that do not work this way are the ones marked Text and Logo.

Text lets you enter a short line of miscellaneous information in the little text 
entry box at the far right of the top line. Since space at the bottom of the page 
prohibit's the display of all 50 characters you can enter, you may want to move 
the small box marked text above the line where it will then display all the 
characters you are typing.

The Logo box is for the placement of a logo that you work out in MacPaint or 
some other related art design program. Once you have created your artwork, 
transfer of it to the Title Page is done by having both your art program and 
CUE open at the same time using Multifinder, or by using a Desk Accessory like 
Art Grabber.

Click on the box marked logo and drag it on to the area of the page where you 
wish to place it. When you release the mouse's button you will see that the box 
has expanded in size considerably and is now highlighted black. This means that it 
is ready to receive. By copying the Macpaint art or "grabbing" it with one of the 
many graphic copying DAs, you can proceed to paste it into CUE by typing 
Command V or selecting Paste from the Edit menu.  Your logo will appear on 
the work page portion of the Title Page window in the identical size that you 
created. Clicking once on the logo will unhighlight  it.

If you want to make your graphic bigger, you can do so by clicking on the Logo 
box once more. This will highlight it again and also bring up two small boxes at 
the upper left and lower right hand corner of the Logo. Dragging the box at the 
lower right horizontally will increase the width of your Logo.You can expand 
the height if you drag the box downward (vertically).  Reversing these actions 
will decrease the size of your Logo.  

If you drag in a diagonal direction you will modify the Logo height and width 
simultaneously.  Holding down the Shift key while you drag the mouse 
diagonally will modify the length and width in perfect proportion to one another. 
Holding down the Command key and clicking once on the little sizing box will 
pop your logo back to it's original size.

The little box at the upper left of the Logo is used to drag the Logo to any place 
on the page that you wish to have it displayed.
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Centering Your Work
There are two ways to automatically center the various items on the Title Page.

If you click on the item labeled Center, an "x" will appear in the box to it's left. 
Any item that you drag up into the work area will now jump to the center of the 
page as soon as you release the mouse button.

When you have set something on your Title Page that you now wish to have 
centered, click Center "on" and then click on the item you want to have 
centered. It will instantly appear at the middle of the page. To center the logo in 
this manner you must click on the little box at the upper left hand corner of the 
logo.

Holding down the Shift key while dragging will lock the item to a vertical grid. 
Clicking on it with the Shift key down will cause the item to snap to a vertical 
grid.

To see what your whole Title Page is looking like, click on Show Page which 
will create a miniature version of the whole page so you can study the overall 
placement of all your items. Notice that this button now reads Show Screen. 
Clicking on it again will return you to your work screen.

Saving Your Title Page
You save your Title Page by clicking on the File menu and selecting Save 
Title Page As from the sub-menu of the Save As entry. Once you have done 
this, your Title Page will appear in the Finder looking like this:

Printing Your Title Page
Click on the File menu and select Print. A Heirarchic menu will include Print 
Title Page which you can then select.

110



Opening a Saved Title Page
The Title Page is saved as a template that can be reused on each new project. It 
will display the title, composer, etc. of the cue that is currently in the Cue Sheet. 
The only adjustments that might need to be made when you start a new project 
are in items that you want centered.

To open your Saved Title Page click twice on the Title Page icon in the 
Finder, or if you are already in the program, click on the File menu and select 
Open Title Page.
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6 Tempos
For most of us, this is where we say goodbye to the Click Book.  

CUE will search for your Tempos and Offsets and allow you to place multiple 
changes of Tempos and Offsets into your Cue Sheet.  It will also calculate 
Accelerandos and Ritards so you can re-time any cues for which you can't 
find a perfect Tempo.  These modifications to your Cue Sheet will affect both 
the custom Score Paper you create as well as the Click and Sequence 
Playback Modes, so it is here that CUE kicks into high gear on behalf of the 
composer.

When you add the ability to hand tap a Click Track, enter up to 400 different 
Tempos in a single cue,  Scale  the Tempos for all or part of a given cue, and 
Calculate Tempos from Beat and Time, you can see what a powerful ally 
CUE can be in your work.

The Click Book
Although one of the central purposes of CUE is to render the traditional Click 
Book unnecessary, there may still be times when you will find it useful to consult 
one. Because of this, CUE provides you with a super Click Book which you 
can access by clicking on the Windows menu and selecting  Click Book, or 
typing Command Opt-K.
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For those deprived unfortunates who have never had the opportunity to fondle 
the sacred pages of a traditional click book, an explanation of the above display is 
in order.

Each page of a Click Book lists the first 599 beats of the current tempo and the 
times at which they occur.  In the example page above, a 12-0 click tempo has 
been selected. Beat #1 hit's at 0.00 seconds, beat #3 at 1.00 second, etc. To help 
you find a particular beat in this sea of numbers, the "one's" column of the beat 
number is listed across the top of the page and the "ten's" column is listed down 
the left. To find beat number 57, for example, find the number 50 in the "ten's" 
coumn and then move right to the column under the number 7 . You will find that 
beat 57 falls on the 28th second. The entire list of 599 timing points can be seen 
by using the scroll bar to the right of the window, and scrolling to the bottom of 
the page.

While the CUE Click Book looks much like it's printed counterpart, it has a 
number of special features which greatly enhance it's flexibility and speed of use.  

The first and most important feature in the Click Book is time format selection. 
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The Click Book display will show all of it's timing points in whatever Time 
Format you have set in your Set Formats dialog box under the Operations 
menu. You can select the Set Time Formats dialog box from the Click Book 
window without returning to the Cue Sheet. There are two columns in this box.  
 CUE will display the Click Book timing points in the time format chosen for 
Relative Time. The Click Book time format will not respond to format 
changes if both columns are set to display Absolute time. However, when you 
change the Relative time column from one format to another, you will see the 
new Time Format instantly displayed in the Click Book window.

Second, the Click Book  will work with any of the tempo formats available to 
you in the Set Tempo Formats window of the Set Formats dialog box. The 
tempo format you have chosen will be shown as part of the title at the top of the 
Click Book window.

A Third feature is the ease of navigation through the Click Book numbers to 
the time point you need. At the bottom of the window there are three areas for 
entering text. They are labeled Tempo, Find Click # and Find Time. 

 When you type in a beat number and hit the Find Click # button, that specific 
beat will be highlighted on the page. If you type in a time and click on Find 
Time, the beat that comes the closest to that time will be highlighted.

If you enter a tempo in the current Tempo Format, and then click on the button 
marked Tempo, the Click Book will display the first 599 beats of that tempo in 
the current Time Format. You can hear the selected tempo from the Mac 
Speaker, audio output  or MIDI Click Source, by holding down the shift key and 
clicking on the Tempo button.  A second click will stop the audible pulse. The 
audible metronome can also be muted or unmuted by selecting the Clicks 
On/Clicks Off item in the Misc menu.

To the far right are two buttons marked Prev and Next. By clicking on them 
you can decrement or increment the tempo by one step for each click of the 
button.  By stepping up or down you can quickly see what tempo comes the 
closest to catching the highlighted beat nearest to the time in the Find Time 
area.  Beats per Minute will be incremented or decremented by 10ths or 100ths, 
depending on what you have set in the Set Tempo dialogue box.  Should you be 
in the 24 frame Fractional Mode, the Prev and Next buttons will change the 
tempo by an 80th of a frame.
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Loading a Cue
To work with Tempo Search, let's call up another cue which will be more of a 
challenge as it has more cue points than our current sample.  Click on the File 
menu and select Open Cue from the pop up menu that appears when you select 
Open. You will be asked if you wish to save our current file in it's most recent 
form.  Make a  "yes/no" decision on this and you will be presented with a 
standard "open" box that lists what you have on your disks.

Open the file called Zarkov/1m2 by clicking twice on it. (If you do not see that 
file listed, click on the button labeled Drive which will change your file dialog 
to the other drive where you should see it listed. It is also possible that the file 
may be nested safely inside a folder, which means you will have to double click 
on the folder title to see what is listed in it.)

If you are choosing this file from the Finder, click twice on the icon that looks 
like this:

        The Macintosh will load not only "Zarkov/1m2", but also CUE.
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Selecting the Tempo Format
We dealt with setting the Time Formats as part of the Cue Sheet Setup on 
page 24.  Now is the time to get to know the Tempo Format feature better. Select 
Tempo Formats from the Set Formats sub-menu in the Operations menu. You 
can also type Command opt-T.

Tempo Format gives you the choice of whether you want to base your Tempo 
on Film Frames (frames and eighths of a frame per beat with the option of 
dividing each frame into eightieths if you select fractional tempos),  SMPTE 
Frames (frames and eightieths of a frame per beat at 25, 29.97 and 30 frames a 
second), or Beats Per Minute with the option of dividing the beats into either 
tenths or hundredths.  Click on the Tempo Format you wish to work in and 
then click on OK (or hit the Enter key).

Let's click on Frames Per Beat @ 24 Frames per Second since this is a 
format lots of film composers are comfortable relating to. If you try any of the 
other formats for experimentation, you will see that the second line from the top 
of the Cue Sheet will list the Tempo  Format you have chosen.
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Setting a Tempo
Let's suppose that you already know the Tempo that you want to set. Select Set 
Tempo in the Operations menu (or type Command T), and the following 
dialog box will appear:

What you have here is a flexible Tempo control center that gives you the option 
of making as many as 400 different Tempo changes per cue. The Tab key 
allows you to move most easily between the 4 entry boxes, but you can use the 
mouse as well.  By typing in your Tempo choice and clicking OK (or hitting the 
Enter key), you will set the cue to that Tempo.  To leave this dialog box, click 
on Exit. 

Whatever number is entered in the box labeled: Starting at click #, will 
determine the beginning point of  the  Tempo selected in this window. Use the 
default setting of 1 if you wish to begin your cue with this tempo. If the Cue 
Sheet behind this dialog box has the click numbers displayed as bars and beats, 
you can switch them to only clicks by typing "y" (either upper or lower case).

The box directly below, Ending at click # this lets you designate an ending 
click number for the Tempo change you are making. If no number is entered in 
this box, the tempo selected in this window will play through the end of the cue.  
By entering an ending click, you will be returned to the previous Tempo at that 
point. As an added reminder,  the small box to the left of the Ending at click # 
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line  must be checked in order to specify an ending tempo. To save you a key 
stroke, the box will become automatically checked whenever you enter an ending 
click.

Being able to enter different Tempos at different spots in the cue lets you fine-
tune your Click track in  those cases where a single Tempo or Offset will not 
work for the entire cue.  When you enter a Tempo in the middle of your cue, 
the Cue Sheet will display the change you have made.

To see how this works (and looks), enter a Tempo at some click point other than 
1, click on OK, and check your cue sheet behind your dialog window. In the 
following example, a Tempo of 11-5 in 24 fps format was entered starting at 
click # 28).

If you wish to cancel the Tempo you have just set, click on the Undo Last 
button.

You can recall and modify the different tempos entered into your Cue Sheet by 
clicking on the Previous Tempo and Next Tempo buttons of your Set 
Tempo window.  This will cause the starting and ending click # as well as the 
tempo of the previous or next tempo to be displayed.  You can click back or 
forward as many times as you have Tempos entered in either direction.  Another 
way to move through the different Tempos is to use the right and left arrows 
on the keyboard.

Scrolling the Cue Sheet Behind the 
Dialog Box
If you want to scroll the Cue Sheet behind this dialog box you can do so by by 
hitting the up/down arrow keys on the keyboard.  
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How to Hear Your Tempo
Clicking on the button marked Play in the Set Tempo dialog box will cause 
CUE to play the Tempo you have displayed in the SetTempo dialog through 
the Mac speaker. A second click on the Play button will stop the clicks. If you do 
not hear clicks when you hit Play, check your Apple menu in the Macintosh 
Control Panel to see if the sound has been turned off, or if you have the click 
turned off in CUE's  Misc menu. If you look under the Misc menu and it says 
Click On, that means that the click is Off and selecting item will turn the click 
On.  If it reads Clicks Off than this means the click is On and selecting this will 
turn the click Off. Another way to access the click Play feature from the Set 
Tempo dialog box is by typing the letter O.

You may need to set a number of different Tempo changes in one cue, so the Set 
Tempo dialog box does not return you to the Cue Sheet when you click on OK.  
If you click on OK (or hit the Enter key) after every entry, you will log each of 
them into your Cue Sheet without having to leave Set Tempo.  When you are 
ready to leave the Set Tempo window, or if you were just browsing, and 
haven't OKed anything this time around, click on Exit.

The button labeled Search Results will be discussed when you have found out 
how to Tempo Search (page 123).

Tempo Tap
If you have a musical segment completed that feels right, and need to determine 
it's Tempo without using a stop watch, you can use the Tempo Tap in the Set 
Tempo dialog box for that purpose. Clicking once on the button labeled Tempo 
Tap will activate this feature. 

Using the mouse or any key, tap out 17 beats  at the tempo you have in mind. 
After the 17th beat, CUE will beep and display the exact tempo you have tapped 
out. The results of your Tempo Tap will be displayed in Film Clicks, SMPTE 
Clicks or Beats per Minute depending on what you have chosen in the Set 
Formats dialog box. If you want to see how that Tempo works with the cue 
points in your Cue Sheet, click on  OK (or hit the Enter key) to enter this 
tempo, and Exit to make the dialog box disappear. The results of your new 
tempo will be calculated and displayed in the right hand column of your Cue 
Sheet  window.
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Calc Tempo From Beats and Time
Another useful feature in the Set Tempo dialog box can be accessed by clicking 
on the button labeled: Calc Tempo from Beats and Time.When you do this, 
a smaller dialog box will appear inside Set Tempo. It has fields for the 
Starting Beat, Ending Beat (with increments button) and Ending Time.

Here are two examples of the way this feature can be used:  

When your Tempo is not catching an important cue point on a beat, and you are 
not interested in hitting any points before that, place the beat number that begins 
the section you are working on into the box marked Starting Click.Then round 
off the beat number that won't fit and put it in as the Ending Click. Make the 
Ending Time the time of that cue point, and click on OK. CUE will calculate a 
Tempo that comes closest to landing that specific cue point on the desired beat.

If you have a finished musical piece (a complete song for instance) that needs to 
be shoe-horned into a specific scene; count the number of beats the song takes. 
Let us assume that the first beat of our Cue Sheet is where the song starts. By 
entering the Starting Click as 1, the number of beats you counted (plus 1) as 
the Ending Click, and the time of the scene as your Ending Time, CUE will 
calculate the Tempo that comes closest to make your music fit perfectly into the 
available space. Remember to enter the time as Absolute or Relative, 
depending on the Enter Abs/Rel Time setting (Command-A).

Your ending beat number need not come in whole number increments.Clicking 
on the right hand button next to the Ending Beat # box, will give you a choice 
of 16th note through dotted 8th note in addition to the Ending beat # you select.
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In the case of both examples, click on OK (or hit the Enter key) and you will be 
returned to the Set Tempo dialog box where you will see this Tempo, Starting 
and Ending Clicks displayed.You can always change the start and end 
information at any time. When your selection is complete, click on OK (or hit 
Enter) and this Tempo will be entered.  Exit returns you to the Cue Sheet.

While the two examples given here begin with the first beat of the cue, you can 
actually select a range of cues from within your Cue Sheet and transfer them to 
the Set Tempo window . While in your Cue Sheet window, hold down the 
Shift Key, and select the range of cue points you want with the mouse. The 
Starting and Ending beat #, as well as Ending Time of the  highlighted 
range will be transfered to the Set Tempo window if you select it at this point.

Note: If you are working in film frames, Calc Tempo from Beats and 
Time will go for the greatest degree of accuracy and use CUE's ability to show 
this format in 80ths of a frame. Should your sync source only go to eighths, then 
you should round off.

Tempo Pop-Up Menu
If you scroll to any place in the Cue Sheet where a change in Tempo is 
displayed and click on that tempo change, a pop up menu will appear that allows 
you to make a number of tempo decisions without having to go back to Set 
Tempo.

Inc (Increment) Tempo and Dec (Decrement) Tempo are very 
straightforward.  Selecting either one of them and releasing the mouse button, 
will change the Tempo by one step in whichever direction you select.  This 
change will immediately appear on your Cue Sheet.

Several options are included to change the degree of resolution for your Tempo 
select.  In Frames per Beat, your tempo will be incremented or decremented 
by 1/8ths.   Hold down the Option key to increment/decrement the tempo by 
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1/80ths.  When you are in Beats per Minute, your tempo will be increased or 
decreased by whole beats.  Holding down the Option key will produce a 
resolution of 1/10ths of a beat.  For 100ths of a beat resolution, hold down the 
Shift/Option keys.

Inc (Increment) Beat and Dec (Decrement) Beat will change the beat number 
that the Tempo change you have clicked on occurs at.  You can make these one 
increment/decrement at a time adjustments until that particular Tempo bumps up 
against a subsequent or previous Tempo change. Both Inc Beat and Dec Beat 
will recalculate the click of all following cue points.

Move Block Up and Move Block Down will let you move an entire block of 
Tempo changes.  When you select either Up or Down, a little dialog box 
appears that gives you the opportunity to select how many beats you want this 
particular block moved. This procedure will affect the tempos that follow the one 
you are moving. If you move a particular block up or down three beats, every 
subsequent block of Tempo changes will also show as being moved by three 
beats. Thus, if you don't want to change what beat the previous or following 
Tempo blocks start at, you should use Inc Beat and Dec Beat instead.
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Searching for Tempos
It is a good idea to have an approximate Tempo in mind before you select 
Search Tempos from the Operations menu. Although CUE will allow you to 
search a wide array of tempos at a given time, it is not unlimited. Also, by 
searching too wide an array of tempos, you may present yourself with an 
overwhelming number of options.  When you first call up Search Tempos, it 
will look like this:
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Once Around the Park With Search
At the top of the Search Tempos dialog box, the Tempo Format is listed: (24 
Frame, 24 Frame fractional, 25 Frame, 29.97 Frame, 30 Frame, B.P.M. ). Make 
sure that it matches the Tempo Format you want to search in.  If it doesn't 
match, then select the appropriate Tempo Format from the Set Tempo 
Formats window in the Operations  menu.

The first series of boxes underneath the Search Tempos title are fields where 
you enter the range of tempos for your search. A default range of tempos will 
come up when you first select Search Tempos. After that, the range of the most 
recent Search you did will be displayed anytime you return to this dialog box.  

Below the entry fields is a button marked To Closest, that runs through a series 
of note value choices allowing you to search to the closest quarter note, eighth 
note, eighth note triplet or sixteenth note, depending on how many times you 
click on it.  

Directly beneath this are two small text boxes labeled Margin that let you 
custom design the margin for error that Cue will deem acceptable when it 
Tempo Searches.  

Under that are fields for entering the range of Offsets that you want searched 
along with each Tempo.

Part way down on the right is a number labeled Max Hit's.This tells you how 
many cue points were marked as Key Hit's.These are the only points that will be 
included in the standard search.

Just above Max Hit's, is a check box labeled Search Cuts. When this is clicked 
"on", CUE  will do a non-standard search where it looks for Tempos that will 
best hit only the cue points which take place on Cuts.

The space at the bottom part of the screen is provided to show the results of any 
search that you do. It will hold up to 36 different Tempos.  

Using Search Tempos
To help matters along with our sample cue Zarkov/1m2, let us say that our 
Tempo Tap came out to be 9-5 . A reasonable search range might be 9-0 to 
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11-0 . Enter these numbers in the appropriate boxes and then click on the button 
labeled Search (or hit the Enter key). If you enter a range of Tempos too 
large to fit in the display box, CUE will beep and select the second Tempo field. 
Reducing the search range will permit you to continue.    

 Once your search margin has been pared down to include 36 or less Tempos, 
hit the Search button and you will see this range of tempos displayed with three 
rows of number numbers to the right of each Tempo. The first column in bold 
type shows the number of key hit's each Tempo is hitting. Since two frames is 
considered to be the amount of time within which the average human eye is 
incapable of noticing a discrepancy, two frames in either direction of the cue 
point is the default setting for CUE. (We will explain how to fine tune this 
parameter in a little while, but for the moment let's decide that any cue point 
within this plus/minus two frame margin is considered to be hit).

The second column in plain text shows the number of hit's that fall just outside 
the established hit margin. This is useful to know because computers are so darn 
literal. If a cue point is even one film frame away from being hit, the computer 
considers this a failure. By looking at the second column you can see how many 
hit's are just a film frame away from being included as bona fide hit's. This gives 
you a little more information to help you decide whether you can work with a 
given Tempo or not.

The third column in the gray text shows you how many of your Key Hit's are 
definitely outside the range of the hit margin. 
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Hits and Misses (The Zoom Feature)
 

9-0  and 10-2  look promising because they are respectively hitting 9 and 8 out of 
12 Key Hit points within two frames of the nearest 1/4 note (check the second 
column, and you will see that 10-2  is hitting a ninth cue point within one frame). 
To take a closer look at which points are being hit, it is not necessary to enter this 
Tempo into the Cue Sheet.  By clicking on a Tempo in the Results Box, we 
engage a "zoom" function which shows us the details we need.  Let's zoom on the 
9-0 Tempo first. 
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This zoom is showing us the time, an abbreviated description, and the beat to the 
nearest hundredth of each Key Hit.  Any Key Hit that this particular Tempo is 
hitting within two frames is shown in bold, any hit within one film frame of 
being hit is shown in plain text, and any hit that is really off is shown in gray 
type.

You will also have noticed by now that CUE has started to play a click as soon as 
you engaged the zoom function.  This click is the Tempo you have zoomed in 
on.  It is provided so you can determine differences in click rates without having 
to leave the dialog box.  In order to turn the click off, hit the letter "O" in either 
upper or lower case.  If you hear no click, hit the letter "O", and click once on 
the zoom box to return to the Search Tempos display and then click on the 
Tempo whose click you would like to hear. This time when you zoom in on that 
particular Tempo, you will hear the click unless you have the sound for the 
whole computer turned off in the Control Panel under the apple menu.

If there are more than 20 Key Hit's, you can examine them by clicking 
anywhere on the zoom box. Each click will show you 20 more Key Hit's. When 
you have reached the end of the Key Hit's listing or if there are less than 20 
Key Hit's, clicking on the zoom box will return you to the Search Tempos 
display.  

Since the other promising looking Tempo is 10-2 , let's click on it .
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Some of the timings that are not caught by the nearest 1/4 note are very close to 
being at .5  of a beat, which is the eighth note. To make sure and see how the 
other Tempos work out, click on the 1/8 note button, and then click on Search, 
so that CUE will search to see how many of the Key Hit's fall on an eighth 
note.
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We now have some decisions to make. The 9-0 Tempo is hitting all 12 Key 
Hit's, and a couple of our tempos are now hitting all 12 if we can work with the 
near misses. Which one is better?

This is where musical choices start to come in.Are there some cue points you 
would like to hit  on the 1/4 note? Each one of our choices differs in this respect. 
If you don't care about that particularly, then are you satisfied to go with a 
Tempo that is slower (10-2) than the original 9-5 we Tempo Tapped?

If hitting the nearest eighth note is all right and you are really interested in 
getting as close to 9-5  as possible, notice that our beloved 9-5  is hitting 11 out of 
12 Key Hit's. By zooming on 9-5 , and examining this Tempo, you may feel 
that the one Key Hit that is not being hit is no big deal. You could write 
something that has slow-speaking instruments like basses catching this point. Or it 
may not be as important as you thought it was when you first entered the cue.

You are on your own with these choices. Each cue will be different. Not all may 
offer as many ways to go as this particular sample does. The main point is that 
CUE lets you spend your time making these creative decisions instead of laboring 
over the math involved.

What has been covered so far provides a basic overview of Tempo Search that 
may give you sufficient tools for your needs. Be aware however, that there are 
further refinements available to you if you want to get involved with them. They 
are:  

1-  Dividing your Tempo into smaller increments to give yourself more choices 
within a given range.

2- Modifying the margin within which CUE considers a cue point to be 
successfully hit.

3-  Retiming your click track so that it still feels like one Tempo but speeds up 
or slows down to catch certain Key Hit's that your Tempo of choice is not 
hitting.

4-  Search Offsets to determine the proper start of your cue which will hit the 
greatest quantity of cue points.

Details on these follow starting on page 131 but for those anxious to get on with 
it let's proceed to actually place a Tempo into your Cue Sheet.
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Entering the Result of Your Tempo Search
 
When you have chosen the Tempo you wish to enter into the Cue Sheet, make 
sure that this Tempo is the last one you have zoomed on before clicking Done. 
By doing this you ensure that when you select Set Tempo from the Operations 
menu, the Tempo of choice will be displayed under the dialog box. This saves 
you the trouble of remembering it or having to scribble this information on a 
scrap of paper.

To make matters even easier, if you click on the button labeled Search Results, 
you will see the Tempo displayed beneath the dialog box is now entered into Set 
Tempos, wating for you to click on OK or hit the Enter key.
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Upping  your Tempo Search Precision
Fractional  Tempos

The more Tempo choices you give CUE to search within a given range, the 
more you up the chance that the maximum number of Key Hit's will be nailed 
with the error margin you have chosen.
 
30 Frames per Beat @ 30 frames per second gives you the greatest level 
of detail because it divides each frame into eightieths. But what if you want to 
work in Frames per Beat @ 24 frames per second where each frame is 
divided into eighths, or  Beats per Minute?

If you want to work in film frames or beats per minute you do have the ability to 
up your level of precision:  

Click on the Operations menu, select Set Formats , pick the sub-menu labeled 
Tempo Formats (or type Command Opt-T)and under 24 frames per second, 
you will see that you have the option to click on fractional tempos.Clicking on 
this will divide your frames into eightieths instead of the standard eighths. In the 
case of Beats per Minute, you have the choice of clicking on either tenths or 
hundredths of a beat.  

To see the effect of this greater range of Tempo choices, convert the standard 
film frames to fractional tempos and then return to Search Tempos so we 
can work further with our sample cue.

One of the first differences you will see is that the breadth of your search range 
is restricted because there are so many Tempos within a small range. You will 
find that  the largest range you can enter into the Search Tempo dialog box is 
between three eighths, because each eighth will have ten sub-divisions.  Since 9-5  
was the Tempo we originally tapped let's enter a range of 9-4  to  9-7 and hit 
Search.  

In case the scope  of your search is so broad that it can't be shown in the display 
window, CUE will list the tempo range in eighths of frames (every ten tempos).  
As soon as you decrease the search range to the point where it can be displayed 
in 36  or less Tempos, then every Tempo in the range will be shown.  This 
range display works works for all tempo formats.
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If you set the search to the nearest eighth note you will see that a 9-47 or a 9-48 
Tempo catches all twelve of our Key Hit's within two frames. Also notice that 
the fractional tempos that work out to an even eighth will be displayed without 
a trailing zero.

Honing Your Hit/Miss Margin
Each composer may have their own preference for how they want to hit a cue 
point with a given musical punctuation.

CUE's default margin for error in it's Tempo Search is two frames to either 
side of the cue point, but a standard bit of wisdom is that it is always better to be 
late than early with a musical sting.  Even though two frames is not supposed to 
be discernable by most people, you may not wish to hit any of your cue points 
early.  To avoid this you can redesign the error margin by using the Margin 
feature of the Search Tempo dialog box.  

The default setting for the search margin is entered as a minus eight hundredths 
of a second to a plus eight hundredths of a second.  (A frame is approximately 
.04 seconds.)  If you only want CUE to search for hit's that fall after a cue point, 
enter 01 into the minus text box (it won't accept a "0" but hopefully less than one 
hundredth of a second early won't be a problem for you).

In this same manner, if you are comfortable hitting a cue point with music that 
may be up to three frames late, enter 12  into the plus box and that will extend 
the range that CUE deems an acceptable search margin.  You can type a number 
as high as 99 into either of the two boxes.  If you want a number higher than that 
. . . you probably don't need CUE to Tempo Search .

Accelerando/Ritard
There are two main purposes for this feature. The first is to create a click track 
which has an accelerando and/or ritard in it to fit the dramatic needs of your 
picture. Another is that you have found a Tempo that really works well for most 
of your cue, but there are a few cue points that just won't fall into place.  You 
may feel that these cue points do not fall on a musically convenient beat, and 
would like to place one or a few of these awkward key-hit's on to specific whole 
beats.  We call this second feature Key-hit Retiming, and will discuss it  after 
we have explored the various features of the Accel./Ritard. box.

132



IMPORTANT NOTE:  Before we proceed, if you are working with 24 
Frames per Second Tempos, it will be extremely useful to set the Tempo 
Formats dialog box for fractional tempos, and if you are working in Beats 
per Minute, you should work in hundredths of a beat.  While Cue will do 
Accelerandos and Ritards in standard frames & eighths or Beats per 
Minute, the much larger range of Tempos you have in fractional tempos and 
hundredths of a beat will allow CUE to perform it's calculations with 
significantly greater precision.

The Accel./Ritard. dialog box can be called up in two ways. The simplest is to 
select a cue point which you would like to have fall on the closest whole beat. 
Click and hold the mouse button down anywhere on your chosen line, and the 
pop-up menu will show Accel./Ritard as one of your choices.  Release the 
mouse button on this selection and your dialog box will open.  A slightly faster 
way of getting to this box is accomplished by holding down the Option key when 
you click the mouse button over your cue point line.  The Accel./Ritard dialog 
box will be displayed immediately.  Of course, you can also click on the 
Operations menu and select Accel\Rit. The following dialog box will appear 
(we are using CUE example: Zarkov/1m2 here):

Depending upon how you entered this dialog box, the numbers appearing in the 
box may vary. We are going to take a look at each of these entry items, replacing 
each with the desired information. As you read the following sections you will 
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find that the numbers CUE has entered for you, will complete your Key Hit 
Retiming with a minimum of key strokes.

Starting Beats/Ending Beats
The first task in creating an Accelerando/Ritard for your cue, is to define the 
start and stop time you want.This is done by placing the beat or click # you wish 
to begin at into the box labeled Starting Beat #, and then typing the time of the 
cue point you wish your Accelerando/Ritard to end at into the text box 
marked Ending Time.

There is a second way to define the Accelerando/Ritard start and stop: Before 
you enter the Accelerando/Ritard dialog, you can hold down the Shift key 
and click on the cue point you want to become the starting point for the 
Accelerando/Ritard. As you do so, this cue point will become 
highlighted.Then scroll to the cue point that is to be the stopping point for the 
Accelerando/Ritard, and click on this cue point while holding down the Shift 
key. Now the entire range of cue points between the two that you have clicked on 
will be highlighted. When you call up the Accelerando/Ritard dialog box after 
doing this you will see that the cue points listed in the Starting Beat # and 
Ending Time boxes are the same ones you chose in the Cue Sheet.

Desired Ending Tempo and Ending 
Click

Desired Ending Tempo and Ending Beat # give you a creative choice. 
Notice that if you click on one of them the button of the other one will no longer 
be highlighted.You can specify the Tempo you want your Accelerando/Ritard 
to speed up or slow down to, or you can indicate what Click # you want your 
Accelerando/Ritard to stop at.  

Desired Ending Tempo is pretty straight forward. The more the Ending 
Tempo you entered varies from the starting Tempo, the more your click track 
will speed up or slow down to reach the Ending Time. CUE will end the 
Accelerando or Ritard at the Tempo closest to the Desired Ending Tempo 
which catches the ending time on a whole beat. CUE will remain at that tempo 
until another tempo indication is inserted. 
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Ending Beat works in a similar way, but fitting the desired number of beats 
into the time specified.  The more the Ending Beat # you enter varies from the 
Click that a constant Tempo would have reached by the Ending Time shown 
in this dialog box, the more drastic the Accelerando or Ritard will be. In this 
case, the Ending Tempo will be the one that comes closest to hitting the 
Ending Beat # you specified.

There is a button to the right of the Ending Beat # entry box that allows you to 
cycle through a series of different note values:

 Clicking on a note value other than "+0" will add that note value to the ending 
beat thus allowing you to end your Accelerando/Ritard on something other 
than a whole beat.  For example: if the Ending Beat # is 55 and you have 
clicked the note value box to show and eighth note, then the destination of the 
Accelerando/Ritard is beat 55 and a half. 

Insert Check Box
When this box is checked, it will cause the beat after the end of the 
Accelerando/Ritard to revert to the Tempo that was originally active at that  
point in the cue.

High Resolution
If you want CUE to calculate Tempos at the highest possible rate of resolution, 
you can activate the High Res button which will give you a resolution of 
65,536ths of a frame or beat.  Be careful- there are two potential areas of 
concern when using High Res:

One is that 65,536ths is a much higher rate of resolution than what the Cue 
Sheet can display, and so consequently, if one of these Tempos is re-entered in 
the Set Tempos dialog box, it may not exactly match the High Res tempo 
originally calculated by the Accelerando/Ritard routine. Of course, a few 
minor tempo fluctuations this small won't affect the overall cue.

The other way that using High Res can trip you up, is that you have a maximum 
of 400 different tempo changes in any given Cue Sheet. Since the High Res 
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mode will probably be making a tempo change on every beat, this would mean 
that at a 1/2 second click rate (120 BPM)  you would be out of tempo changes by 
the time your cue was three and a third minutes long if you are doing 
Accelerando/Ritards from the beginning of the cue. When you are working on 
longer cues, use the High Res mode judiciously and you should be in good 
shape.

Scrolling the Cue Sheet Behind the Dialog Box
If you want to scroll the Cue Sheet behind this dialog box you can do so by by 
hitting the up/down arrow keys.  

 Key Hit Retiming:  

Key Hit Retiming is designed to place a particular cue point on a whole beat in 
as few keystrokes as possible. It is accomplished by clicking on the cue point you 
wish to see in the Accel.Ritard dialog box and selecting Accel/Rit when the 
pop up menu appears.  Explaining Key Hit Retiming will be easiest if we work 
with our sample cue Zarkov/1m2. We are working with Relative Time, and a 
starting film-based click tempo of 10-3. To gain extra resolution, we have also 
chosen a click tempo accuracy of 1/80th.

 The first Key Hit timing point that we will address appears at 15.42 seconds 
(Relative Time). Even though it falls on 36.66  beats into the cue, which is just 
fine for writing to the nearest eighth note, let's decide that we really need to have 
this on the beat.
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To start Key Hit Retiming, hold down the Option key and click on this cue 
point text line.   The  dialog box  will open looking like this:

Notice that CUE has automatically filled in all the text boxes for you. If for any 
reason you wish to amend any of the entries, you may do so without hurting 
CUE's feelings. The Starting Click # is 2, because CUE always adds one beat 
to the previous Accel\Ritard operation.  Even though this is not the case at the 
beginnning of the cue, CUE goes ahead and adds one beat anyway to preserve 
your starting Tempo. You can change this if you wish, although it is not 
necessary.

The Tempo displayed is the one that was part of your Cue Sheet when you first 
loaded the file into CUE. If it is not displaying a 10-3 Tempo, go ahead and 
enter 10-3  for purposes of staying together in this example. Notice that the 
Ending Click has been rounded off to the nearest whole beat.  Again, if that 
does not conform to your needs, you can type in your own number. It is 
important to note that you should have the Tempo page of the Set Format 
dialog box set for fractional tempos if you are working in 24 Frame per 
Second Tempos.

At this point, you need only click on OK, and CUE will calculate the necessary 
Accel./Ritard, entering the proper changes of tempo into your Cue Sheet, and 
NOW placing your cue point at 15.42 right on as close to beat 37 as possible. 
Chances are, if your sample cue has not been altered for other operations, you 
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needed to make only one click in the Accel./Ritard dialog box-  the OK.  Pretty 
Nifty.

For those who have never had access to it before, Key Hit Retiming will feel 
like a luxury. It is a process whereby you speed up and slow down the click track 
ever so gradually to make your key hit's fall on quarter notes. The whole essence 
of Key Hit Retiming is to make subtle Tempo changes that will not throw off 
the musicians following your click track. If they can easily play to the shifting 
Tempo without being disturbed, chances are that the viewing public will not 
even notice the compensations you are making.

The extent to which you use Key Hit Retiming must be up to each individual, 
but there are some definite constraints you should consider. If you ask CUE to 
pull a very large discrepency into line within a small number of beats, there is 
just no physical way that it can be accomplished without a comparatively radical 
Tempo shift. Also, when using Ending Beat # to determine your accelerando or 
ritard, you may end up with a tempo significantly different from the one you 
started with. You can, of course, check the Insert box which will restore the 
tempo which was originally set for your ending cue point, but this could be 
dangerous.

It is also useful to remember that if you are satisfied with certain Key Hit's 
which  fall within the part of your cue that you are Key Hit Retiming, they 
will probably end up at a slightly different click point as a result of the gradual 
Accelerando or Ritard which you have programmed to take place around 
them. This could make your hit's more even more accurate, but it also might 
drag them in the wrong direction.

Accelerando/Ritard timing points can be in Absolute or Relative Time 
Format, according to what you set for your Input window of the Cue Sheet 
(Command-A).  Scroll  your Cue Sheet  to the right so that you can see the 
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timing column closest to the description and the column that lists the clicks to the 
right. You might want to use the split feature to see your far left and far right 
columns if necessary (Command Opt-S).

There are several more options available to you for Key-Hit Retiming, if you 
wish to use them. Desired Ending Tempo or Ending Click # can be checked 
the dialog window before clicking on OK. If you do not wish to proceed with 
this calculation you can always click on the Cancel button and the dialog box will 
disappear without making any changes in the Cue Sheet.  Should you have 
clicked on OK by mistake or wish for any reason to Undo the most recent 
Accelerando/Ritard that has gone into the Cue Sheet, hitting Command-Z 
will Undo the last Accelerando/Ritard which you entered.

After you have clicked on OK, you will be returned to the Cue Sheet. If you 
scroll to the top of the Cue Sheet, you can see that the word Ritard or Accel. 
has appeared at the point where we asked the program to begin Key Hit 
Retiming.  At the end of the Retimed portion, CUE displays the final Tempo 
reached by this particular Key Hit Retiming .

If you want to behold all the gyrations CUE goes through to achieve a Key Hit 
Retiming, you can go to Cue Sheet Formats in the  Set Formats menu and 
click on All Tempos under Accel/Ritard Display. When you do this and and 
click on OK, you can see that there are places where CUE is recalculating the 
Tempo on virtually every beat. Unless you want an extremely long Cue Sheet, 
you should probably go back to Cue Sheet Formats and click on Beginning 
and End Only.

You can use Key Hit Retiming to bring several cue points onto whole beats. 
CUE will begin the accelerando or ritard for each successive cue point after the 
one it has just completed. Check the Starting Beat # box to be sure.

If you want to come even closer to an exact beat using Ending Tempo, check 
the High Res box. When you return to the Cue Sheet you will see that the 
ending click number is much closer to the beat you wanted to hit.

It should be possible with Tempo Search and Accelerando/Ritard to create a 
click track that will work for you, but what happens if nothing close to the 
Tempo you want hit's enough of the cue points and you absolutely want a rock 
steady click track that has no Accelerandos or Ritards in it?

This is where Offsets come in.
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Setting Offsets
Slipping Your Cue

You may run into times when no tempo close to the one you want will catch 
enough of the Key Hit's in a scene. One possible way out of this bind is to use 
Search Tempos for a tempo that will work if you offset your cue a little bit 
earlier or later than the start point you planned. In many cases, a few frames in 
one direction or another will make little difference to anyone but the composer.

Searching for an Offset
Let's say that you like a 9-5  click and nothing else will do. Our previous Tempo 
Search showed that a 9-5  was hitting only five of our twelve Key Hit's on the 
nearest 1/4 note.  Although searching to the nearest 1/8th note indicated that 11 
out of the 12 Key Hit's were being caught, we would like to do better.

Remember: the Offsets you Search will be displayed in the current Relative 
Time Format.  Make sure your Set Formats dialog box is set up to your 
liking.  

We start by clicking on Search Tempos in the Operations menu. Even though 
we only want an 9-5  click, let's search Offsets in a range of Tempos from 9-4  
to 9-6.If there was a wonderful solution to our problem just one click to either 
side of 9-5 , we might be willing to compromise.

Next, we need to define the range of Offsets to search. To the right of the word 
Offsets are three boxes marked start, #, and step.  

Start is where we enter the beginning point of our search.The search can begin 
before zero by clicking on the minus button. Moving forward with our example, 
click on the minus button and enter /5  as our start point. This means that CUE 
will search Offsets starting at -5 film frames.

By entering a number in the box labeled #, we determine how many different 
Offsets will be searched in each Tempo.  Enter the number 10.

The last item to define is the increment between each Offset in our search. Enter 
/1 (one frame) in the box marked step. CUE searches in a consecutive manner, 
so it will now start at minus five frames and search ten different Offsets one 
frame at a time. This means -5,-4,-3,-2,-1,0,+1,+2,+3 and +4 frames.  If the step 
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were set for /2  (two frames), then the search would cover -5,-3,-
1,+1,+3,+5,+7,+9,+11 and +13 frames.

You can enter information into the start and step boxes in any of the valid time 
formats including measures and/or beats.  We have chosen film frames for the 
current example.  Once you have set the three boxes and chosen the note value 
reslolution, the Search Button can be clicked (or the Enter key hit).  

Should you make an error entering any data, the Macintosh will beep and select 
the field where the error occurred.  If you asked for more Tempos and Offsets 
than can be displayed at one time, the Mac will beep and select the second tempo 
field.  Asking for fewer Tempos in the search will alleviate this error, as would 
asking for fewer Offsets to be displayed.    

Since asking for a great number of Offsets can exceed the size of our display 
box very quickly, you will be only be able to display the Offsets for a somewhat 
narrowed range of Tempos. If you want to examine a large range of Tempos, 
then place the plus or minus Offset you would like to search into the box labeled 
start, put "0" in the # and Step boxes and click on Search  (or hit the Enter 
key). By backspacing, entering another start point, and hitting the Enter key 
again, you can move through a series of single Offsets per Tempo quite 
efficiently.
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Let's make our first Offset search to the nearest 1/4 note:

We are making progress. There are several Offsets catching seven of the Key 
Hit's within two frames.  

Now set CUE to search to the closest eighth note by clicking on the To Closest 
button until the eighth note symbol comes up. Click on search and you should see 
something like this:
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We are looking good. The +4 frame Offset at a 9-4 Tempo is catching all 12 
Key Hit's within an 1/8th note. A zoom on +4 frames at 9-4 shows the 
following:

Whichever one you choose, make sure it is the last one you zoom on before 
clicking on Exit, in order to ensure that CUE will show you the choice you 
made when you go to enter it in the Set Offset dialog box.

A Helpful Hint
Being able to enter an Offset of measures and/or beats can be helpful if you are 
trying to change tempo in the middle of a cue. Lets use the example of an 11-5 
starting tempo in a cue that catches all the major cue points up through bar 23, 
beat 4. Now you want an imperceptible tempo change to catch the rest of your 
important cue points. You might search the Tempos 11-4 to 11-6 with an Offset 
of m23b4 (measure 23 beat 4). Only the hit's that come on or after bar 23 beat 4 
will now be included in the search. The Max Hit's number will also reflect the 
number of hit's in the specific part of the cue you are searching. The bar and beat 
format takes into account any earlier tempo and meter changes you have already 
placed into the Cue Sheet, so if you find a new tempo for this next section of the 
cue, it can be entered with the knowledge that it will work with what you have 
previously set.
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Entering the Offset You Have 
Searched For

As with the Set Tempo dialog box, the Set Offset dialog box will display the 
Search Results of your last zoom in a box beneath it:

Clicking either the "+" or "-" button, entering the Search Results in the upper 
box, and clicking on OK (or hitting the Enter key) will place your Offset into 
the Cue Sheet.

Underneath the box for entering the Offset, you will see a place for entering 
SMPTE bit's.This relates to a similar offset procedure you can perform in the 
Playback window. Entering a plus or minus SMPTE bit's Offset here will 
not affect the actual calculations set in your Cue Sheet, but is provided to deal 
with a situation where a minute adjustment of under a single SMPTE frame 
would perfectly align the music to the picture on Playback. Click on either plus 
or minus and enter a number up to 79 bit's in the box provided. Once again, 
clicking on OK or hitting the Enter key will engage this adjustment.

In the center of the Set Offset box you will find the check box marked 
Permanent.  When this is checked, the start time and all cue points will be 
permanently recalculated, and all memory of the offset will be gone forever.  
Permanent Offset is most useful when someone forgets to enter a Running 
Time before they begin entering cue points.   (See page 20)
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If you want to examine various choices of Offsets, you can do so by entering a  
different Offset on each Version of the Cue Sheet. Do not make your 
Offsets permanent if you want to see a different result on each Cue Sheet. 

Anchor Tempos
If you check the "-" button and the Permanent button, the Anchor Tempos 
checkbox becomes active.  

When you check the Anchor Tempos check box, and enter your Offset in 
measures and/or beats, you will add that many measures and beats to the start of 
your cue, up to your first tempo change.  From there your cue will remain intact.  
Thus, if you calculated your tempos and then moved your music start three beats 
earlier (for example) than it's original starting point, CUE will add those three 
beats up to  the first tempo change in your cue.  Without Anchor Tempos, 
CUE would normally move all of your tempo changes 3 beats earlier, and that 
would throw off your hit's. This is especially true for hit's caught with a lot of 
tempo changes calculated for their original points.  Anchor Tempos will add 
the Offset beats in so that the original tempo changes are all happening at the 
same Absolute Time that they did before you put in the Offset.  

If you check Anchor Tempos but enter the Offset in some other format than 
maesure/beats, CUE will beep and select the Offset text window when you hit 
OK.  

Adjusting Running Time
Since you have decided to start your cue later or earlier than the original start 
point, you have effectively changed the Running Time by the amount of your 

145



Offset. CUE will automatically adjust your Running Time to reflect this 
Offset, without changing the absolute times of individual cue points.
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Setting the Meter
Set Meter allows you to insert up to two hundred meter changes into your cue. 
You access the Set Meter feature by selecting it from the Operations menu, or 
by typing Command-M.

This dialog box has a field for entering the number of Beats per Bar, four 
Unit's buttons for selecting the value of a beat, a display that shows the Meter 
you are setting and a field entitled Starting at bar # to show where the meter 
change occurs. You can enter multiple meter changes by clicking on OK (or 
hitting the Enter key) after changing the necessary information. Other features 
in this dialog box include an insert option and an Undo Last button, the ability 
to customize your Accents, and set the Clicks per Beat.  

Unless you are using the insert option, the last meter entered becomes the 
meter for the rest of the cue and will remove any meter changes you have 
entered after this point, so meter changes should be entered in the order they 
occur. If you want to clear the whole cue in one particular meter , enter a meter 
at bar 1, and any other meters you may have set will disappear.

If you want to select a beat value without using the mouse you can do so by 
holding down the Option key while you hit the appropriate number. Option 2, 
Option 4, Option 8 and Option 6 set the Unit buttons for 1/2, 1/4, 1/8th and 
1/16th notes respectively.
To facilitate entering several meter changes in the cue, the Set Meter dialog box 
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will remain visible until you click on the Done button. This will return you to 
the Cue Sheet where you will see each meter change displayed in bold lettering.

The Insert Button
If you want to change the meter of one particular bar, you can do so by entering 
the meter you wish to have in exactly the same manner as indicated above and 
clicking on insert. (Holding down the Option key while hitting "x" will also 
turn insert on or off).  Whichever bar number you now place in the text box 
next to Starting at Bar #  will be the only bar number where that particular 
meter will appear in the Cue Sheet. The next bar will revert to whatever meter 
was originally active at that point and any other following meters will also 
remain unchanged.

In our last example, a 2/4 bar was placed at bar 7 so that the Key Hit at 13.25 
seconds would fall on a downbeat. The meter then returned to 4/4 on the next 
measure.

Undo Last
Once you have entered a meter change, the Undo Last button will become 
active.  Clicking on it will Undo the last meter change that you entered. This is 
very different from using the Undo command in the File menu (or typing 
Command-z) which will Undo all of the meter changes you made since you last 
entered the Set Meter dialog box.
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 Changing Clicks per Beat
If you are setting a Meter that is either eighths or sixteenths you can have the 
audible click that CUE generates follow along by clicking on the appropriate 
Clicks per Beat.  As you change the Unit's from quarter notes to eights or 
sixteenths, you will see that the Clicks per Beat option changes to give you the 
choice of several audible beat subdivisions.  These options range from x4 and x6 
subdivisions in 16th note meters to .5 subdivisions (one click every two beats) in 
half note meters.  

To toggle between the audible beat subdivisions without  using the mouse, you 
can hold down the Option key and hit the period and comma keys for the same 
result.

Customizing the Accents
CUE will place a number of "x 's" to the right of the word Accents that is equal 
to the number of Beats per Bar. Clicking on any of  these displayed x 's will 
place an accent above it, providing an audible accent for that beat. A second click 
on any x will turn the accentuation off for that beat.  
If you wish to customize your audible click track further, you can click on the 
Accents Only box.  With this feature engaged, only accented beats will be heard 
in your click track.This is a particularly useful feature for irregular and 
compound meters. A 7/8 meter with clicks placed only on 1, 3, and 5 would be 
constructed like this:

In Playback, CUE will play all 7 beats for each measure of Warning Clicks 
specified.  Then, for the cue playback it'self, accents only will be heard. 
Remember to reset your accents with each change of meter within a cue, if you 
want a different accent scheme.

The Next and Previous Buttons
If there are multiple meter changes set in a cue, the Next button or Previous 
button can be used to jump forward or back between them. While you can modify 
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any meter you select, remember that a modification to the meter of an early 
measure will wipe out all ensuing meter changes. If you don't wish to lose your 
next meter changes, you may wish to use the Insert function, or build your 
meter changes from the beginning of the cue.

The left and right arrows on your Macintosh keyboard will replace mouse clicks 
on the Next and Previous buttons.

Changing the Meter While in the Cue 
Sheet
If you scroll to any place in the Cue Sheet where a change in Meter is displayed 
and click on that meter change text, a pop up menu will appear that allows you to 
make a number of metering decisions without having to go back to Set Meters.

Inc (Increment) Meters and Dec (Decrement) Meters are very 
straightforward. Selecting either one of them will change the Beats per Bar by 
one step in whichever direction you select.

Inc (Increment) Bar and Dec (Decrement) Bar will change the bar number that 
the meter change you have clicked on occurs at. You can make these one bar at a 
time adjustments until that particular meter bumps up against a subsequent or 
previous meter change.

Move Block Up and Move Block Down will let you move an entire block of 
meter changes.  When you select either Up or Down, a little dialog box appears 
that gives you the opportunity to select how many bars you want this particular 
block moved.This procedure will affect the meters that follow the one you are 
moving. If you move a particular block forward three bars, every subsequent  
change will also show as being moved by three bars, so if you don't want to 
change these following meters, you should use Inc Bar and Dec Bar.
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How to Organize Where to Make Meter 
Changes
There are two ways to make selecting places for Meter Changes easier:

While you are in the Set Meter dialog box, you can hit the letter "y" (upper or 
lower case) which will toggle between Clicks and Measures/Beats.If you are in 
the Cue Sheet and wish to do this, you can hold down the Command key and 
hit Y to achieve the same results. If you can't remember this shortcut (which is 
listed in the Misc menu), a longer method for switching formats is to click on the 
Operations menu, where you can first select Set Formats and then Cue Sheet 
Formats from the hierarchic menu that appears Once this dialog box presents 
itself, you can set the Click display to Measures/Beats or Clicks. 
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Another completely different approach is to examine the Clicks window.

The Clicks Window
Selecting Clicks from the Windows menu, or typing a Command K gives you 
a window which displays your cue in notation similar to that used for drum parts. 
With the Clicks laid out in such a visual manner, it is very easy to make 
decisions about setting Meter.

What's in the Window?
At the beginning of each bar we have the following information (reading from 
top to bottom):  the time of the beat at the start of the bar (25.52);  the click # of 
that beat (51);  a meter change (if there is one) (4/4);  and the number of that 
particular bar (14).

If you have made a Tempo change during the cue, this will be displayed above 
the beat where you called for the change. In our example, a 12-2  Tempo starts 
at beat number 55.

There is a horizontal line with an "x" on it for each click. Up to 48 bars are 
displayed on any single line. Whenever a cue point comes along, the "x" closest to 
it appears in bold.

Each cue point has two pieces of information related to it. Above the "x" is the 
time of that cue point, and below it, an abbreviated form of the description. The 
Key Hit's descriptions appear in bold.   
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If the cue point is off by more than the margin set in the Search Tempos box, 
it's time will be followed by a minus if it is early and a plus if it is late.

When the timing information and abbreviated description are vertically aligned 
with an "x", and there is no plus or minus following the timing, that quarter note 
is hitting this cue point (see beats 51 and 59 in the example above). If the cue 
point is shown between beats without a plus or minus, it is hitting the eighth note 
(look between beat 56 and 57).

How to Use the Clicks Window
Any changes made in the cue via the Input window or any menu commands such 
as Set Meter and Set Tempo will be immediately reflected in the Clicks 
window.

Navigating the Clicks window is easy. There are both vertical and horizontal 
scroll bars that will move you from bar to bar in a leisurely manner.

For greater speed, type a bar number followed by the Return key, and that bar 
will appear as the first bar on the screen.

Typing "+" (or "=") and a number will immediately move you that many bars 
further into the cue,  and typing  "-"  and a number will move you that many 
bars earlier.

If you try to look at a measure number that is higher than the number of 
measures in the cue, the Clicks window will scroll to the last bar in the cue.

The title bar displays your current bar number and Tempo. This is helpful in 
case the most recent  tempo change has been scrolled off the screen. 

The Clicks window can be scrolled in Playback , allowing you to hear and 
see each upcoming cue point, along with it's brief description (see page 36).
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The Clicks Window Pop-Up
When you click anywhere on the Clicks window, a pop-up menu will appear that 
looks like this:

This is perhaps the most useful and powerful of the pop-up menus scattered 
throughout CUE.  

ZoomOut and In:  A Macro/Micro 
Measure Display

When you select Zoom Out, the display will change to show you up to 32 bars 
of your cue on a standard Macintosh Plus or SE screen.
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In Zoom Out, you will see a maximum number of measures displayed on screen 
so you can start to get a perspective of what is happening with the whole cue.  In 
this mode, CUE will place 8 measures to a line so you shouldn't have to scroll 
left to right.  Because we are looking at so many measures at once, there is no 
room for any cue point descriptions.  Events are indicated by the large, bold "x". 
Their spatial placement in the cue will give you a sense of where each cue point 
falls.  If the cue point is a Key Hit, there will be a black dot beneath the large, 
bold "x".

Whichever measure was the first one displayed in the Normal size Clicks 
window will have it's measure and beat number outlined when you Zoom Out.  
When you return to normal size (this sounds like Fantastic Voyage), that measure 
will once again be the first one displayed.  This is done so you don't have to 
remember the specific measure you were focused on. If you want to return to a 
different measure, just type that measure number and hit the Return key. Now 
this new measure will be the one whose measure and beat number will be 
outlined, and thus will become the measure the Clicks window displays when 
you return to Normal. 

From the Normal Clicks display, select Zoom In from your pop-up menu.
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Zoom In looks at a single measure (the one clicked on in Normal or Zoom 
Out) with all the information displayed in the Normal sized window, plus the 
time of each beat and of each half beat. If you need to descend to an extreme level 
of detail, then this is the place to be. Notice that the cursor has turned into a little 
magnifying glass.The only function that works differently in Zoom In as 
compared to Normal size, is that the scroll bar thumb will zip over to wherever 
you click your cursor, as if it was magnetized.

Set Tempo, Meter and Accel/Rit
You can click on Set Tempo, Set Meter or Accel/Rit in the pop-up menu 
without having to leave the Clicks Window.  The beat you click on when you 
select Set Tempo will be placed into the box labeled Starting at Click #. The 
measure you click on when you select Set Meter will be shown in the box 
labeled Starting at Bar #. And, the beat you click on when you pick Accel/Rit 
will show up in the box marked Ending Beat #.   The primary purpose of 
Accel/Rit here is to move around a single beat, as opposed to a complete cue 
point.

A Note to Avoid Confusion: Since you have entered the Accel/Ritard 
dialog from the Clicks window by clicking on a specific beat number, hitting 
OK without logging a new ending beat into the Accelerando/Ritard dialog will 
result in no Tempo changes being made since CUE is already hitting that beat 
with the current Tempo.

Move to Downbeat  

Move to Downbeat is a very useful tool although at times it can be more literal 
and less musical than you would be. Clicking on a particular beat in the Clicks 
window and selecting Move to Downbeat from the pop-up menu, will 
automatically shorten that measure making the selected beat the first beat of the 
next bar. While this is a great little short-cut, it may not always arrange the 
previous bars into the most sophisticated musical solution. 

Example:  You want the third beat of a measure to become the downbeat of the 
following measure.  For your specific application, you may want two 3/4 bars to 
precede this beat instead of a 4/4 bar followed by a 2/4 bar (which will be CUE's 
tendency). If you don't like CUE's solution, you can always hit Command-Z to 
undo this change and then use Set Meter.
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To "B" Or Not To "B"
Command "," toggles the display between showing cue point timings in seconds 
and displaying cue point timings in beats to the nearest hundredth from the last 
barline, not from the beginning of the cue.  

In this mode,  plus or minus signs have been deleted after cue points if they are 
not within the acceptable hit margin (which you set for a quarter or eighth note). 
Instead, added to the title bar is a display which tells you the range of the hit 
margin which you set in the Search Tempo dialog box.  This range is 
expresssed here in hundredths of a beat in the current Tempo. Using this error 
margin in conjunction with the beat fractions will enable you to make the 
appropriate musical choices.

The benefit of this display mode is that you can tell much more about the cue 
points which do not fall within the hit margin of a quarter or eighth note.

If we compare the above example to the identical measures displayed in seconds 
on the previous page, it can be seen that the cue point at 26.71 seconds could in 
fact be caught with a triplet.  Also, if you check the error margin in the title bar, 
you might notice that this cue point is three hundredths of a beat from being 
within the hit margin of an eight note.  These kind of evaluations are not possible 
by simply looking at the time from the start of the cue.

A Helpful Hint
Using the "+" and "-" is especially useful if you are trying to fit an existing tune 
to the cue.  Say the tune has a sixteen-bar verse and the verse starts at bar 27. 
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Type: 27 and hit Return to bring the start of the verse into view. Typing: "+" 16 
Return will quickly tell you how the start of the chorus relates to the cue.

Of course, you could always add 27 and 16 in your head and type 43 Return, 
but you've got CUE, so why not let it do the work?

What if I Don't Want Any Bar Lines?
Now that we have gone to such great lengths to Meter the cue you say you would 
prefer not to have any bar lines at all.  Hmmm . . . .  Well OK, have it your way, 
but I wish you had mentioned this before . . . .  Go to the Misc menu and select 
Hide Bar Lines (or hold down the Option and Command keys while typing 
B).

Squeezing the Weasel
Although this little known Scottish tradition has never been written about in a 
major software manual, we felt it was time to bring this ancient practice to light 
if for no other reason than it makes a great chapter heading, and the Society for 
Ethnomusicology didn't want to publish it.

The first written account of squeezing the weasel is found in the journal of Lord 
Bartholemew McWanker, the third Earl of Askew who firmly believed that this 
pagan ritual dating back to Druid days was cruel to the small animals and should 
be abolished.  He was instrumental in designing an acceptable substitute that 
duplicated the experience as closely as possible and is remembered to this day as 
the inventor of the bagpipes.

Despite his invention catching on quite well, there still remain to this day certain 
pockets of traditionalists who feel that nothing tops the sheer sensual excitment of 
actually squeezing their very own weasel. It may be noted as a further sidelight, 
that the original pagan practice led to the development of flexible iron gloves for 
hand protection.
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7 Cue's Hardcopy Output
While the Cue Sheet  is the central document that CUE generates, it is the goal 
of this program to provide a full range of print outs that will allow you to make 
this program a home base for the entire film scoring process.  In line with that, 
CUE will let you create custom Score Paper, generate Spotting Notes, a 
Title Page, a Master Cue List, and a Performing Rights Cue Sheet

Creating Custom Score Paper
You may have noticed by now that all the information in the Clicks window is 
remarkably similar to the data a composer laboriously transfers by hand to sketch 
paper before sitting down to write.Guess what you don't have to do anymore…

By selecting CUE's Score Page from the Windows menu you can create 
custom sketch paper that has all the information in the Clicks window 
automatically printed at the top of each system.  This is what the Score Page 
window looks like:
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On the left are icons representing different staff and clef configurations. Below 
them is a box for entering an instrument name.

To design your score page, type in the instrument name and then select the 
appropriate icon by clicking on it.  

Now point to the miniature score page on the right side of the window, and click 
where you want to add the new staff.  When you click the first line, do so about 
one quarter of an inch under the line of clicks at the top of the page. Notice that 
when you do so, the cursor arrow changes to a tiny staff.To make a change you 
must click in an area where the cursor has changed into a tiny staff. When you 
have clicked successfully, you will see a staff appear on the page with a miniature 
instrument name to the left of it.If you click somewhere that does no good, you 
will be severely reprimanded with a beep.

You add staves by clicking below the lowest staff of the first system on the page.  

To replace a staff, type in another instrument name in the box on the left, and 
select the appropriate staff and clef icon. Then click on the staff you wish to 
change, and it will be replaced by your new entry. If you selected the Remove 
icon, any staff you click on will disappear from the score page.

Should you have forgotten what instrument you placed on a particular staff, you 
can find this out by moving the cursor to the miniature score page and clicking 
on the instrument name in question.  When you click on the tiny instrument name 
you will see it appear in the text box where instrument names are typed.  Also 
notice that the corresponding clef icon has been selected as well. If there is more 
than one system on the page click on the instrument names in the system closest to 
the top of the page.    

For a clef other than treble, bass or a combination thereof, you will have to pick 
the plain staves and do your own artwork after you generate a printout. Should 
you be so heartless as to ignore the lovely clefs we have created for you, the 
tenor clef is it's own punishment.

Near the bottom of the Score Page window underneath a line which reads: Max 
Clicks Per Line, are two buttons labeled 12 and 16. The default setting is 
sixteen clicks per line, but if you are going to be writing a lot of sixteenth notes, 
you can click on the button marked 12, to give yourself more space on the page.

CUE will adjust to fit the maximum number of bars and staves on the sizes of 
paper your printer can use. When your score has only one or two staves, CUE 

160



will place three systems on a page for an Imagewriter with 8-1/2 x 11 paper. 
With three to five staves, this decreases to two systems. If you select  more than 
five staves, the Score Page will reduce to a single system.  There can be up to 
twelve staves per page.

Should you want more room between your bar lines, and would like to have 16 
clicks per line, you can print your Score Paper sideways by clicking on the 
File menu, selecting Page Setup and selecting the sideways print icon under 
Orientation. If you know you will be printing sideways, lay out your Score 
Page accordingly. In this print format you will be limited to two systems of up 
to three staves or one system of up to eight staves.

Although we mentioned in the discussion about the Clicks window that you can 
do away with bar lines, it bears repeating in this section on the Score Page.  Go 
to the Misc menu and select Hide Bar Lines (or hold down the Option and 
Command keys while typing B).  When you print out the score, measure lines 
will be withheld.

Every brand of printer is slightly different with respect to just how much paper it 
actually prints on, so the number of systems that can be placed on a page will 
vary from printer to printer.  The miniature score which follows is just an 
approximation of what you will see with an Imagewriter II.  

Hide Bar Lines and Max Clicks per Line do not change the score page 
display.
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Below are two examples of what the  Score Page looks like as the staves builds 
up.

Just in case you are worried that this is the size of the score paper when it prints 
out, do not be concerned.  You can see an example on the next page which is 
closer to the actual size of the score paper which the printer turns out. 
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Saving Your Score Page
When you are satisfied with your layout, make sure you click on OK (or use the 
Enter key). If you click on Cancel, the Score Page window will be returned to 
it's previous state. This means that should you have clicked OK while you were 
working, then this is the point the Score Page will revert to.  Any further 
deletions will have to be done by using the Remove icon. To remove the Score 
Page window, click on one of the windows visible behind it or click on the close 
box in the upper left hand corner.

There are two options available to Save your score setup to disk. One is to click 
on Save Cue in the File menu which will save the Score Page as part of that 
Cue Sheet. The other is to select Save Score from the File menu, give your 
Score Page a name and click on Save which will make it an independent file.

Saving your Score Page as part of your Cue Sheet will always link it with that 
particular Cue Sheet when the time comes to print out your Score Paper. By 
saving the Score Page as a separate file with it's own name, you can use this 
single Score Page to print out Score Paper for a number of cues that have the 
same instrumentation. The advantage of this is that since there are probably many 
cues that will use the same orchestration, you can use a single Score Page 
without having to create an identical one over and over for each cue. Conversely, 
if there is no Score Page saved as part of the file, opening that file will not 
replace a score that has been previously loaded into the program.

Whether you loaded a Score Page in as separate Score Page or whether it is 
left over from a previous file, it will stay there until you update it. So if you do 
not want to save that Score Page as part of the new file, make sure you delete 
the staves that are shown and click on OK before you leave the Score Page 
window and Save the Cue Sheet.

NOTE: The information about whether you want 12 or 16 clicks per line is 
Saved with each individual cue and not with the Score Page file. This is done 
so that if you are using the same score setup with different cues, each batch of 
score paper will print out with the number of clicks per line that is most 
appropriate to the music you are writing for that particular cue.

Printing Your Score Paper
In order to print your score paper, select Print from the File menu, and release 
the mouse button on Print Score Paper when the sub-menu appears. Since any 
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score setup can be used with any Cue Sheet, you can just click on the File 
menu, select Open Score, and double-click on the Score file title you want.  

When you are still in the Finder and wish to print a score, you can select any 
number of cues that you wish to have Score Paper printed up for. A typical 
Score Page icon looks like this:

Printing From the Finder
Should you have a Score Page that you would like to apply to a number of 
different cues, move your file icons around in the Finder so that this Score 
Page precedes the files you wish to link to it. Then select the files you want, click 
on each file while holding down the shift key, or draw a rectangle around all of 
the files to be connected. The Finder will print out all files that you have 
selected starting in the upper left hand corner and proceeding left to right across 
that line. When it has done that, it will go to the second line  down and do the 
same until it has printed every file you have selected.

CUE will use a Score Page to print Score Paper with that particular 
orchestration for all the files that follow, until it comes to another Score Page 
set-up or until it encounters a file with it's own Score Page.  

Score Pages that have been Saved as part of a specific cue will always take 
precedence over a separately Saved Score Page.  If the next file in line to be 
printed does not have a Score Page Saved with it, it will link up to the Score 
Page that was printed with the previous cue.

Multi-Print
You can print out both Cue Sheets and Score Paper from the Finder in a 
single process if you wish, or each individually.  After you have selected the 
icons of all the cues you want to print, choose Print from the File menu. When 
you do this, a special dialog box will be displayed on the screen before the 
standard Macintosh print options are made available to you:  
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If you are printing Cue Sheets and Score Paper, make sure both boxes are 
clicked "on". To continue, click OK, or hit the Enter key and you will be 
presented with two Macintosh page set-ups and two Macintosh print option dialog 
boxes one after the other.  Each of them will have a title beneath it indicating 
whether you are setting the print options for Cue Sheets or Score Paper. This 
will allow you to have different printing specifications for each form in the same 
print run, such as printing your Cue Sheets vertically and your Score Pages 
horizontally. 

Although printing sideways was mentioned already in conjunction with how you 
lay out the score paper, it can't hurt to mention it again now that we are 
discussing printing.  Should you want wider bars, but would like to have sixteen 
clicks per line, you can print your Score Paper sideways by clicking the File 
menu, selecting Page Setup and clicking on the sideways print icon under 
Orientation. 

In this way you can set up a large amount of material to be printed without 
having to be there to nursemaid the process. Score Paper does take a while to 
print, so printing a batch of material at one time while you do something else can 
be a definite time saver. 

CUE will put the date and time in the upper right hand corner of every Score 
Page you print so you will always be able to tell which is the most recent copy.

Remember that the information in the Clicks Window will be printed out at the 
top of each system in the format that was selected with Command ","  (see page 
157), so make sure this is set correctly before you print your score.

In the lower left hand corner, CUE will place a copyright sign (©) followed by 
the year, the name of the first composer, first publisher and affiliation 
(depending on what information you have entered under Set Cue Info).
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A check in the Reset Formats box and an OK, will bring up the Set Time 
Formats dialog, used for selecting Absolute and Relative time formats for 
your two left hand time columns in the Cue Sheets to be printed.  You can select 
any of the different time formats (seconds, film feet/frames, video frames etc.) 
for printing purposes here without altering your original Saved Cue Sheet 
formats.  This should prove quite useful when you need to print out Cue Sheets 
with varied time formats, without having to go back to each for conversion.

When you place a check in the Alt. Running Times box, your printed Cue 
Sheets will change the Column One Time Format to what has been 
previously set as your Alternate Running Times in all of the Set Running 
Time dialog boxes (Command Opt-X) for your selected cues. 
 

Using Different Printers
CUE will recognize different Mac compatible printers and make adjustments to 
them.  If you own a laser printer and the Sonata™ font, CUE will be able to 
utilize this font in your laser printouts.  Not only is the laser printer recognized, 
but if you have a wide Imagewriter, CUE will adapt to the larger paper 
dimension and place as many systems per page and bars per line as is possible.

A Handy Hint: If you print your Score Paper out sideways, don't tear the 
individual sheets apart when you remove them from the printer. By taping the 
left edge of the first page to the last page, you will have an easy to use book. 

The Master Cue List
To build a Master Cue List (the "Bible") of all the cues and their vital statistics 
from a particular film, click on the Windows menu and select Master Cue 
List. 

Although we have written previously about saving cues with a "production code", 
it bears repeating now because of it's relevance to the Master Cue List:  

If you want the Master Cue List (or the Performing Rights Cue Sheet or 
Spotting Notes) to work, you must name your files and folders correctly when 
you save them for the first time.  It is only when the file name of each cue in the 
film begins with the same "production code" followed by a slash (/), that CUE 
will include it in the search.  So stay consistent within a given project when you 
Save cues.  
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Also, be sure to enter a cue number in the Set Cue Info dialog box using the 
form rrMss, where rr  is the reel number and ss  is the start number (6m4 is the 
fourth cue on reel six).  CUE uses these cue numbers to sort the cues into proper 
order.  Any cues without numbers will be listed alphabetically by title.

One final warning before we go any further:  If you have been reading this 
manual front to back, you will probably be sick of hearing about this by now, but 
since it is the most common error made by CUE users . . . .  DON'T STICK 
YOUR FILES OR FILE FOLDERS IN A FOLDER LABELED: "CUE" 
OR ANYTHING OTHER THAN THE PRODUCTION CODE OF THE 
PROJECT YOU ARE WORKING ON FOLLOWED BY A SLASH!!  If 
you do, CUE will not be able to find these files when it searches to do a Master 
Cue List compilation.  

To use the Master Cue List, start by typing the "production code" (without a 
slash mark) into the box at the bottom left of the window. Next, enter your 
Production # if any into the appropriate box, and click on the title Prod. # 
which should be highlighted.  If you want to have the cues for a particular session 
number displayed or printed then enter that session number in the box to the 
right of Session #. and click on it's highlighted title. Only cues with the proper 
production and session numbers (from Set Cue Info) that match the session 
number you placed in the Master Cue List will be searched for.   If anything 
other than 1 to 9 (including leaving the space blank) is entered as the session 
number, all cues will be displayed.

Before you click on OK (or hit the Enter key) to initiate the search procedure, 
be sure that CUE knows about all the disks you want to include in the search.  
Any disks that have not been placed into a drive since you opened the program 
should be inserted at this time.  Clicking on the Eject button will remove disks 
currently in use so you can place other disks in your drive.  You can repeat this 
process as many times as is necessary. 

As you can see in the example on the next page, once the search has started, you 
will be asked to Search or Skip each disk that has been inserted since you began 
your current use of CUE.  If you have forgotten any disks, you will have to go 
through the search procedure all over again, so it is good to be organized before 
you start.
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After all the disks have been searched, the Master Cue List will list every cue 
in numerical sequence. Any cues which have not been given a numerical name 
will appear at the end of this list in alphabetical order.
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For each cue number you can see the composer, orchestrator, whether it has been 
written, orchestrated copied and recorded (any cue that has been recorded has a 
line drawn through it), and the date and time of the last revision. If there is more 
than one cue with the same title, the most recent one will be listed. 

A reminder:  the Set Cue Info dialog box in the Operations menu is where 
you enter the information about the progress of the cue by clicking the buttons 
marked Written, Orchestrated, Copied and Recorded.

Once the Master Cue List (or the Performing Rights Cue Sheet or the 
Spotting Notes) has been built, you can print out the Master Cue List by 
selecting Print Cue List from the File menu. As a convenience to you, Print 
Cue List is kept disabled in the menu until you actually have a compiled list 
ready to print. 

Clicking on the Clear button will cause the text in the Production Code box to 
be returned to the last "production code" that was  OK'd. 
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The Master Cue List  only searches cues that have been Saved to disk. If you 
have changed the title or Cue Info of the cue currently in memory, you must 
reSave the cue if you want it included.

If you are using HFS (Hierarchical File System) initialized disks (such as 800K 
double-sided disks, the Apple HD20, or a SCSI hard disk) and you want to put 
your cues in folders, your folder names must start with the "production code" 
and a slash (/) in order for them to be included in a search. The folders can be 
nested as deep as you want as long as they follow this naming convention.  For 
example, you might have a folder named Zarkov/Cues that contains other 
folders named: Zarkov/Reel 1, Zarkov/Reel 2, Zarkov Reel 3, etc. Each of 
these folders would contain the actual cues.  Even if you are not using HFS-
initialized disks, following this organization procedure will help you keep your 
project in good order.
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Performing Rights Cue Sheet
Although completing the Performing Rights Cue Sheet is one of the last tasks 
you will do on a film, we will deal with it now, because it operates identically to 
the Master Cue List window.  You access it by clicking on the Windows menu 
and selecting Performing Rights.

We will skip the steps for searching the various disks your film may be on, and 
ask you to refer to the Master Cue List section of the manual (page 166). One 
suggestion to add is that keeping all your cue files for a particular project on as 
few disks as possible will stand you in good stead when it comes to this sort of 
information management.  

Another suggestion is to make sure that you have not stored your files or your 
production folder in another folder that is labeled with something besides the 
production code of the show you are working on.  This is important to check 
because it will prevent CUE from being able to find them when it does a 
Performing Rights search. 
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After you have clicked on OK, and searched your disks, the Performing 
Rights window will look like this:

The production information that appears at the top of this Performing Rights 
Cue Sheet report was entered into CUE in the Set Cue Info and the Set 
Production Info dialog boxes that are in the Operations menu. The report 
takes this information from the first cue in the list.  

Anything you type into the Other box of the Set Production Info dialog, will 
appear under the production and episode titles in the Performing Rights Cue 
Sheet. The rest of the information displayed above the actual list of cues is 
derived from specific dialog boxes you will find in Set Production Info.

Reading from left to right in the cue listing, the Performing Rights Cue 
Sheet displays the title, composers(s), percent each composer receives on a given 
cue, publisher(s), music society affiliation and length of the cue. Underneath the 
affiliation, CUE lists the cue's music usage (on camera, instrumental, etc.). If 
you have customized the Usage Menu , then any of these special choices you 
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have made will be displayed here as well.  The Usage information will be 
displayed in it's own column if the Performing Rights Cue Sheet is printed 
out sideways.

At the bottom of the list of cues the amount of music in the film is added up. The 
total time of each type of usage will be listed, and beneath those, a grand total for 
the whole picture will be displayed.

Once the Performing Rights Cue Sheet (or the Master Cue List or 
Spotting Notes) has been built, you can print out the Performing Rights 
Cue Sheet by selecting Print Perf. Rights from the sub-menu of File 
column. Although longer titles are abbreviated on the Macintosh screen, they will 
be printed out in their entirety.

If you have cues in a film that do not get used in their full form because of one 
editing decision or another, you can make their actual length be reflected 
accurately in the Performing Rights Cue Sheet by placing a Reverse Slash 
(page 77) in your Cue Sheet at the point where the music was cut.  This will 
make that cue point the end time of the cue and thus your Performing Rights 
Cue Sheet will list the correct amount of music, after you have saved your cue, 
and created a new Search..
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8 Communicating With the Outside 
World

CUE converses easily with a range of synthesizers, video machines, streamer 
boxes, 
          tape recorders, sequencers and sync boxes

CUE outputs a click track with all the meter and tempo changes you have made

CUE  allows you to customize the sound of the click track

CUE generates streamers and punches

CUE lets you superimpose streamers and punches over your video

CUE drives the Tesla Color Streamer Box

CUE locks to SMPTE

CUE outputs MIDI clocks and song pointers

CUE  lets you loop or  repeat any part of a click track

CUE can receive a MIDI start command

CUE instantly dumps it's click track into various sync boxes

CUE generates MIDI Event Triggers

CUE lets you follow existing material and tap out a click track by hand

CUE commands the generation of SMPTE

CUE creates MIDI Files that can be read by other programs

CUE will play any sequence that can be saved as a MIDI File

CUE  Imports and Exports from older CUE versions, text, and MIDI 
files.
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The Import and Export of CUE
When you have productions saved on an earlier version of CUE, and/or wish to 
Import text or MIDI files for Cue Sheet or Playback use, select Import in 
the File menu.  The following entries will appear in the sub-menu, when you 
click on Import:

Importing Older CUE Files

CUE has become quite friendly to Imports in recent years. Perhaps the 
most frequent importation for those owners of previous CUE versions is 
the Import CUE 2.x File  feature. If you tried to Open an older file of 
CUE in CUE 3.0, you received the following admonition:

Frankly, there's not that much to the Import CUE 2.x File command. 
Mostly we wanted to show you the nifty sign above with the hand on it. 
After you have seen that, go directly to the File menu, and select CUE 2.x 
File.You will immediately be taken to the standard Macintosh File 
Selection box, giving you the opportunity to open files on your current 
storage system, or selected drive.  From there CUE will open your files in a 
normal manner.
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Import Text File 
Click on the Import Text File  and the following box will appear:

The CUE check box allows the importation of a CUE Cue Sheet  which was 
previously saved in the "Sparse" text file format. This format was created 
for the additional flexibility of spell-checking or adding to your Cue Sheet 
material with a favorite word processor or text editor. Once you are 
finished with your word processor editing, Save  your material under it's 
original name.  For instance:

The "Special" check box is a text format used by the Music Design Group's 
In-house computer system.
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Exporting the Cue Sheet as Text

The Export sub-menu under File has both special text and MIDI file-save 
formats. The first, Export Cue Sheet as Text , allows you to save your 
entire Cue Sheet with all information (the Detailed check box) or with a 
single column of cue point timings and their descriptions (the Sparse text 
check box). Clicking on either of these two check boxes will bring up the 
standard Save Text File dialog box allowing you to Name, Save , or 
Cancel your present file.  Note that CUE will automatically add a .txt to 
any previously Saved file placed in the Save File dialog box.This addition 
is not necessary for file recognition, however a standardized file-type 
format is highly recommended.

In the Text File  format, you can open up your Cue Sheet for editing  in a 
favorite text editor or word processor as discussed above.  

Use the Detailed format when you wish to import a Cue Sheet file into a 
word processor for complete editing and printing from that application.In 
this form, you can transfer your Cue Sheet to someone who doesn't have 
the CUE application for information and/or further editing of the 
constructed cue.
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The Click Track/ Streamers & Punches
When you are ready to play the Click Track or Streamers and Punches, 
select Playback from the Reel World menu (or hold down the Option and 
Command keys while you type P). The window you will be presented with looks 
like this:

It looks like a large strip of film with five sprocket holes (artistic license).

The film strip has a stopwatch readout that displays the Absolute or Relative 
Time depending on which one the Input window is set for. It also has a place 
below it where the time of the Next Punch is shown, and to the right, a Cue 
End display that indicates the length of the cue.  All three will be shown in one 
of the two Time Formats you picked for your columns of timing information 
in the Cue Sheet. Which column's Time Format is to be shown in the 
Playback window depends on the choice of either Enter Absolute or Enter 
Relative Time that you made in the Operations menu. If both your timing 
columns are set for either Absolute or Relative time, then the Time Format 
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of the left column will default to Absolute time, and the right column will 
default to Relative time format.

To the right of the Next Punch  is a display that indicates the current Bar and 
Beat.  Following this are icons for display and selection of the Music Port and 
Sync Port for .MIDI information. Clicking on either one of these icons will 
change it from Modem to Printer, or reverse. In the center of the Playback 
window is a stopwatch face with a sweep second hand.

From this window you can play Clicks, Streamers and Punches as well as 
output MIDI Clock.  You need select only those features that apply to the work 
at hand.

The Playback window is multitasking. You can go to other windows or even 
another application under Multifinder while the Playback window is running 
and it will still keep going.  In fact, you can run both the Playback window and 
Midi Events (page 202) simultaneously.

Playing the Click Track 

Six of the sprocket holes have text in them, and function like large buttons. The 
Start, Stop and Cont (Continue) buttons are fairly self-explanatory. To play the 
Click, click on the Start button or hit the Space Bar on the keyboard. After 
you hit Start, CUE will play the number of Warning Clicks you have asked 
for in the Set Countoff Warning Clicks dialog box under the Operations 
menu. Then it will begin playing the .i.Click Track with all the Meter and 
Tempo changes you have placed into the Cue Sheet.

You can listen to the clicks through the Mac's internal speaker, plug its audio 
output into an external sound system, or send it to a midi device.

While the Click Track is playing, the Playback window will display what Bar 
and Beat you are on.  

Starting the Click After the First Bar
If you have stopped your .i.Click at a certain point and wish to resume with the 
very next beat, click on the button marked Cont (Continue) which appears 
below the Start button and will become enabled whenever you hit Stop. Hitting 

179



the Tab key will also cause the Playback window to Continue. Either way, 
Continuing the Playback will pick it up on the next beat from the one you 
stopped at.

Should you want to play the Click from a point other than the Start or the point 
where you may have stopped it, you can do so. As you move the mouse cursor 
over the Bar Number you will see that as you place it over the top half of the 
number it turns into an arrow pointing upward, and as it covers the bottom half 
of the Bar Number it turns into a downward pointing arrow. When the upward 
arrow appears, clicking on the Bar Number will increment it, and when the 
downward arrow is visible it will decrement the Bar Number. The Beat 
number works the same way except that you can only increment it.

If it is more convenient, you can type out that Bar Number instead of 
incrementing or decrementing. It will appear in italics until you hit either the 
Return or Enter key.  If you want to start at a beat other than the down beat in 
the Bar Number you have just typed, you will still have to increment the Beat 
by clicking on it.

In either case, the Playback window will start playing the beat following the 
one which you have entered.  To store any of these internal start times, see the 
section entitled Multi-Point Search to CUE that follows Looping the 
Playback.   

If you have an Opcode Studio 3, footswitch #2 will stop playback.

Looping the Playback
If you wish to instruct CUE to endlessly loop a particular section of the cue 
follow these steps:

Picking the Loop Point

First, you have to determine the beginning and end point of the loop. CUE gives 
you eight different loop points labeled A through  H. Although there is more 
than one way to accomplish this, the quickest method is as follows:

Type the bar number which you want to make your first loop point and you will 
see it displayed in italics under the Bar display. Hit the Return or Enter key 
and the italics will turn into regular text letting you know that your instruction 
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has been received. You can also click on the Bar number to change it, but typing 
is faster.  

Yet another way to pick your loop point is to play the cue until you get to where 
you want to have a loop point.  Hit the Stop button or the Return key at this 
point.

Marking the Loop Point
Once you have your loop point logged into the Bar and Beat display, it is time 
to Mark it.  Click on the button labeled Mark, and the following little dialog 
box will appear:

You pick the letter to designate your loop point by clicking on the letter in the 
dialog box.  Clicking on the upper portion of the letter will advance you through 
the alphabet (after H you will be returned to A) and clicking on the lower 
portion of the letter will have the opposite effect. Once you have the letter you 
want, click on OK or hit the Enter key.  Mark two loop points in this manner 
and we will then be ready to go to the last step of  actually creating the loop.

Creating the Loop
Go to the Reel World menu and select Set Loop Points in order to call up this 
dialog box:

Pick which letters you have marked as the beginning and end of the loop by 
clicking on the two letters shown, just as you did when you were marking the 
loop points.Then by clicking on the number preceding Sec. Delay to set how 
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long a pause (between 1 and 8 seconds) there will be before CUE  starts playing 
the loop again.  Click on OK or hit the Enter key and now you are ready to play 
your loop.

Playing the Loop
If you look at the sproket hole marked Loop, you will see that the two letters 
you picked as the beginning and end points of the Loop are now shown there. 
Clicking on this button will start the looping process, including the built in pause 
you chose, until you click on the Stop button.

Multi-Point Search to CUE
A related function to looping is the ability to store several different points for cue 
playback beginnings. Use the Mark button to set these points up identically to the 
way you set your loop points. They might even be the same places in the cue.  
Rather than loop the selected points, we will have CUE Start the Click Track 
from one chosen point, and play through the cue from that point.

The locate point is picked by clicking on the Reel World menu and selecting Set 
Locate.  When you do this, a sub-menu will appear that looks like this:

It displays the eight points you can loop or locate from, and also shows you which 
Bar each point has been set to.  Selecting the one you want, will cause it to 
appear in the sprocket hole under the word Locate. Now when you hit the 
Locate button, the Playback window will start playing from this point. 
Clicking on the Stop button will stop the Playback just as if you were playing 
from the beginning of the cue.
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Turning the Click On and Off
It is possible to turn the click track on and off as many times as needed within a 
given cue.  This is done by editing the specific on and off points in the Cue 
Sheet. Place the cue point  that you want to make your off point into the Input 
window for editing. Type a vertical line character (|) into the text entry area as 
the first character of the Description. When you click on OK or hit the Enter 
key, you will see the words: CLICKS OUT appear above that cue point in the 
Cue Sheet. Doing the same thing with the cue point where you wish the Click 
to return will result in the words: CLICKS IN AFTER TWO WARNINGS 
being placed above the Description.

As a guide to the musicians, the click track that has been turned off and is about 
to start again will be preceded by two warning clicks in the Tempo that's about 
to begin.

Playing Unáccented Clicks
Anyone who does not wish to give their musicians an accented downbeat can 
easily modify this default click setting by going to the Reel World menu and 
selecting Options.  At the top of the dialog box is the phrase Accented 
Downbeats.  Clicking this to the "off" position will remove the accented 
downbeats from the click track.

Playing a Kustomized Klick
If you don't want to use CUE's click sound, click on the Reel World menu and 
select Options. 

 
You activate the Send Clicks as MIDI Events feature by entering a MIDI 
Channel number and a Note value from C-1 to G9. Now you can put a digital 
metronome click (or a dog bark) into your sampler and CUE will trigger that 
sound on every beat. 

The MIDI Event click track is sent out the Music Port. Clicking on the right 
hand Port icon will change the Music Port from modem output to printer 
output or vice versa.  
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Scroll During Play
 
To reference your place in the Cue Sheet or the Clicks window while in 
Playback, a useful feature called Scroll During Play has been added. Go to 
the Misc menu and click on Scroll During Play (or simply type Command-
Opt-L). Now go back to your Playback window, and and Start your playback. 
Of course, you could type Command Opt-P and just hit the space bar. Once 
Playback has started, proceed to select either your Cue Sheet or the Clicks 
window. You will find large triangular cursors now show the active cue point, as 
your Cue Sheet scrolls down the entry list.  If you selected the Clicks window, 
your measures will scroll left to right, showing each cue point and it's abreviated 
description.  The Title Bar will indicated each change of bar and tempo.

To stop Playback,return to the Playback window,hit the Stop button, or hit 
the Return key.

The Scroll During Play function is particularly useful for those with genlock 
capabilities. By locking CUE to SMPTE, you can superimpose the Cue Sheet or 
Clicks window over your video, and watch each cue point and it't description 

scroll by in sync with the real-time action.

Driving the Tesla BeatMaker 
This is a wonderful little box that makes a click just like a digital metronome 
except for the fact that it is totally MIDI driven.  The only difference between 
using it and driving a synthesizer as your click source is that the Tesla needs only 
a specific MIDI channel and note value in order to operate.

Select MIDI Setup from your Reel World menu. You will see a Tesla check 
point under MIDI Click:

Once checked, CUE will automatically send out the correct note and channel to 
operate the Tesla BeatMaker. This feature, once selected, can be Saved in your 
Defaults file for regular future use.

Don't forget to click on the Reel World menu, select  Options, and place a 
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check in the Send Clicks as MIDI Events box. You can now select either the 
Printer or Modem port, depending on which one you have The Tesla hooked 
up to. This unit not only sounds like a digital metronome, but is capable of 
creating flexible Tempo changes,  including Accelerandos and Ritards. 

Playing the Right Version of the Cue 
Sheet

When you select Playback, and have the Cue Sheet set to a Version other than 
the final one, CUE will beep you and give you the following choice:

If you click on Yes, CUE will switch the Version to the one selected as your 
final choice and send you to the Playback window. Click on No, and you will 
be sent to the Playback window where you can now play the non-final Version 
you have chosen. This feature has been installed to help avoid a serious error on 
the scoring stage.

Playing Streamers and Punches 
If, after figuring out all of your clicks, you decide to conduct your cue, then 
CUE can be of assistance by displaying Streamers and Punches on the 
Playback screen. You can run this Playback window wild, or you could lock it 
to SMPTE. 

Any place in the Cue Sheet that has been designated as a Key Hit will receive a 
Streamer and Punch, so make sure you have edited your Cue Sheet in order 
that all the places you want Punches are marked as Key Hit't. Once you have 
completed this step, select Playback from the Reel World menu.
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All of the procedures for playing Streamers and Punches are the same as those 
for playing the Click.  In case you don't want to listen to clicks while the 
Streamers and Punches are unraveling, then click on the Misc menu and select 
Clicks Off (or hold down the Option and Command keys while typing the 
letter "O" in either upper or lower case).
 
If you only want to listen to the number of Warning  Clicks that you have 
chosen in the Set Count Off dialog box while the Streamers and Punches are 
unraveling, then place the vertical Click Off line in the Description of the first 
cue point.(see page 182).  After this you will hear no more Clicks and the Stop 
Watch  and time counter will start.  The Beat Number will flash on and off in 
the Tempo you have designed so you will have a good sense of what the Click is 
even though you can't hear it.  As you come up to a Punch, a Streamer will 
animate across the screen from left to right:
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When the Punch hits, the screen looks like this:

The Next Punch display will be updated as each punch hits.

187



Streamer Options
It has become so common to work and conduct with video copies of a film, that 
methods of sending traditional visual Streamer information to the outside world 
have gained increasing importance. If you click on the Reel World menu and 
select Streamer Options, you will find that CUE has set up it's visual 
Streamers found in the Playback feature, to be sent out as MIDI information: 

To send streamer information out as MIDI events, check the Send Streamers as 
MIDI Events box and select Channel, Note and Port information so that it 
conforms to your outboard streamer device requirements.

Varying the Streamer Length
You have a choice of clicking on either 3, 4 or 5 foot Streamers, depending on 
the length of visual warning you prefer, and the streamer purpose in your 
application.  After the Streamer length has been changed, remember to click on 
OK or hit the Enter key. 

Varying the Punch Type and Size
There are several punch types to choose from in the Punch Only line. These 
govern how the Tesla Streamer Box will display Key Hit't that are set to Punch 
Only in the Input Window of your Cue Sheet.  When the Key Hit box is 
checked, the pop-up menu is activated behind the Default Streamers box.  
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Release the mouse button on Punch Only when you wish to activate this feature 
for your cue point. The Mac Playback screen will always do single punches 
when in the Punch Only mode.  

You will also see that there are three different Punch Sizes to choose from in 
this dialog box.  Select the one you want to see displayed and click on OK or hit 
the Enter key. This feature is designed both for your external Streamer Box, 
and the Playback screen punch size.  
Along with the OK and Cancel buttons at the bottom, you will see a center 
button marked Test.Clicking here will trigger a Tesla Streamer box flutter 
punch followed by a streamer and punch set according to your settings in this 
Streamer Options dialog. The Test button is designed specifically for the Tesla 
unit, which will be described more fully in following sections of this chapter.

Even if traditional Punches and Streamers are being scribed on the film you 
are working with, the Playback window will still provide a means to practice 
conducting difficult cues before the session as well as letting you check the 
musical validity of your approach.  

  Projecting Streamers/Punches on 
Video

The Tesla Streamer Box
Hardware is now available that will place beautiful Streamers and Punches 
over the video you are working with. The best streamer box currently on the 
market is the Tesla Streamer Box. Not only does it superimpose perfect 
streamers over any video, but it also does so in color. One of the best features of 
this box is that it can produce color streamers even if you have a black and white 
computer such as the Mac Plus or SE.  CUE and the Tesla Streamer Box are 
designed to work together. In fact there are no switches or knobs on the Tesla 
Box.  All of it't commands are contained in CUE. 

There are three places in CUE that have Tesla Box commands.  

1- Selecting Streamer Options from the Reel World menu provides you with 
the ability to modify Streamer length, Punch size and whether you want to have 
Flutter Punches on cues marked Punch only. This is also the dialog box that 
you use to establish your basic link with the Tesla Box. You do this by clicking 
on the the box next to Send Streamers as MIDI Events. When you make this 
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connection with the Tesla Box, it is not necessary for you to select a specific 
MIDI channel or note value, but it is important that the Sync Port button to the 
right of the Note Value entry box, matches the port you choose for the Tesla-
Macintosh MIDI Interface connection. (You change the icon from one port to the 
other simply by clicking on it.)

2-   In the Input window of your active Cue Sheet, directly above the OK and 
Clear buttons is a pop-up menu labeled Default Streamer. When you click on 
the Key Hit box of a new cue point, the Default Streamer box becomes 
enabled. This is what enables you to give instructions to the Tesla Box as to 
what type of streamer you want to appear at different points in your cue.

  Now click on this box while holding the mouse button down. You will see a list 
of different Streamers to choose from:

Select the streamer you want for this Key Hit cue point by releasing the mouse 
button over Warning, Downbeat, Internal, Ending, User 1, User 2, 
Default or Punch Only.  When you release the mouse button, the Streamer 
selection will be reproduced inside the button.  

If Default Streamer is chosen CUE will determine the correct type of 
streamer based upon the placement of the cue point in the Cue Sheet. User 
Streamers 1 and 2 are optional features for your own musical purposes within 
the cue. Flutter Punches are one of the features in CUE  that only work with 
the Tesla Box. 

When you click on OK in the Input window, the correct streamer request will 
be forwarded to the Tesla Box during playback of the cue.
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Set Streamer Colors
3-  For those of you who have a Macintosh with color card and monitor, the 
Playback screen can provide several color options for you to work with.Go to 
the Reel World menu and select Set Streamer Colors.  The following display 
will appear:  

Click on a particular streamer whose color you want to change and then click on 
which of the eight specific colors you want to select. You can modify as many of 
the streamers as you want by following this same procedure for each one. When  
the desired adjustments in streamer colors have been made, click on OK or hit 
the Enter key. If you do not wish to make any of the changes you have selected, 
then click on Cancel key and the Set Streamer Colors choices will remain as 
they were previously set. Streamer colors can be saved with your defaults.

CUE is set to default to fairly widely accepted colors for the warning, 
downbeat and ending streamers, but that shouldn't stop you from getting 
creative and tailoring the streamers to fit your individual situation. 
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A Third Approach to Streamers
Another type of box you can employ to superimpose streamers over video is a 
relay triggered device like the Video Streamer made by CB Electronics (an 
English firm).  Although the streamers are fat and easy to see, there are several 
drawbacks to the use of this type of device.  It does NOT employ MIDI to 
communicate with the outside world, and does not have color streamers.  It also 
doesn't allow as much control from cue.  However,  it IS possible to buy a MIDI-
to-relay interface like the Cooper Electronics MIDI Mute and make the 
proper cables for it's connection to CUE. This interconnection may involve some 
extra time and money, but if you already have a Video Streamer, or similar unit, 
we've heard it may well be worth the effort.

To use the Video Streamer, you must set up CUE to send out a trigger 
instruction via MIDI. If you select MIDI SETUP from the Reel World Menu, 
you will see the following dialog box:

Select the Relay Triggered option for the Streamers option at the bottom of 
the box.Click on OK and move to the Streamer Options box in the Reel 
World menu. Midi Channel, note, and port must all be set to conform to the 
MIDI Mute inputs.
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You will need to follow the CB Electronics manual to set the streamer length 
for your different cue points.  Select one relay from the MIDI Mute to be 
triggered by a specific MIDI keyboardnote (like C1 or A4).  Send your relay out 
by properly wired connector and you can use the CB Streamers.
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Locking to Picture - MIDI Time Code
Thanks to MIDI Time Code, CUE  can now be locked to SMPTE Code provided 
that you have acquired a MIDI Time Code Box to connect between your MIDI 
interface and the SMPTE source.  Opcode makes two very good alternatives for 
accomplishing this. One is the Studio 3 and the other is called The Timecode 
Machine. Both of these work in conjunction with CUE as well as generate 
various forms of SMPTE and regeneration of SMPTE Time Code. Several other 
companies offer versions of this essential little device.

The hookup chain of command for SMPTE and MIDI connection is as follows: 
run  your SMPTE audio source into the MIDI Time Code Box. The MIDI out of 
the Timecode Machine gets plugged into the MIDI input of your Macintosh 
interface device (like your Studio 2). With the Studio 3, simply connect the 
SMPTE signal to the Audio Input in the back of the unit.No other MIDI/SMPTE 
connection need be made. Both the Timecode Machine and the Studio 3 have 
audio SMPTE signal outputs which can generate or regenerate the SMPTE code 
when needed.

CUE will adjust to the SMPTE format it is reading without causing you to 
change any format settings. For example: you could take timings in 30 frame 
SMPTE and use 30 frame Tempo Format and then go to Europe to record 
where you could lock to 25 frame SMPTE without making any changes to the 
Cue Sheet.

Click on the Reel World menu and select MIDI Setup.When that dialog box 
appears, set the sync port to whichever port the cable is hooked into and then  
click on OK (or hit the Enter key). 

Next, click on the Reel World menu and select Options.

When the dialog box appears, click on the Lock to Time Code circle, and then 
punch the OK (or hit the Enter key). Two other ways to Lock to Time Code 
are selecting Lock to Time Code from the Misc menu, or simply typing 
Command-E.  

194



After completing whichever one of these operations you choose, click on the 
Reel World menu and select Playback.

Notice that the Playback window title bar now has added the words: (MIDI 
Time Code) and that there is some additional information displayed at the 
bottom of the dialog box which includes a listing of the selected SMPTE format, 
a Bit Offset display and a SMPTE Lock indicator.

As soon as you click on start in this window, and send a SMPTE signal from your 
external device, CUE will recognize the type of SMPTE being sent and hightlight 
it for you in this READING area.

The Bit Offset  can be set by holding down the Command and Option keys 
and then hitting either the plus (or =) or minus key. Holding the plus or minus 
key down will cause the Bit Offset to cycle in whichever direction you have 
indicated. This lets you make adjustments of up to 79 bit't in either direction that 
will not affect any of CUE's calculations. A main reason Bit Offset is provided 
is to deal with a MIDI lag, a slow speaking instrument or a cue that for whatever 
reason needs a very minor Offset  to settle into a perfect place.(You can also set 
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the Bit Offset by typing a number into the appropriate place in the Set Offset 
dialog box, but as long as you are already in the Playback mode, the first 
method described seems more convenient.)

The circle to the right of the word Lock will light up when SMPTE Lock has 
been achieved.

The Playback window will stay in Play mode until you hit Stop or until it 
receives SMPTE numbers that are more than ten minutes past the time that marks 
the end of the cue. This means that you can run back and forth within the cue and 
CUE's Playback will follow along without you having to hit the Start button 
every time before you roll videotape.  (If you want to manually halt the 
Playback you can do so by hitting the Stop button). Because the window is now 
following SMPTE, the Cont (Continue) button will not appear in this mode.

Your Options Options; 
There are several choices available to you in the Options dialog box which have 
not yet been discussed.  Send Clicks as MIDI Events, Lock to Time Code  
and Accented Downbeats are covered on pages 183 and 194  of this chapter. 
Lets look at some of the other features in this box.   Click on the Reel World  
menu and select Options:
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MIDI Clock Out
Having CUE output MIDI Clocks is done exactly like playing Clicks or 
Streamers and Punches with the exception of one preparatory step. Click on 
MIDI Clock Out and then on OK (or hit Enter key).  You will now be 
sending  MIDI Clocks through  your Sync Port while Clicks are 
simultaneously being sent through the Mac audio out mini-phone jack.

If you have not programmed a countoff into your sequencer or drum machine 
but want CUE to play an audible countoff before the MIDI clocks and the music 
starts, and click on Start After Count Off. 

Setting Your MIDI Clock
I know you thought that you would never have to adjust your digital clock, but 
you probably didn't read the fine print on the packaging.  All sequencers are not 
created equal, and sometimes even the same sequencer can have a different 
response rate to MIDI Song Pointers, depending on the complexity of the 
sequence.

The problem you may encounter as a result of different reaction rates to Song 
Pointers is that a slower sequencer may miss the Continue command and either 
not start playing or react in some bizarre manner.

Next to Song Pointer Mode, you will see four choices from Fast to S L O W. 

Clicking on one of the choices other than Fast, will progressively slow down the 
amount of time that CUE wait't between sending the song pointer it's Continue 
command.
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Receiving a MIDI Start Command
If you are scoring to film, cannot lock to SMPTE or don't have a compatible sync 
box, there is another not quite so perfect option available to you for starting your 
CUE playback synchronously with an external MIDI device. Put CUE in MIDI 
start mode by checking on the Wait for MIDI Start check box, and then hit 
start on your Playback screen.

By programming the sync box to start at the correct SMPTE number you can 
have it send CUE a MIDI Start Command, which will start the Click, 
Streamers and Punches and MIDI Clock at precisely that time.The main 
difference is that after the start message, CUE will be running free. Our tests 
have shown CUE to be extremely accurate, but of course it is not as sure a thing 
as an actual SMPTE lockup. 

When in MIDI Start mode, CUE will start on any MIDI Note On command, or 
with the Opcode Studio Three footswictch no. 1. CUE reacts much faster to 
these signals than to the space bar, so you can gain an extra measure of precision 
with this feature.
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Doing a Dump (to Your Sync Box)
If you want to use an external sync box to control your sequencer it is possible to 
do a system exclusive dump to either the Roland SBX-80, Garfield Master Beat 
and Time Commander, the Southworth JamBox/4 and the  J.L. Cooper PPS-100.

You can select the specific sync box you own by clicking on the Reel World 
menu and selecting MIDI Setup.  

Click on the sync box you wish to use and then click on OK or hit the Enter 
key.  Make sure that your Sync Port is set to the same output port as your Sync 
Box.

Once you have confirmed your connections, click on the Reel World menu and 
select Xfer to Sync Box.

If you have not yet selected MIDI Setup, the MIDI Setup dialog box will open 
automatically so you can choose between the printer and modem ports and pick 
the proper sync box before CUE  does the dump.

The actual dump is completed by selecting Xfer to Sync Box from the Reel 
World menu. 
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How to Do It With the SBX-80
Here is some some specific assistance with a system exclusive dump to the SBX0-
80:

1- Connect the MIDI out from your MIDI interface to MIDI in of the SBX-80

2- Connect the MIDI out from the SBX-80 to MIDI in of your MIDI interface

Remember to connect both the MIDI IN and OUT of your SBX-80 to the port 
chosen as CUE's sync port on the MIDI interface.  Also, be sure that if your 
SBX-80 was set at the factory for 30 fps that you select either 30 or 29.97 for 
your Tempo Format. If it was set for 25 fps, then that would be your choice 
(see page xxxold 68).

3- Before you select Xfer to Sync Box from the Reel World menu, make 
sure the switch on the SBX-80 labeled Tape has been pressed. This will cause the 
Save, Verify or Load selections to light up.

4- Select Xfer to Sync Box.  When the dump has taken place successfully, the 
readout on the SBX-80 will display the word: Done. If there is a problem, a 
dialog box will appear informing you gently of this:

5- Before you playback the SBX-80, the Play button must be on. If you have 
forgotten to toggle from Tape to Play, the SBX-80 will think it is time to start 
dumping stuff to it't cassette.

The SBX-80 is one of the only sync boxes that needs a two-way connection for 
the system dump to be completed (although you will probably have two cables 
connected anyway so you can playback to your sequencer).
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Using Other Sync Boxes
If you are using a sync box other than the SBX-80, you may find that the system 
dump procedure is somewhat more straightforward. Refer to the manual that 
hopefully came with your sync box for set-up instructions including whether you 
can dispense with the SBX-80's Tempo format restriction .
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9 Sound Effects & Other Reel 
World Features

The MIDI Event Trigger
CUE can function as a very specialized "sequencer" designed to turn any MIDI 
accessible sound on and off at specified SMPTE numbers. It simplifies the laying 
in of sound effects to a tremendous degree and like so many other aspects of 
CUE is tied in with the cue points that are entered as part of the Cue Sheet. 
We'll take a brief look at the layout of the MIDI Events box as an overview, 
and then go into specifics.

You can create and store up to 40 separate MIDI events, each one of which may 
be triggered as many times as you wish. When you click on the Reel World 
menu and select MIDI Events the following window will appear:
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Each of the 40 MIDI Events lets you enter a Description, a MIDI Channel 
Assignment from 0-16, a Note name, a Volume Level from 0-127 and a 
Duration whose time format will match the way you have set the Relative 
column of timing information in the Set Formats dialog box.  Also notice that 
every MIDI Event lets you access up to five different notes on up to five 
separate MIDI Channels per Event.  

Clicking on any one of these parameters will highlight it and place the existing 
entry into the Text Entry box at the bottom left where you can now replace or 
modify it. After you have updated a parameter, hitting the Enter key, the Tab 
key or clicking on another parameter will replace the existing text with your new 
entry. If you want to cancel what you have just typed or played without actually 
entering it, click on the Clear button to the right of the Text Entry box, and it 
will return to it's original setting.  Whenever you click on the Clear button, 
information in the entry box at left will be highlighted for re-edit. 

There are several other buttons and check features at the bottom of your MIDI 
Event wndow to help you place and edit the MIDI Events.    

The MIDI Input check box will enable you to enter notes from an external 
MIDI keyboard when checked. This check box will be activated only when a 
Note Name is highlighted in the Text Entry box at left. With a Note Name 
highlighted, and a check placed in this box, you can enter your notes via external 
musical keyboard. Use the mouse to click around your screen events, placing a 
different event into the Text Entry box, and modifying it via your keyboard. A 
second click on the MIDI Input box will return your screen to it't original 
mode, and disconnect the keyboard.  

The central Play button in the Midi Events box will bring up a separate dialog 
box giving you several different choices for Playback control, as will as  a view 
of what event is currently active.

A check in the Link to Cue box will allow you to Save your MIDI Event 
information as part of your Cue Sheet.

Lets look at the process in more detail:
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How to Use the Event Trigger
The starting point for creating an event trigger sequence is the Cue Sheet. You 
may want to prepare a Cue Sheet whose sole purpose is to provide timing 
points. This list will then be used as  MIDI Event Triggers. Or, you may want to 
work with a more general music Cue Sheet and modify it to interact with the 
MIDI Event trigger.    

For an example let's use Zarkov/1m2 once more, and create a few MIDI 
Events. The only difference between entering standard cue point descriptions 
and entering MIDI Event descriptions is that the text you type into the Input 
Window must be preceded by the number sign (#) and the number of the MIDI 
Event. Click on the cue point at s00:36:09 so that it appears in the Input 
Window and type #1 before the existing description.
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When you click on OK or hit the Enter key, that cue point will appear in the 
Cue Sheet with the words MIDI Event #1 typed in bold just above it.Let's 
enter a few more Event Triggers. Type #2 in front of the description of the 
cue point at s00:37:10, make the cue point at s00:40:15, MIDI event #3, and 
since the sound for the cue point at s00:48:22 will be the same sweeping sound 
as the event at s00:37:10, type #2 before the description so that CUE will play  
MIDI Event #2 for both cue points. This part of your Cue Sheet should now 
look like this:

We are now ready to work on the specific trigger designations for these cue 
points so select MIDI Events from the Reel World menu. The description for 
event #1 will be automatically selected when the window comes up.Type: laser 
whine into the highlighted text entry space at the bottom of the dialog box and 
click on the description for event #2 in the upper part of the window. The 
description for event #2 will now be selected for text entry and the words: laser 
whine will have been entered as the description of event #1.  Another way to 
enter an item in the MIDI Events window is to hit  the Tab key which will 
enter what you have typed and highlight the next box in line. (You could also 
have entered laser whine by hitting the Enter key, but this becomes an 
unnecessary keystroke if you are entering multiple items.) 
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Next, let's type in: laser sweep as the description of event #2 and: haystack 
rustle as the description for event #3.  

Return to the Cue Sheet by clicking on the close box in the leftmost portion of 
the title bar, and you will see that the MIDI Event descriptions which you 
entered are now a part of the Cue Sheet:
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We will not make specific suggestions for changing the other parameters in the 
MIDI Events window. You can click on, highlight, and alter each Channel, 
Note, and Duration entry. Within each MIDI Event, you can use the TAB 
key to move from one value to the next. Change several Event designations and 
values to get comfortable working with this window.

Note:  If you are not going to send information to all five Channels, entering a 
zero (0) for the Channel number will turn off that note and the ones below it.

The Shift Key - Making Blanket Entries 
If you want to modify all five MIDI Events, Channels, Notes or Levels of a 
particular Event at the same time, select any one of the five parameters under 
the column you wish to update, type the new information into the text entry 
space, hold down the Shift key and hit the Enter key. You will see the new 
number appear in all five places.  This will save you many keystrokes 
particularly when you are playing around with shifts of pitch and volume.

Proportional Changes
If you have entered a complex MIDI Event with different volumes and pitches 
and you want to shift them up or down but maintain the same relationships that 
you have already developed, you can do so. Select one of the five channels in the 
column you want to change and then type into the text entry space a plus or minus 
followed by a number. When you hold down the Shift key and hit the Enter 
key, the specific number you entered will be added or subtracted to all five 
parameters. If you are making a change in the Notes column, the number you 
enter represents half steps.

Hitting the Enter key without holding down the Shift key will modify the single 
entry you have highlighted without affecting the rest of the column.
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Entering Note Values With a MIDI Keyboard
If you want to use your MIDI keyboard to enter note values, there are three small 
steps involved. The first is to make sure that your MIDI keyboard is connected to 
CUE's Music Port. You can do this by clicking on the Reel World menu and 
selecting MIDI  Setup:

Click on Modem or Printer under Music Port, depending on where your 
cable is connected and then click on OK or hit the Enter key.

The second step is to click on whichever Note Name you wish to modify.

The third step is to click on MIDI Input at the bottom of the MIDI Event 
dialog box so that it is toggled on.  When you do so, Clear, Play and Link to 
Cue will disappear from the bottom of the dialog box until you turn the MIDI 
Input off.  (If you have not chosen a Note Name, CUE won't allow you to turn 
on the MIDI Input). Since the scroll bar will also vanish, be sure you have the 
MIDI Events you wish to work on totally visible on the screen.  

At this point, whatever note you hit on your keyboard will appear both in the text 
entry box and in the location you selected in the Notes column. This action will 
also enter the corresponding volume level for the note you just played. (When 
you are using a keyboard as your entry device it is not necessary to hit the Enter 
key to place a Note Name into the MIDI Event window).

If you hold down the Shift key while you are playing a single note on your 
keyboard, that note and it't volume level will be placed in the selected Note 
Name and Level locations and the Note Name directly below them will be 
selected.

When a note is played on your master keyboard, CUE will send it back out on 
the listed channel so you can hear it being played by the instrument it was 
intended for.  
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Entering Chords

When you hold down the Shift key and play up to five notes on the keyboard, 
they will be entered sequentially into the Note Name column. If you have 
selected one of the last four Note Names possible within a particular MIDI 
Event and play more notes then you have room for, CUE will wrap around and 
overwrite the starting Note Name in that MIDI Event. 

Copying & Pasting Events
At the far left of the MIDI Event window is a column where the different 
MIDI Events are numbered. If you click on a  specific event number to 
highlight and select it, and type Command-C (or select Copy from the Edit 
menu), you will Copy all the data concerning that particular MIDI Event.  
Selecting the number of the MIDI Event you want to Paste it into and typing 
Command-V (or select Paste from the Edit menu), will create an exact 
duplicate. This is useful if you want to have two events that are the same in all 
respects except for a few minor differences.  

You will find it easier to copy, paste and make changes than to enter all the 
information from scratch.

Link to Cue - How to Save Your MIDI Events
It is necessary for Link to Cue to be toggled "on" in order for you to save your 
MIDI Event information. If that has been done, then when you save the Cue 
Sheet, you will also save the MIDI Event information along with it.  

WARNING NOTE:  Although Link to Cue toggles "on" automatically with 
your first entry in the MIDI Event window, it is a good idea to be sure that it is 
on before you save the Cue Sheet because if you have inadvertently toggled it 
off, the MIDI Event information will not get saved and when you close this cue 
all your work will be lost.

Link to Cue exists because the MIDI Event Trigger takes up a sizeable 
quantity of disk space; nearly as much as the whole rest of the Cue Sheet. Since 
the MIDI Event Trigger is a specialized use of CUE, there is no point to 
automatically allocating such a large amount of disk space unless you are actually 
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going to use it. With the Link to Cue feature, CUE won't use this extra disk 
space unless you tell it to do so by making an entry into the Event Trigger or 
by toggling on Link to Cue manually.  This permit't you to fit the maximum 
amount of cues possible on to a single disk.

Checking the Music and Sync Port 
setups
If you have not already checked, make sure that you have the Music Port and 
Sync Port set correctly. Typing Command ] (right bracket key ]) will toggle 
the Sync Port between Printer and Modem. Command [ (left bracket key [) 
will toggle the Music Port in the same manner. A reminder of these keystrokes 
can be found in the MISC menu. 
A long way to accomplish this operation is to select the Reel World menu and 
click on MIDI Setup.  Set up your ports according to how your equipment is 
connected, click on OK or hit the Enter key.Now that you have assured a clear 
path to the sampler containing the sound effects you wish to trigger, you are 
ready to play the sequence.  

Throughout CUE's many windows and dialog boxes, there are buttons for 
toggling the Music and/or Sync Port selections. Its almost Playback time. Do 
YOU know where your Port Setups are (connected to)?

Auditioning a MIDI Event
To hear a brief Audition of a specific MIDI Event from the MIDI Events 
window, select (click and highlight) the MIDI Event number which appears to 
the left of the event you wish to hear, and below the # column in the display.  
Once the number is highlighted, hold down the Shift key and hit the Play 
button. The selected MIDI Event will play for it't listed duration, or until you 
click the mouse again, whichever comes first.
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Playing the MIDI Events Sequence 
By hitting the Play button at the bottom of the MIDI Event window the Play 
MIDI Events dialog box will appear:

Note:  While this may seem obvious, remember that if you have not selected cue 
points to be specific MIDI Events, nothing will happen when you click on the 
Play MIDI Events function buttons of this window.

Start and Stop do exactly what they say, and Exit removes this dialog box from 
the screen.  If you Exit from this box while events are playing, they will keep on 
going, even if you continue to edit other cue points. You can Stop events by 
returning to the Play Events Dialog box (hitting the Play button again) and 
hitting Stop, selecting Stop Playback in the Misc menu, or simply typing 
Command  Return (command key and return key).

Cont (continue) allows you to play the MIDI Event Sequence from a place 
other than the beginning of the cue.  This is where the use of the two opposite 
facing arrows comes in.  Clicking on the arrow facing to the right will let you 
move forward through the sequence of MIDI Events in the same order that you 
have arranged for them to appear in the Cue Sheet.  Clicking on the left facing 
arrow will have the opposite effect, allowing you to step backwards through the 
MIDI Events until you return to the first event in the sequence.  The left and 
right arrows found on Macintosh keyboards duplicate the function of these on-
screen arrows, saving both time and excessive clicking.  Holding one of the Mac 
arrows down will keep CUE scrolling through your MIDI Events.
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If you choose to stop in the middle of a MIDI Event playback, hitting Cont will 
start the playback again from that point. When you scroll to the particular MIDI 
Event that you would like to begin listening from, clicking on the Cont button 
will start the sequence from that point, whether or not you had clicked on Start 
before.  

If you are working with a large MIDI Events list, there is a quick way for you 
to reach a specific event without having to click through them one at a time. 
Typing any digit from 1 through  9 will move you forward from where you are 
in the Event list  by that amount.  If you type a Command 1 through  9, CUE 
will move you back by that amount in your Event list.

The Panic button shuts off any sustaining sounds. If you have sounds that for any 
reason sustain too long, you can terminate them by clicking here. However, the 
Panic button does not stop the sequence from continuing to run.  

The Panic button can be used to your advantage if you are punching in. You can 
click the Panic button until you come to the MIDI Event that will be the first 
sound.  This will allow you to keep any extraneous sounds from being recorded 
in case you have been punched in early.

Right in the center of the Playback box is the Next line.This will list the title 
(or number) of the next MIDI Event to be played. As soon as that event is 
played the next upcoming event will be listed.

When you click on the Start button, a time counter will begin rolling above the 
Next line.  This will display either Absolute or Relative time depending on 
what has been set in the Operations menu. The Title Bar of the Input window 
will always display the current time mode.  Remember that you can toggle 
between Absolute and Relative time with Command A. When you are in the 
MIDI Event Dialog box, you need only type an A to change Time Formats.
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Edit allows you to change all MIDI Event parameters of the particular cue 
point displayed in the Next line of the Play MIDI Events window, without 
having to return to either the MIDI Event dialog window or the Cue Sheet. 
When you click on this button, the following will appear (if you are stopped, for 
example,  on our  MIDI event #2 of Zarkov/1m2):

Any changes you make in this Edit dialog box will be reflected in the MIDI 
Event dialog box  and the Cue Sheet window once you click on the OK button. 
If you don't want the changes you have made in the Edit dialog to show up, then 
click on the Cancel button. In both cases, after you click on OK or Cancel, you 
will be returned to the Play MIDI Events window.  

Locking MIDI Events to SMPTE
In order to lock your MIDI Event sequence to a SMPTE input, type the letter E 
on the keyboard. Should you not have set your MIDI port you can do so in this 
dialog box by typing a left bracket ([) for the Music Port or the right bracket 
(]) for the Sync Port.  You do not have to hold down the Command key in this 
dialog box. If you have any question about what you need to hook up, refer to the 
section entitled, Locking to Picture (page 194). It will be clear that you have 
successfully set the MIDI Events to lock to SMPTE, because there will be new 
information displayed in the dialog box:
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Hitting the plus (or "=") key or the minus key will adjust the Bit Offset by 
increments of 20 bit't in either direction.

Clicking on the Start button and rolling your SMPTE master will enable CUE to 
lock up. The circle to the left of the word Lock will light up when SMPTE 
Lock takes place.  Just as in the Playback window, you can roll back and forth 
within your SMPTE sequence and CUE will follow. The sequence will not shut 
down until you hit the Stop button or run the SMPTE to a point that is later than 
the last MIDI Event which you have listed.  If it is useful for you to stay locked 
up, you might want to enter a  MIDI Event that is a good deal later than the last 
one you are concerned with. This will give you some leeway when you reach the 
end of your sequence so that it wont shut off.  Remember, of course, to remove 
this extra event when you wish to return to your original time indications.
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Tapping  Out a Click  -  True Digital  

Programming
For those times when you you have to match the specific cue points to an existing 
piece of music, or place sound events right with some images that do not sync up 
to a standard metronome setting, CUE provides you with the ability to tap out a 
custom click track on the Macintosh keyboard.  

Although it is possible to enter your cue points after tapping out a click, loading 
an existing Cue Sheet into CUE first will probably be more practical.  After a 
template cue has been loaded, click on the Reel World menu and select Click 
Tap.You will be presented with the following:

The keyboard in your window is there for inspiration, it is not operative. Your 
actual Mac keyboard is what you will use to tap out your click. CUE permit't 
you to create a click that has unaccented warning clicks and differentiated bars 
that start with an accented downbeat. The specialized keys which let you do this 
are C, D  and S described below.

Before we begin, let's set the Average over. . .beats buttons at the bottom of 
the window. This allows you to adjust how closely the Click Tap will follow 
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you. If you want every nuance of your custom clicking to be followed then click 
on the button next to 1.  Remember however, that the human tap machine (us) 
tends to be rather "inconsistant" in comparison to computer clickers.  

Should you want CUE to average out some minor inconsistancies in your 
tapping, you can specify whether you want this averaging to be done over every 
2, 4 or 8 beats. The Average over. . .beats buttons remain "live" during your 
Click Tap recording, so you can set your average for 8 beats during a section 
which needs to have a constant tempo, and change it to 1 or 2 in those sections 
which need more careful variation. The easiest way to make these live changes is 
to simply type a 1, 2, 4, or 8 from your keyboard.The change will take place at 
the end of the current active average period.

Even with Averaging, tempo changes in your Cue Sheet may occur after 
almost every beat when you are using Click Tap, and the size of the cue may 
become unmanageable.  This can be remedied by clicking on the Operations 
menu, selecting Set Formats, and releasing the mouse on Cue Sheet Formats 
in the sub-menu. Or you can move directly to this window by typing Command 
Opt-F.  You will find the following selection available to you in the Set Cue 
Sheet Formats Window:

Clicking on the Beginning and End Only circle, will constrain tempo change 
indications to the first and last created ones only.

To commence the Click Tap process, click on the Ready button. In the upper 
part of the screen you will see that the word RECORDING has appeared along 
with BAR and BEAT. This does not mean that the recording of the click has 
started, but merely that the dialog box is in readiness waiting for the next key 
stroke to actually begin.

Note:  Once you have clicked on Ready, you will not be able to leave this 
window until you hit the S key to stop the proceedings.

It is not necessary for you to tap a countoff (with the C key), but it is necessary 
for you to use the D key to tap down beats and the S  key to stop your click.
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After the Ready button has been clicked "on", tap the C key for as many 
countoff beats as you want to preface your cue.  Then tap on the D key for down 
beats of each measure you construct, and any other key on the keyboard for the 
remaining beats of each measure.  You are not locked into any preset meter when 
you use Click-Tap feature, so typing a D key for downbeats can change your 
meter at will.  All meter and tempo changes will be reflected in the Cue Sheet.  
When you are done tapping, hit the S key to send a stop message. The S key must 
be tapped in rhythm.

If you tap out less measures then the length of the cue you have described in the 
Cue Sheet, CUE will take the last Tempo you tapped and carry that through to 
the end of the cue.  To see what your new Tempo looks like in the Cue Sheet, 
click on the close box at the far left of the Click Tap title bar (or type 
Command-U).

Read Sync Box

If you have a Garfield Time Commander, CUE can import it's SysEx tempo 
information and enter it into the Cue Sheet tempo map. Check the button labeled 
Read Sync Box.  If the Time Commander is tracking live to an audible click in 
"record Mode," it will send tempo information to your Click Tap in Ready 
mode.

Calculate Tempo from MIDI Clock
Suppose, while watching a scene in your project, you had your trusty Drum 
Machine going, and found just the perfect set of tempos for the visual material. 
Can you log those tempos into CUE for your Cue Sheet  or MIDI Events?  
Well. . .

 
When you place a check in the Calculate Tempo from MIDI Clock box, The 
Click Tap feature will determine the tempo for your present cue according to 
the tempo you have set on an external MIDI device like a drum machine or 
synthesizer sequencer. When you have checked the box, click on Ready, and the 
Click Tap feature goes into Record - Beat and wait't for an input.

Type S from your computer keyboard to exit this function.
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Click-tapping with a MIDI Keyboard     

You don't like to tap your fingers to the music on a computer keyboard? In that 
case, connect your MIDI keyboard up to the Music Port (check to see that you 
are in the properly selected Printer or Modem input from your MIDI interface). 
Playing a D above middle C will record a downbeat, just like typing D on the 
Mac. Playing middle C will record a beat other than the down beat.  Now you 
can tap to the action, but it will still be necessary to type an S on the Mac 
keyboard (in rhythm) to stop your recording.

Locking Your Tap to SMPTE
Make sure that your MIDI Time Code box is connected to the Sync port that you 
have set using the MIDI Setup dialog box from the Reel World menu.Then 
lock CUE to SMPTE by either clicking on the Reel World menu and selecting 
Lock to Time Code, or typing Command-E.

If you have done this correctly, you will see (Lock to Time Code) appear in 
the title bar when you return to the Click Tap window. Next, hit the ready 
button, turn on the video and wait for the place in the picture where the first beat 
will occur. When SMPTE lock has been achieved the Lock light next to the word 
"recording" will turn on. At the appropriate point begin with the first down beat. 
Do not worry about your Countoff. You can set that later by going to the 
Operations menu and selecting Set Count Off (or typing Command-W).
 
When locking to code with the Click Tap procedure, CUE calculates the 
difference  between the Running Time you have set in your Cue Sheet Setup, 
and the first of your D(downbeat) taps.  It then enters this time difference as 
Offset into the Cue Sheet.

In order to check your Click against the picture, lock CUE to SMPTE and listen 
to the Click out. (see page 194)

Editing Your Hand-Tapped Click
You can edit this new set of hand tapped tempos and meters in the same way you 
do other tempos and meters in your Cue Sheet. Select the Set Meter or Set 
Tempo dialog boxes and enter the modifications you need (see pages 147 and 
112).
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Downbeat Mode - 
Remetering by Click Tap:

Downbeat Mode  enables you to easily and quickly change the meters of 
your cue to put certain hits on the downbeat of a bar. You can listen to 
your click in Playback mode, and just tap where you want downbeats to 
occur.

To get to Downbeat mode , go to the playback window and start 
playback. Then open Click Tap  and hit Ready. The click is already going, 
and just tap D where you want downbeats and S to stop. CUE will adjust 
the meter map accordingly.  CUE will never make a meter longer than the 
initial one.  This allows you to only tap where you want the meter to 
change. As an example, if you start out in 4/4 and tap on the 16th beat (15 
beats from the start) you will have 3 bars of 4/4 and one bar of 3/4.  You 
can see the changes by going to the Cue Sheet or Clicks windows.

SMPTE Generation
 
CUE will act as a commandler for certain SMPTE generating devices such as the 
Opcode Timecode Machine, Studio 3, Garfield Time Commander and the 
Southworth JamBox/4.

You can select the type of SMPTE you wish to have generated by setting choosing 
the proper format in the Absolute time column of the Set Time Format box 
(in the Operations-Set Formats menu, or just type Command-F. It is not 
necessary for the SMPTE button to be toggled on. You could be working in 
feet/frames or any other format and not have to switch.  Clicking on the specific 
type of SMPTE will be enough for CUE to know what to do.

Once you have picked the SMPTE type and clicked on OK or hit the Enter key,  
Select Generate SMPTE from the Reel World menu. If you have not yet 
selected MIDI  Setup, the MIDI Setup dialog box will open automatically.  
Make sure the correct sync port and SMPTE generator are chosen and click on 
OK (or hit the Enter key).  When you have done so, the Generate SMPTE 
dialog box will open.
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If you have a cue open, CUE will automatically give you a fifteen second Pre-
Roll and place the time of the first beat into the text boxes labeled Music Start. 
The small box is for the SMPTE hour and the larger box is for the rest of the 
SMPTE number. (It is set up the same way as entering Running Time).  You 
are of course free to modify any of the entries.  Should you shorten the amount 
of Pre-Roll, the new number you have entered will continue to appear until you 
modify it again or close the program. The Pre-Roll can be set as a default.

The Generate,  Stop and Exit buttons are self-explanatory with one exception. 
Hitting the Exit button will not turn off the SMPTE generator. You can leave 
dialog via Exit, and even quit the program, the SMPTE generator will keep 
going. In case you are striping an entire reel, this feature will not tie up the rest 
of your computer. You will be able to continue on with other work. When you 
have exited the dialog box but stayed in the program, you can turn off the 
SMPTE generator by returning to the dialog box and hitting the Stop button. 
Should you have exited the program, when you return to the Generate SMPTE 
dialog box, you will have to hit the Generate button first in order to activate the 
Stop button which you can then hit to turn off the generator.

Generate: Multi 
As you progress down the Reel World menu, you will see the Generate: 
Multi title.  In the Real World, we need to put SMPTE stripes on our analog (or 
digital) tapes to lock our audio-video playback, and to begin clicks and/or 
electronic sequencers. This is necessary but boring work best done before the 
recording session if possible. Here is the feature to help you with that task.  
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Through this feature you can generate the SMPTE starts and stops for your entire 
set of cues.  If you have not yet compiled your Master Cue List, Performing 
Rights Cue Sheet, or Spotting Notes, this heading will be shown in grey 
print, and will not be operational. After you have created one of these 
compilations however, CUE will take this combined information and through the 
now darkened Generate: Multi feature construct a single complete time-lock 
track for all cues.  When you now select Generate: Multi, the following dialog 
box will appear:

Well actually, the FIRST time you click on Generate: Multi you will find the 
MIDI Setup dialog box in your screen first:

Select the SMPTE Generator you are working with from one of the three 
possibilities provided here, and click on OK.  THEN the Generate: Multi 
dialog will appear with text boxes for Tape Length, Pre-Roll, Post-Roll, and 
Silence Between Cues.  Once these guidelines have been set, Generate: 
Multi will stripe the whole tape based on the starts and stops of the cues in the 
Master Cue List.

The first box, entitled Tape Length, allows you to enter the total recording time 
available on your external recording tape.  The default time (30 minutes) is fairly 
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standard for a 10 1/2 inch roll of analog recording tape moving at 15 inches per 
second.  You can type in any number you would like here, of course.  CUE will 
calculate  how many cues it can stripe on one tape, and stop after the last 
complete cue it can put on one tape.  A gentle BEEP will tell you to change reels, 
and the Stop button will change to the Cont (continue) button.  It will wait for 
you to change tapes and hit the Cont button, before continuing on with the 
striping procedure.

The Pre-Roll box allows you to set a standardized number of seconds before 
each Cue's actual start time. A default time of 15 seconds should be enough to get 
your synchronizer to lock picture and sound. If not, enter a larger number.With 
electronic synchronization only (MTC), you may not need 15 seconds, and can 
designate a smaller number in this box.

The Post-Roll is set to determine how long you want time code to extend past 
the end of the cue.  It will then move on to the final entry box, Silence 
Between Cues, enter that quantity of silence, and move on to the next cue.  

Generate: Multi is multitasking.  You can leave it's dialog box and it will 
continue operating.  When it is time to change the external tape you are 
recording to, CUE will present you with a dialog box to do so.  In fact, if you 
are in multi-finder, and working with an entirely different program, it will still 
present you with it't Change Reel Dialog box. 

If the Session Number in the Master Cue list window was set to 1 - 9, and 
was selected when you last created a ProductionSearch, Generate: Multi will 
only stripe cues from that session. Any other number entered into the Session 
Number box will cause all cues to be striped.

Generate: Multi will only stripe cues with the requested Production Number as 
well.   If a Prod.# search was done in the Master Cue List, Perf. Rights, or 
Spotting Notes window, Generate: Multi will stripe only those cues with the 
same production number.
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MIDI Files
You can Save your Cue Sheet information as a MIDI File. This is a new file 
format developed by Dave Oppenheim of Opcode. It allows all manner of 
different programs to save MIDI information in a common file format.

One of the key reasons to save your Cue Sheet as a MIDI File is that this file 
can be read by a sequencer. This means that before you even start working on 
your sequence you will have a template in place that contains all your Meter and 
Tempo changes. In addition, CUE will also make it't MIDI Events List, and 
cue point descriptions (if there is one) part of your sequence. 

How to Save MIDI Files
You can Save your cue as MIDI File by selecting Export from the File menu, 
and sliding the mouse down the sub menu, to the heading Export Cue as MIDI 
fi le.   The following dialog box will appear:

The four checkable selections in this box allow you to export information you 
would like to have show up in your MIDI (sequencer) files. The checked 
Tempo/Meter map will always be a part of the MIDI file, so to save your time, 
we have permanently checked this box for you.  Tempo and Meter information 
will now be built right in to your sequencer tracks.  
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When you check the Cue Points heading, you will be able to select All Cue 
Points, Key Hit't, or Cuts for addition to this Saved file.The Cue Points 
descriptions are saved as Marker events in the MIDI File's Meter Track. In 
this way they can be viewed in the editing window for any sequencer track in 
Vision and most other Mac professional sequencing software packages.

If you have constructed a MIDI Events list, and check the MIDI Events box 
here, your Events will get their own track in your sequencer file.
A check in the Copyright box will put the symbol, followed by the year, 
composer, publisher, and the composer's rights affiliation into a track named 
"Legal Stuff".

When you are happy with the choices you have made, click on OK (or you can 
hit Cancel at any time). You will get a standard Save File box with the default 
file name alreayentered into the proper dialog area. 

 
The letters .MF will be added to the end to signify Midi File.  At this time, you 
can Save, or hit Cancel to return to your cue. When you save your default cue 
title as a MIDI File, it will turn up with an icon that looks like this:

 
Or, you can give it your own name:

You will have saved a MIDI File that is separate from your Cue Sheet.

Before you dump this MIDI File into another program, make sure what version 
of MIDI File the software accepts. When MIDI Files were first implemented 
they had a different form that is incompatible with the current version. CUE 
writes Version 1.0 MIDI Files.

224



Importing MIDI Files
A click on the Import MIDI File from the Import sub-menu will bring 
up the following dialog box: 

Two check boxes allow you to choose the type of MIDI file you wish to 
import:  Music or Tempos/Meters/Offset . This feature opens a Format 
0 Standard MIDI File created by a sequencer, for use with the MIDI File 
Playback feature.
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How to Copy and Paste MIDI Files
When you click on the Edit menu, and select: Copy MIDI File to Clipboard, 
CUE will create a Midi File.  But,  instead of saving it to disk, this MIDI File 
will exist only on the Clipboard. If you have a sequencer capable of cutting and 
pasting MIDI Files, or simply want to copy your tempo and meter map to 
another cue in CUE, you can clip a Midi file onto your Clipboard, pick a 
sequence (or another cue),  and Paste.

Lets make a short example. We've doctored Zarkov/1m2 up a little bit to keep the 
studio musicians awake during the latter half of the cue.  Several tempo and 
meter changes have been added to the original. 

The changes worked so well, we decided to try this lovely section in 
Zarkov/2m1 also: By selecting Copy MIDI File to Clipboard, the Tempo, 
Meter, and Running Time were copied to the clipboard. A Paste MIDI File 
sent these features (minus the individual cue points and descriptions) to 
Zarkov/2m1 for a second try.
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Conversions Window
The Conversions window is provided as a means to let you convert a Tempo 
or  Time into all possible formats without having to make changes to the Cue 
Sheet. It also enables you to select a Tempo  and see the length in milliseconds 
of any given note value from a 32nd note triplet to a whole note.

One of the uses of this window is in setting digital delays. The Conversion 
window takes the guesswork or calculation time out of deriving a delay setting in 
milliseconds for a any musical equivalent you wish to hit at a given Tempo.

This window will also be of use to you is if you are cutting up music to fit edits 
in the film.

Access the Conversions window by clicking on the Windows menu and 
selecting Conversions, or typing Command Opt-C.  

227



To use the Tempo side of this window, click on whichever Tempo format you 
wish to enter and then key in the Tempo you wish to examine into the text boxes 
provided at the top of the window. When you do this and click on OK, you will 
see that every other Tempo format has the corresponding Tempo displayed 
beneath it in italics.

Since there will be minor variations in note lengths depending on Tempo format, 
any time you click on another format, you may see a slight adjustment in note 
lengths and Tempos in the other formats. You do not have to click on OK for 
these adjustments to be made. This slight shifting will be most evident when you 
click on Beats per Minute after having entered one of the other formats.  

For example if you have made a 24 frame entry of 11-1 , and then click on 
Beats per Minute, you will see that the 24 frame time has been changed to 
11-13 since that is the closest a Beat per Minute tempo can come to the 11-1  
you originally entered.  As a result of this recalculation, the note durations will 
have shifted a bit as well.

Using the Time side of the Conversion  window is simply a matter of entering 
the time you wish to see converted into all the other formats. You can type in 
unit't of time, SMPTE or feet/frames. As soon as you click on OK, you will see 
that number converted into all the different formats.

It is also possible to add and subtract time in this window by typing the plus (or 
=) key, or the minus key followed by a time quantity. This turns the Conversion 
window into a time calculator.

As you work with different conversion possibilities, it will help to hear the click 
tempos you are requesting.  Holding down the Shift key, and clicking on the 
TEMPO OK button will start and stop an audible click. Once you have started 
an audible click, you can change conversion tempos, but the audible click will 
continue unchanged. Stop the click with Shift-OK). and then start the click 
again,It will take the newly entered tempo.

The Enter key on your Macintosh keyboard will function like a Click on 
whichever OK button your blinking cursor is closest to.
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10 Mac II Supplement
Cue provides several substantial features for the Macintosh 2 family of 
computers. Peripheral slots for color display as well as for video genlock give 
Mac 2 owners substantial choices for color monitoring, superimposing colored 
streamers, punches, and CUE graphics on to NTSC video displays.  

The color version of CUE available from Opcode, has the following additions to 
CUE 3.0.

Color Monitors and Genlock Boards
If you have a Mac II,  the  Set Streamer Colors dialog box will work the 
same way except that you will see the actual colors instead of having to select 
from a list of the color names. In addition, you have the option of being able to 
pick streamer colors from the full Mac II palette for CUE's internal streamers 
or when employing a genlock board to superimpose the actual Mac II image 
onto your video monitor.  
        
Superimposition of color streamers over your video involves buying a genlock 
board for your Mac II. This will allow you to actually place the Mac screen 
streamer animation over the video image. Genlock boards can be had for less 
money than the Tesla Streamer Box, but the truth of the matter is that the 
Tesla's animation is far superior to that which the Mac 2 version of CUE is 
capable of producing.

Color for Search Tempos
Search Tempos in the Operations menu, lists it't results in three columns. The 
first column shows the number of cue points caught in green.The second column 
shows the number of near misses in amber and the third shows the number of out 
and out misses in red. When you "zoom in" on a tempo, the cue points are also 
listed in the green, amber or red.

229



Key Hit Displays
The Key Hit checkmarks found in your Cue Sheet are displayed in the color of 
their streamer type. Default streamers will be in black, and if a streamer color is 
too light to show up on a white background, it will be shown in an outline font.

Title Page Color
The Title Page will work with color artwork. Unfortunately, you will need a 
pretty expensive printer, and a high-quality graphics application to make full use 
of this feature.  CUE may be slightly ahead of it't time.

The Reel World Menu Additions
The Playback Window has many color options for those Mac owners with a 
color monitor. Your streamer colors are determined by the streamer types set in 
the pop-up menu which appears when you click on the Default Streamers 
button in the  Input Window. The colors assigned to the different streamer 
types are set in the Set Colors dialog box (Reel World Menu).

If the Computer Friends genlock is activated, the background color of your 
display becomes the chromakey (invisible) color, and everything else on the 
screen gets superimposed over an incoming NTSC video signal. 

Color Playback Display
This dialog lets you choose what gets displayed in the Playback Window and 
what doesn't. If the only thing being displayed is the Time Counter then it will be 
shown twice as large. The settings for Playback Display are saved as defaults.

MIDI File Playback
If the genlock is active, typing "R" while in MIDI File Playback hides all of the 
Mac Video, so only the live video is visible. Typing "R" again puts things back 
the way they were.
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Set Colors
This dialog lets you pick the colors for each streamer type, and for text and text 
backgrounds in the Playback Window.If you are using the Mac II to genlock the 
streamers, click on the Mac II button. If you are using the Tesla box, click on 
Streamer Box. Clicking on one of the streamer type buttons opens up a 256 color 
palette (8 colors if you are using the Tesla). Click on one of the colors and hit 
OK. If none of the colors is to your liking, click on one then hit the change 
button. This opens up Apple's Color Picker dialog so you can set the streamer to 
any one of 16, 777, 213 colors give or take a decimal place.

The Text button lets you pick the color of the text and sweep clock. The Text 
Background sets the color of rectangles that are painted behind each object in the 
Playback Window so that they will show up better when genlocked over video. 
If you don't want a background, set the background to the same color as the 
chromakey color, which is marked with an X in the palette.

If the Chromakey Cue Sheet button is checked, the Cue Sheet will be painted 
the same color as the Playback window, and it't text will be the same color as the 
text in the Playback Window. This lets you genlock the Cue Sheet over the 
video. To make this work you should have a genlock board with an RGB output. 
Computer Friends makes one. You will probably also want to use a large font. 
With the right equipment, you would be able to take timings of the same screen 
that you are typing them into. With the Scroll Cue Sheet During Play 
option set (MISC Menu), you can have cue points scrolling in front of the video 
as they go by. 

The settings for Set Colors are saved as defaults.

Set Palette
Set Palette opens a palette dialog like the one in Set Colors that lets you change 
the palette without reassigning the streamer colors. These settings are saved as 
defaults.

Color Bars
This draws a set of color bars so you can adjust your NTSC monitor if you are 
using the genlock.
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Hints For The Misc Menu:

Genlock On/Off

If you have the Computer Friends T.V. Producer connected to your system, this 
toggles the genlock on and off. It can also be selected with Command Opt-V

Enlarge Playback Window

This toggles the Playback Window between it't normal size and a size big enough 
to fill an NTSC monitor. It can also be selected with  Command Opt-E.
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11 Helpful Hints
Some of the following hints are excerpted from earlier parts of the manual.  
Others appear here for the first time.

Learning a few Cue Sheet Conventions

If you are new the world of Music Editorhood it will be useful for you to learn a 
few of the conventions used in putting Cue Sheets together:

Dialog is capitalized.

Capitalize the word in your description that occurs right at the timing point you 
have noted: 
              (The window SHATTERS.  Joe ran across the room and SLIPPED.)

Film and Video Abbreviations:
BG Background INT Interior
CU Close Up LS Long Shot
DIAL: Dialog MS Medium Shot
EL End of Line (of dialog) NARR: Narrator
EXT Exterior O.C. Off Camera
FG Foreground O.S. Off Stage
FS Full Shot POV Point of 
View

Slipping a Cue into Place with Offset
Being able to enter an Offset of measures and/or beats can be helpful if you are 
trying to change Tempo in the middle of a cue. Say you have a starting Tempo 
of 11-5 that catches all your beats up through bar 23, beat 4, and you want an 
imperceptible Tempo change that will hit everything after that.  You might 
search the Tempos 11-4 to 11-6 with an Offset of m23b4 (measure 23 beat 4). 
Only the hit't that come on or after bar 23 beat 4 would thus be included in the 
search. The bar and beat format takes into account any earlier tempo and meter 
changes you have already placed into the Cue Sheet, so if you find a new 
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Tempo for this next section of the cue, you can enter it knowing it will work 
with what you have previously entered.

 If there is some obscure bit of arithmetic you need that CUE does not do, you 
can use a desk accessory calculator and then Copy and Paste the result into the 
Input window or wherever you need it.
  
 If you want to print a lot of cues, it is best to go to the Finder, select the icons 
of all the cues you want to print, choose Print from the File menu, answer all 
the appropriate dialogs that will appear and go eat lunch. The Imagewriter is not 
known for setting speed records.  

Key Equivalents and Desktop Shortcuts
 Instead of using the mouse to select items from the menus, you can use key 
equivalents.  (This means holding down the Command key and typing a single 
keystroke.) Almost all the key equivalents can be found in the menus to the right 
of the menu items they represent. For easy reference you can consult the menu 
map that appears at the front of the manual.

Command "," toggles the Click Window and Score Page between time and 
beats within a given measure.

Another key equivalent provides an alternate method of changing Versions. 
Holding down the Command key and typing either "+" (or "=") moves you 
forward through the Versions, while holding down Command and typing "-" 
will move you in the other direction. If you are not sure what Version you have 
moved to, click on the Version menu to check your progress. 

Double-clicking on a Score icon in the Finder will load CUE as well as open 
that particular score setup. The Score icon looks like this:

If you have cues in a film that do not get used in their entirety because of one 
editing decision or another, you can make their actual length be reflected 
accurately in the Performing Rights Cue Sheet by placing a Reverse Slash 
(page 77) in your Cue Sheet at the point where the music was cut.  This will 

234



make that cue point the end time of the cue and thus your Performing Rights 
Cue Sheet will list the correct amount of music.

When you want to start timing from a cue point other than zero, click twice on 
that cue point to place it into the Input Window. When you start the Stop 
Watch it will begin timing from this point.  After you stop the watch,  the new 
time will be displayed and you can tab into the Description field thus selecting 
the old description which will be replaced by the next thing you type.

If you print your Score Paper out sideways, don't tear the individual sheets 
apart when you remove them from the printer. By taping the left edge of the first 
page to the last page, you will have an easy to use book.

A number of shortcut keystroke combinations that provide alternatives to using 
the mouse can be found under the MISC menu.
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12 MIDI File Playback
MIDI File Playback allows you to to take a MIDI File recorded in a 
sequencer such as Opcode's Vision, and play it back using the Tempos and 
Meters calculated by CUE.

Not only will CUE play back the music, but it will also play an audible click, 
either through the Mac speaker or over MIDI (see Playing the Click Track), 
and trigger an external streamer box such as the Tesla if you have set things up 
correctly (see Playing Streamers and Punches).

It will display both a bar/beat counter and a time counter whose format is based 
on the Set Time Formats and the Command A (Enter Absolute Time) 
settings.

To use this feature you must have in your possession an authentic Format 0 
(single-track, multiple channel) MIDI File. All the major Macintosh sequencers 
are writing them these days. Choose Import MIDI File from the Import sub-
menu under the File menu, and when the first dialog appears, make sure that the 
Music checkbox contains an X (See Import MIDI File).
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Open the cue containing the Tempos and Meters you want to use, then choose 
MIDI File Playback from the Reel World menu. You will be presented with 
this dialog:

You've seen all these controls before. Start (or the Space Bar) begins playback 
from the countoff, Stop (or the Return key) stops it, and Cont (or the Tab key) 
picks up where you Stopped. Exit (or the Esc key on extended keyboards) 
Stops playback then leaves the dialog box.

You can also pick the Continue point by clicking on the bar number. Clicking on 
the upper half will increment it, and clicking on the lower half will decrement it. 
Holding down the mouse button will make the increment/decrement continuous 
(and quite brisk).
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Playback Markers

As with the Playback window, up to eight markers lettered A through H can be 
set up. First set the bar number by clicking on it or playing and stopping at the 
right place. Next click on the Mark button. You will see this dialog:

Clicking on the upper half of the A will increment through the marker letters and 
clicking on the bottom half will decrement. Click on OK when you reach the 
marker you want to set.

To use a marker, choose one from the Set Locate pop-up. The marker's letter 
will appear in the Locate button just to the right.

Sustaining Note Cutoff

Use the Panic button when your whole world is falling apart and you can't cope. 
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It won't help, but it will cut off any sustaining notes.

MIDI File Playback Locked to Time Code

This all locks up to MIDI Time Code in the same way that the Playback and 
MIDI Events windows do. First make sure that your equipment is connected 
correctly and that the MIDI Ports are assigned. The Sync Port should be 
connected to the MIDI Time Code device and the Streamer box. The Music 
port should be connected to your synthesizers and MIDI Click source, if any 
(see Locking to Picture - MIDI Time Code). CUE should be in Lock to 
Time Code mode (Command E, Misc menu, or Options in the Reel World 
menu).

If you enter MIDI File Playback before making these settings, you can make 
them quickly from within the dialog. "[" will toggle the Music Port between 
Modem and Printer, "]" will do the same for the Sync Port, and "E" will turn 
Lock to Code on and off.

When you are set to Lock to Code, the MIDI File Playback dialog will look 
like this:
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Now, when you hit Start, and run your tape, CUE will find its place, and play in 
sync with the tape. It will stop when it receives a Time Code number past the 
end of the cue.

Channelizing

There has been much debate over whether this ancient mystical technique is a 
hoax or not, although several CUE users have reported making contact with the 
King himself. Although you may not have this kind of luck with the Channelize 
button, it will allow you to alter the Playback file in several ways. When you 
click on it, here is what you see:

From this dialog you can reroute any channel to any other channel (note Channel 
2), transpose any channel up or down one octave (note Channel 1), mute any 
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channel, and non-exclusively solo any channel(s). You can also rename channels.

To change channel or octave numbers, just click in the appropriate column next 
to the desired channel. Clicking on the upper half of the number increments it, 
and clicking on the lower half decrements it.

To mute or solo any channel, just click in the appropriate column to the right of 
the desired channel. A little dot appears when the channel is muted or soloed. 
Clicking on it a second time puts things back to normal. You can solo as many 
channels as you want (up to 16, of course).

Naming Channels

You might want give more meaningful names to your MIDI channels, such as the 
synthesizers or sounds that they are playing on.

Select a channel by clicking anywhere on its line. The small dot on its left will 
change into a ">" when it is selected. When you start typing, the old channel 
name will be replaced by your typing. The new name will be in Italics until you 
accept it by hitting the Return key. The standard Macintosh editing techniques do 
not apply here. While the name is still in Italics, you can use the Backspace 
(Delete) key to remove characters one at a time, or you can hit Return and start 
all over.

When you are done, hit OK (or Enter) to accept your changes and Cancel to 
ignore them.

Channel names are saved with your default settings. All other Channelize 
settings last only until you quit CUE.
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Click On and Off 183
Click Book 112
Click Display 68
Click Tap 216
Click Tap Display 71
Click Track

Custom Clicks 183
Playing the Right Version 185
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Clicks window
Scrolling 184

Clicks Window 152
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Copy 38
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Cut 38

D
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Decrement Bar 180
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Decrement Tempo 121
Defaults 73
Delete Range 60
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Enter Chg. Over Time 100
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Font Default Settings 36
Fractional  Tempos 131

G
Generate Multi 220
Generating SMPTE 219
Get Next 85
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H
Helpful Hints 233
Hierarchical File System 55, 106, 170
hierarchical menus 24
High Res 139
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I
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Import MIDI File 225
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Increment Beat 122
Increment Meters 150
Increment Tempo 121
Input Error Checking 71
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J
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L
Loading a Cue 115
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Meter Setting 147
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MIDI Event Trigger 202-212
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How to Save 209
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MIDI Keyboard 208
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Proportional Changes 207

MIDI File Playback 236
MIDI Files 223
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MIDI Setup 199, 210
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MIDI Start Command 198
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Offset Search 140-143
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On Camera Vocal 17
Opening a Saved Title Page 111
Organizing Your Files 106

P
Panic Button 211
Paste 38
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Permanent Offset 145
Playback 178
Playback Looping 180
Playing Streamers and Punches 185
Playing the Click Track 179
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Preface to Spotting Notes 76
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Printing Your Title Page 110
production code 54, 166
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Publisher(s) 16
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Q
Quitting the Program 20

R
Reference Cue Points 77
Reference Point 102
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Reset Formats 166
Restoring Your Cues 56
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Round Off Mode 69
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S
Save As 52
Save Cue 52
Save Defaults 73
Saving Score Page 163
Saving the Cue Sheet 52
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Printing From the Finder 164
Saving 163
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Screen Setup 66
Scroll During Play 184
Search Cuts 124
Search Results 130, 144
Searching for an Offset 140-144
Searching for Cues 167
Searching for Tempos 123
Selecting the Final Version 84
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Set Change Over 99
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Set Cue Sheet Formats 64
Set Formats 64
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Set Offset 144
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Sonata Font 166
Song Pointers 197
Sound Effects Lay-in 202
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Stop Watch 42
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Streamer Options 188
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T
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Tempo Pop-Up Menu 121
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How to Save 110
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Turning the Click On and Off 183
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Font 35
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Undo 51, 59, 79, 148
Undo Last 148
Usage Menu 17
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V
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Z
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